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I. Pendahuluan

1. Apa itu Ms Word

Microsoft Word adalah software pengolah kata
(word processing) yang merupakan bagian dari
Microsoft  Office  Suite (Microsoft Excel,
Powerpoint, dll) dibuat oleh Microsoft Corporation
(http://www.microsoft.com).

Ada 3 paket utama produk Microsoft Office yaitu

1. Home and Student,
2. Home and Business,
3. Professional.
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2. Mengapa Belajar Microsoft Word

3. Perkembangan Microsoft Word

Sebagian orang masih menganggap Word sebagai
tools yang sederhana, anggapan ini kemudian
menyebabkan mereka menggunakan Word tak
ubahnya seperti mesin ketik biasa.. "Toh cuman
mengetik saja". Akhirnya segala sesuatunya
dilakukan secara manual ya karena memang
cuman mesin ketik ©.

Kalau demikian adanya, software/aplikasi ini
sebenarnya terlalu canggih jika digunakan hanya
untuk urusan ketik mengetik saja. Bahkan menurut
suatu riset, umumnya pengguna Microsoft Word
hanya mengeksplore 20% dari keseluruhan fitur
yang disediakan.

L Ms Office 2000
K

l

[ 'WE L
\-Sm" s Office 2007
@

| %

1 —
L]

M:s Office 3.0 [92]
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ot denaan

Ms Office 2013
(code name: Officel5)

4, Memahami Microsoft Word Versi 2010

a.

User Interface

@‘ 90 A s Materi.docx - Microsoft Word = = 53
i Home Insert Page Layout References Mailings Review My Tab View Developer 3 a_
[ﬂg_ — Find ~
°$ Cambria (Headii = 11~ A A" | Aa~ | ‘% = i = R AaBbCcD AABB( % e
—_ - a',;, Replace
fa\ ~ & i i Ch
J'J R lib btﬁgtnx | - W7 - A . No Spacing  Headingl | Styalgsg'e [y Select~
E ara Styles [F} Editing
XX Il_|| e e e B i T

o
ag

L]

Daftar Isi

4 Pendahuluan
Perkembangan Micro...
Apa itu Microsoft Wo..,
Mengapa Belajar Mic...
Memahami Ekstensi ...
Mengenali User Inter...
Mengenal View Docu...
Bekerja dengan Shar..,

4 Beberapa Fitur Baru Mic...
a) Kustomisasi Menu
Panel Mavigasi
Tool Image Editing

Ligature

Protected View

@u@n%

-

- : Ekstensi File
[ DI Word 2010 (2007) |  Word <= 2003
Do«
Macro-enabled D it docm .doc
T late .dotx .dot
Macro-enabled Template .dotm .dot

1. File otomatis terkompresi

jejak versi 2007, Microsoft Office menggunakan format file yang disebut open XML
standard web). Itulah mengapa ada penambahan huruf "X" pada ekstensi file Microsoft O
2007 ke atas yaitu dari "doc " menjadi "docx"

-|{eunggulan format file Microsoft Office berbasis XML antaralain :

—
i rﬂ s
-

B- Start enforcement

&I'grmqtﬁy re t_TfE )

of styles
Settings...
2. Editing restrictions

Allow only this type of
in the document:

Mo changes (Read only)

Are you ready to apply the
settings? (You can turn the
later)

Gee also
Restrict permission. ..

é- E % i
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Tab

Home Insert Page Layout References
Fiﬁ’j °$ Cambria (Headit ~ 111  ~ A" A" | Aa~ | &)
— 3

Pastej Bluv*xax"&va‘vav[

v

!
Clipboard Font @
) 27
1 \‘ 1 I"
S 1 ™~ ol &l d Ul = ab Vi
Group Cli p@:@aw Group Font
\\ //’
\‘ l,

b. Ekstensi File

- . T TS T SSS—
Ekstensi file merupakan tambahan nama suatu file untuk — , :
. . . v| 1. ¥ Libraries » Music » Extension
menunjukan jenis atau format file tersebut, tambahan nama =
dipisahkan dengan tanda titik. e v Share with = |3|a}¢I all Burn
Contoh: rorites Music library
lesktop Extension

» *mp3 = untuk file audio / music; lownloads o

» *xlsx = untuk file Microsoft Excel; ecent Places @A“d'°HE"m?“'mp3

» *.docx = untuk file Microsoft Word. B DataPegawaiisx

) |@Materiﬂl.doc¢ |
raries -

Microsoft Word 2010 (2007) memiliki 4 file extension default:

Ekstensi File

Jenis Dokumen Word 2010 (2007) Word <= 2003
Document .docx .doc
Macro-enabled Document .docm .doc
Template .dotx .dot
Macro-enabled Template .dotm .dot
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Sejak versi 2007, Microsoft Office menggunakan format file yang disebut open XML (bahasa
standard web). [tulah mengapa ada penambahan huruf "X" pada ekstensi file Microsoft Office versi
2007 ke atas yaitu dari "doc " menjadi "docx"

Keunggulan format file Microsoft Office berbasis XML antaralain :

File otomatis terkompresi sehingga ukuran file relative lebih kecil
Struktur file2 pendukungnya tetap terjaga

Modifikasi informasi dokumen lebih mudah

Mudah dalam integrasi data antara aplikasi

Mudah dalam membedakan dokumen yang berisi atau bebas dari makro

G Wi

Berikut ini, struktur file dokumen Microsoft Word 2010 yang dibuka dengan program kompresi
7zip:

' N
| Data pegawai Calsers\user\Music\Extension\Data pegawai.doce, E‘Elﬂ_hj
|| AudicHarimau.mp3 Berkas Sunting Tampilan Kesukaan Peralatan Bantuan
[ Data pegawai.doc a
& Data pegawai.docx + - B = X 1
pegawal. Tambah Ekstrak  Uji  Salin  Pindah Hapus Info
=] DataPegawaixlsx
(] Materi01 .docx T @& C\Userstuser\Music\Bxtension'\Data pegawai.dacr, A
MNama Ukuran  Ukuran Dikemas  Dimeodifika

J docPr

ops 1363 715

58118 15939
590 243
=] [Content_Types].xml 1472 394 1980-01-01

4 | 1 r

0 objek terpilih

Meskipun demikian, kita bisa menyimpan dokumen kita dalam format yang diinginkan. Misalnya:
.doc (Word 2003, 2002, 2000, dan 97), rtf (rich text format), pdf (portable document format).
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5. Mengelola Versi Dokumen

Ms Word secara otomatis akan menyimpan duplikat atau kopian dari file dokumen yang terbuka
setiap 10 menit sekali. Jika kita menutup file tanpa menyimpannya maka kita masih bisa membuka
duplikat dokumen tersebut.

a. Mengatur Frekuensi Penyimpanan Otomatis

» Pada tab File, pilih Options

» Padajendela Word Options, pilih tab Save.

» Pada bagian Save AutoRecover information every box, masukkan angka dalam minutes dari
1 sampai 120.

-
Word Cptions ea X
. - r - v
General
H Customize how documents are saved.
Display
Proofing Save documents
Save Save files in this format: Word Document [*.docy lz‘
Language Save AutoRecover information every 10]: | minutes
ad " Keep the last autosaved version i - -
vance
AutoRecover file location: | CaUsersws|_ETSr @ Whele numberfrom 1t 120 }
Customize Ribbon
Default file location: ChUsers\usenDocumentsiTeach' 2012402, Ms Office 2010 Advanced\Ms Word

b. Menampilkan Dokumen Versi Sebelumnya

» Pada Backstage view, di daftar Versions, klik versi dokumen yang ingin ditampilkan.

" Versions
'_': ) IE_|] Today, 2:08 PM (autosave)
Manage IE_l‘] Yesterday, 10:22 AM (autosave)

WVersions -
|E_|] 8/14/2012 3:50 PM (aytosave)

|E_|] 8/14/2012 2:25 PM (autosave)
IE._] 8142012 10:44 AM (autosave)

c. Mengganti Dokumen Saat Ini Dengan Versi Dokumen Sebelumnya

1. Tampilkan file dokumen sebelumnya.
2. Pada Autosaved Version yang muncul dibawah ribbon, klik Restore.

d. Menampilkan Versi Dokumen Sebelumnya Yang Belum Disimpan

1. Pada Backstage view, klik tombol Manage Versions, kemudian klik Recover Unsaved
Documents.
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e

Manage
Yersions =

Versions
Today, 2:08 PM (aut)
Yesterday, 10:22 AM

@.&ﬂiﬂlﬂlﬂ:ﬂﬂ_EM[
Recover Unsaved Documents

Browse recent copies of {
unsaved files. I} MI
2. Pada jendela Open, pilih file yang ingin kita tampilkan pada folder UnsavedFiles, kemudian
klik Open.

F ™
) Open ks 2 e v =
q| 1. = Microsoft » Office » UnsavedFiles - | 4 |'| Search UnsavedFiles P|

— S
Organize « Mew folder =~ 0l @
B Desktop *  Name . Date modifig
& Downloads I
N | File Video({Unsaved-302424902336112950])).asd 8/10/2012 5:
"=l Recent Places .
L Introduction{{Unsaved-302417561823758224)).asd 8/6/2012 2:0.

i ; . . __| On the Insert tab((Unsaved-302423892296649856)).asd 8/9/2012 5:34

|| el Libraries i
@ Documents =
J’ Music ;
| Pictures

i B videos |
1 ]
I 18 Computer

i

| & T - | i | 3
1 File name: | - ’Unsaved Files (*.asd) vl l
]

i Tools - ’ DpeR Iv] [ Cancel ] I

g B

K - E
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II. Memodifikasi Tampilan

1. Kustomisasi Color Sceme

Microsoft Word (Office) 2010 datang dengan tiga skema warna tampilan (color scheme). Jika kita
bosan atau kurang nyaman dengan tampilan default (blue), maka kita bisa mengantinya menjadi
hitam atau silver dengan mudabh.

T |
Home Insert Page Layout References Mailings Review My Tab View Developer Format & e
= W calibri (Body) -l -
gy B 7 U-abex, x* |5

AaBbCcDc AaBbCcDe AaBbCi || % &

=S

Paste . o THNormal 1 No Spaci.. Headingl |—| Change | FEditing
- 7 WA (A A D E T ? 9" |=) siytes~ |~
Clipboa.. | Font M| Paragraph | Styles M| |
|I||-|-|-1_-|-z-|-3)§|-4- -5-|-e‘|-7-|-s-|-9-|-1o-|‘11.-|-1_2-w-u-w-]_-t-n-]_s‘n-]_e-/\-ﬂ-|-Ls-|ﬁ_7|
tH— T (— ., TR T T T =

Recent Editing e
Learn more about Protected View
New

1.2 KUSTOMISASIMICROSOFT WORD
Microsoft Word 2010 datang dengan pengaturan default, mulai dari warna tampilan, menu-
menu, seting fitur-fitur tertentu, dil. Kita bisa melakukan kustomisasi terhadap seting tersebut E

sesuai dengan keinginan kita, agar kita bisa lebih nyaman, efektif dan efisien dalam bekerja.
1.2.1  KUSTOMISASI COLOR SCHEME

W0 ndq

4 [ i | »
Page: 14 of 20 | Words: 1,488 | <88 English (U.S) | Insert [ | IEEEE 100% (OO |

Berikut ini langkah-langkah mengubah scheme color default pada Microsoft Office 2010:

1. Pada menu ribbon, pilih File menu dan klik Options

Home In

e Save
B saveas

(7 Open

[ Close

Info

Recent

Save & Send

Help

:] Options

kd et

2. Pada tab General, kemudian pada opsi Color scheme, pilih color scheme baru dari tiga opsi
yang tersedia yaitu: Blue (default), Silver, and Black.
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Word Options EE
[ General ] 5 . . .
Gl General options for working with Word.
Display
Proofing User Interface options
I } ]
Save Show Mini Toolbar on selection (i)
Enable Live Preview (i
Language
Color scheme: Elack | = ||
Advanced
ScreenTip style: Blue ure descriptions in ScreenTips EI
Customize Ribban silver
Personalize your oG osoft Office
Quick Access Toolbar
User name: |Hafid
Add-Ins ——

3. Klik tombol OK, selesai

Insert Page

Calibri (Body) v|11 - &
Ca | B I U -oabe x, x| 2

1.2 KUSTOMISASI MICROSOFT WORD
Microsoft Word 2010 datang dengan pengaturan default, mulai dari warna tampilan, menu-
menu, seting fitur-fitur tertentu, dil. Kita bisa melakukan kustomisasi terhadap seting tersebut

sesuai dengan keinginan kita, agar kita bisa lebih nyaman, efektif dan efisien dalam bekerja,
1.2.1  KUSTOMISASI COLOR SCHEME

Page: 14 of 20 Words: 1,495 &% English [U.5) Insert [

2. Kustomisasi Menu Ribbon & Quick Access Toolbar

Salah satu kelebihan Word dibandingkan dengan software sejenis adalah user atau pengguna
diperbolehkan menganti user interface sesuai dengan keinginannya antara lain: kutomisasi menu
ribbon dan quick access toolbar.

a. Kustomisasi Menu Ribbon

Caranya: klik kanan Ribbon, lalu pada popup menu, pilih Customize Ribbon
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- — — = 2
Word Options - - - g
General q . .
Customize the Ribbon and keyboard shorteuts.
Display
Choose commands from: (i Customize the Ribbon: (i
Proofing Popular Commands Iz‘ Main Tabs El
Save
L “# Accept and Move to Next - Main Tabs -
| anguage = Align Left i = Home =l [
N | Advanced Breaks 3 Clipboard !
Bullets 3= Font
i Customize Ribbon = Center Paragraph
<= Change List Level > Styles
Quick Access Toolbar 123 Copy Editing
% cut [¥] Insert £
Add-ns Define New Number Format... T on Page Layout
Trust Center ES Delete - Refe.rences
Eﬁ' Draw Table << Remove Mailings
Drraw Vertical Text Box R_""""“"
= E-mail [¥] view L
% Find Developer
Font T~ [#] Add-Ins |
| A Font., Blog Post il
| P
A Font Color |> [ ] [ ] [ ]
Font Size i i Mew Tab Hew Group Rename...
NN .
Customizations: il |
- i
Keyboard shortcuts: Import/Export ¥ | i
|
i o« m | r
|

e New Tab : membuat tab baru pada ribbon

e New Group : membuat group pada ribbon

e Rename : mengubah nama tab dan group

e Add>>:menambahkan command pada ribbon

Disamping itu, kita juga menyembunyian Menu Ribbon sehingga akan memperluas area kerja
dokumen.

Home My Tab Insert Page Layout References Mailings Review View Devem.‘ @0
Navigation v X o
Search Document P~ -
Paragraf 1 (]
g8 5 N =
Loremipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fus_ |
( Parsgrara £ posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna
Quis urna.
Paragraf 2
Paragraf 3 Nunc viverraimperdietenim. Fusce est. Vivamus a tellus.
Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. P
pharetra nonummy pede. Mauris et orci. Y
i 2
(o}
Paragraf 2 *
M i [ [ | »
| Page:1of1 Line:4 | Words: 180 | Indonesian | Insert 73 | | BB 3= %0% (=) 0 +)

b. Kustomisasi Quick Access Toolbar

Caranya: klik kanan Ribbon atau Toolbar, lalu pada popup menu, pilih Customize Quick Access
Toolbar
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r
‘Word Cptions

General

I
Customize the Quick Access Toolbar,

Display
Choose commands from: (i Customize Quick Access Toolbar: ()
Procfing Popular Commands El For all documents (default)
Save
AIGA TEXT LETT " I save
Language »
I Bullets ¥ Undo
I | Advanced Center E 5 Redo
- i »
Customize Ribb Change List Level ‘? Spelling & Grammar
ustomize Ribbon Copy |3’ Draw Table
Cut
Quick Access Toolbar .
Define New Mumber Format... E]
Add-Ins Delete Comment
Drave Table -
Trust Center fl Draw Vertical Text Box
= E-mail
Find
Font I il Modify...
A Font.
Customizations: bl
|:| Show Quick Access Toolbar below the
Ribbon Import/Export ¥ |0
4 1 ] »

3. Mengenal Document Views

Di Word, kita bisa mengganti tampilan dokumen (view) sesuai dengan kebutuhan. Untuk berpindah
tampilan, caranya:

» Pada tab View, di grup Dokumen Views, klik Print Layout, Full Screen Reading, Web Layout,
Outline View, atau tombol Draft View. Atau

Ol @ = (= [=)]

Print |Full 5creen Web  Outline Draft
Layout | Reading

Home Insert

Page Layout

Layout
Document Views

W

References Mailings Review My Tab
Ruler C{ [E] one Page
Gridlines Twcu Pages

o Zoom 100% : .
Mavigation Pane =] Page Width
Show | Zoom

WView

=

Mew A
Window

» Di sudut kanan bawah jendela program, klik pada toolbar, klik Print Layout, Full Screen
Reading, Web Layout, Outline, atau tombol Draft.

| |[Ele R

0%

Berikut ini penjelasan dari ke lima jenis tampilan tersebut.

a. Print Layout (Default)

Print Layout View merupakan tampilan default, tampilan ini akan menampilkan tampilan yang
sama ketika dokumen di cetak. Komponen seperti margin, header, footer, watermark dokumen
akan ditampilkan.
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II. Sharing dan Pengelolaan Dokumen

A Tampilan Dokumen
A.1 Mengganti Tampilan
Di Word, kita bisa mengganti tampilan dokumen (view) sesuai dengan kebutuhan.
Ada empat tampilan:
1. Print Layout (default)
Print Layout View merupakan tampilan default, tampilan ini akani

raamamnillean taramilam trame pamas leatiles dolnvam dicatale Bammsoman

Page: 19 of 45 | Words: 3,951 | @ English {U.5.) | |@ E E
T

t 3

|
|

R

b. Full Screen Reading

Full Screen Reading View menampilkan dokumen konten layaknya slide presentasi yang cocok
untuk dibaca. Pada tampilan ini menu ribbon diganti dengan satu toolbar yang terletak diatas
dengan tombol simpan dan cetak dokumen, mengakses referensi, penerjemahan teks, teks
highlight, dan penambahan komen.

FIEE o ] 1 Page1s 200145 - 1 2 view options - x Close

1L, Sharing dan Pengelolaan Dokumen
A Tampilan Dokumen
A1 Mengganti Tamy

pilan
D Viord, kit bisa menggan smpiln dokumen (view) sesus engan kebutan,
3 emparcampilar

Full Seeen Reading Vi Layous, Quine, s ool D

1933 m o

F Template Dokumen

Full Sceen Rescing
Full Seeen Resting View mensmpilian coumen korsen yskays side

o

dengm sau toular yang terek dizas dengan Tombal impan dan ok

dokumen, referans, peneremaban ok, toks highbht, dan
Ry

> Pada b View, &i grup Dokumen Views, ik Print Layowt, Ful Sereen
Reating Wb Layous, Ouckine View, e tom ol Drae View. e

Sharing dan Pengelolaan Dokumen .I Sharing dan Pengelolaan Dokumen .I

c. Web Layout

View ini menampilkan dokumen layaknya tampilan di web browser. Pada tampilan ini, kita akan
melihat bakground dan efek-efek lain, dan bagaimana teks ditempatkan pada window serta
bagaimana grafik atau gambar ditempatkan.
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I NFORMATION S HEET

Simple Room Design

With the Room Planner, you'll never make anather design mistake. Created by acclaimed interior designers to simplify
the redecorating process, this award-winning planning tool incorporates elements of color, dimension, and style to guide
your project. It includes a furniture location guide; room grid; drawingtools; and miniature furniture, rugs, accessaries,
and color swatches that match our large in-store selection. Here’s how to use the planner to create the room of your
dreams!

— Take alook at how your home is decorated and notice the things you like and
Go with what you love, and dislike. Pay special attention to the color scheme and to how you react to each
the rest will fall into place. room. Isitinviting? Does it feel comfortable? Does it relax you or does it

- - d invigorate you?

Focus on the room(s) you would most like to change. Brainstorm all the things you would change in that room if you
could. Don't think about what it would cost; just let your imagination go wild! It might be helpful to write down all the
negatives and positives. You don't need to come up with solutions all at once. Just be clear about what you like and what
you hate about that room.

Visit our showroom and purchase a Room Planner, Yhile you're there, take a look around and see what really appeals to
you, Sometimes entire rooms are designed around just one ortwo special pieces, so don't be afraid to fall in love with
something that doesn't seem to fit into your overall scheme. Go with what you love, and the rest will fall into place.

“« 0 » 4

Talka wour Boom BPlannar hama and aat toosaark] Adinct tha nlannar cathat it modals tha roorm dimancinne Dion't foraat to

words: 814 | <& | 3 | | B Rz = 0% (o) 0 (+)

d. Outline

View ini menampilkan struktur dokumen secara bersarang atau bertingkat berdasarkan heading,
serta disediakan tools untuk mengubah hirarkinya. Indentasi dan simbol tertentu digunakan untuk
mengindikasikan level dari heading dan paragraf pada struktur dokumen.

Ketika bekerja dengan tampilan ini, kita bisa dengan mudah mengontrol level dari konten yang
ditampilkan, menaikkan atau menurunkan level dari heading dan teks, dan memindahkan section.
Kita juga bisa bekerja dengan subdocuments dari master document.
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Uutlining Home | Insert | Page Layo | Reference | Mailings | Review | My Tab | View | Developer | & @

W @ [BoayTer -] & gp | O Showlevet M| k3
| Show Text Formatting
ao ¥ = o Master Clase
[ Show First Line Only Document ™| Qutline View
Qutline Tools Close
| © m. Pemformatan Konten 7
| @ A Atribut Font dan Paragraf
@ B Navigasi dan Pencarian pada Dokumen
@ C Indentasi dan Tab
© D Spasi Font dan Paragraf
© E Manipulasi Tabel E
© F Bullets dan Numbering
®
I
| © IV.Including Illustrations and Graphics in a Document 3
@ A Insert and Format Pictures in a Document ol
@ B Insert and Format Shapes, WordArt, and SmartArt o
© C Insertand Format Clip Art ¥
I 4
Page: 20 of 46 Line:14 | Words: 4173 | <% | [ 100% (=) [} (F)

» Menampilkan Panel Style Konten di Sebelah Kiri Dokumen

Caranya: Pada menu File > Options, pilih tab Advanced pada jendela Word Options.
Scroll ke bagian display. Masukkan lebar dari Style area pane width in Draft and
Outline Views, ubah menjadi 2 cm (default 0 cm), lalu lihatlah perubahannya

Word Options —
e " — . e W
FIEIT SOAaIng: | WREn seleed| |
General : i .
|:| Use draft font in Draft and Cutline views
Name: [Courter New [ -]
Proofing Size: n
_— | Eont substitution... |
Language Display
Advanced l ol -
Show this number of Recent Documents: 25 IZI (i)
Customize Ribbon Show measurements in units of: n
Quick Access Toolbar Style area pane width in Draft and Qutline views: |[II cm |
|:| Show pixels for HTML features I}
Add-Ins El . .
' Chomaas =0l aagie deoaaae im dloo Toclels o
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Qutlining Home Insert Page Layout References Mailing

@@" Show Level: | Level 4 - =

4 @ | Level 2 | 3 P (=
| W Show Text Formatting —
= Sh

o v + [ Show First Line Only Dgcu?::nt Sub|

J_L Cutline Tools ‘ Master Dog
i | © I, Pendahuluan
Heading 2 © A Seleksi Teks
Heading 3 © A.1Menggunakan Mouse
Heading 4 @ a) Dalam.Tubub.Dokumen
Heading 4 © b) Dalam.Tahel..
Heading 3 Q A2 Menggunakan Keyboard
Heading 4 © a) Dalam.Dokumen
Heading 4 L+ h] Dalam.Tabel..
Heading 2 Bergerak Dalam.D okumen
Heading 2 i
Heading 3 0 C IM&nanmLLkanﬁhnmmKﬁy,dl Me
Heading 3 Q cC. 2 ShorioutYang Umum Digunakan
Heading 2 @ D Sharing dan Pengelolaan Dokumen
Heading 2 @ E Tampilan Dokumen
Heading 3 © E.1MenggantiTampilan
Heading 2 @F Proteksi Dokumen

» Menampilkan Hanya Level Tertentu Ke Atas
Caranya: Pada tab Outlining, di group Outline Tools, pilih level pada pilihan Show Level.

Cutlining Home Insert Page Layout Referen

- w Level:
& Sh L II 45
Level 2 - | “ =

| Show Text Fg Level 1
e [ Show First Li L€ve! 2
Qutline Tools Level 3
Level 4
th| ® Caranyi Level 5 I} in

» Membuka atau Menutup Section (Bagian) Dokumen
Caranya: Double klik tanda plus pada sisi kiri heading.

@ D Sharing dan Pengelo}
@ E Tampilan Dokumen
E> “® E.1Mengganti Tamp|
@ F Proteksi Dokumen
@ G Versi Dokumen

Atau gunakan tombol Expand dan Collapse pada tab Outlining
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Ka

F Y

&

b

Cutlining Home

Body Text | 3 o

| =

Cutling

» Mereorganisasi Level Heading Dokumen
Caranya: Klik tanda plus pada sisi kiri heading untuk menyeleksi section dokumen.
Kemudian lakukan salah satu perintah dibawah ini:

O
O
O

Drag section tersebut ke lokasi baru

Cut dan paste section tersebut ke lokasi baru

Pada tab Outlining tab, group Outline Tools, klik tombol Move Up atau Move
Down.

Cutlining Home

+A ~@ Body Text T o e

S

v |4 =

Qutling

» Menaikkan atau Menurunkan Level Heading Dokumen
Caranya: Select atau Klik heading atau teks biasa yang ingin dinaikkan atau diturunkan
levelnya. Kemudian pada tab Outlining tab, group Outline Tools, lakukan salah satu
dibawah ini:

O
O
O

Klik tombol Promote untuk menaikkan satu level

Klik tombol Demote untuk menurunkan satu level

Klik tombol Promote to Heading 1 untuk menaikkan ke level tertinggi yaitu
Heading 1

Klik tombol Demote to Body Text untuk menurunkan ke level terendah yaitu
teks biasa.

Qutlining Hame Insert
B sh
+A -'%EndyText - D ] ="
| Shoy
‘ ==
S Shoy

» Expand dan collapse Sub Dokumen
Caranya: Select atau klik sub dokumen. Lalu pada tab Outlining, group Master
Document, klik tombol Expand Subdocuments atau Collapse
Subdocuments.

» Membuka Sub Dokumen

Caranya: Pada tab Outlining, group Master Document, klik tombol Show Document
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e. Draft

View ini menampilkan konten dari dokumen dengan layout yang simple sehingga kita bisa
mengetik dan mengedit dengan cepat. Adapun elemen layout seperti header dan footer tidak
ditampilkan.

EI'"1-"'2"'1'"2'"3'"4"'5'"'E-"'?"'B""-‘"
=

CTRL + LEFT /RIGHT
ARROW

HOME/END Bergerak ke awal / akhir bari
CTRL + HOME/END Bergerak ke awal / akhir doks

Bergerak satu kata ke kiri / ks

Bergerak ke awal dari halama
sebelumnya/setelahnya

PAGE UP/DOWN Bergerak (scroll) keatas/keb:

CTEL + PAGE UP/DOWN

Mormal

Heading 2 C Shortcut Yang Sering Digunakan

Normal Untuk lebih meningkatkan efisiensi dan efektifitas dalam
Ms Word, kita perlu mengetahui keyboard shortcut v
mengolah dokumen serta menggunakannya sebagaimana 1

Heading 3 C.1 Menampilkan Shortcut Key di Menu Ribbon
Normal Terkadang kita kesulitan menghafallkan shortcut-shortcut ;
jangan khawatir karena Microsoft Word (Office] 20
menampilkan panduan shortcut key pada menu ribbon, ya

Normal Tekan tombol ALT, maka shortcut key akan muncul pada
vang tampak pada gambar berikut ini:
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4. Membagi Jendela Dokumen

Jika kita bekerja dengan dokumen panjang maka seringkali kita harus melakukan scroll untuk
melihat data pada bagian lain dari dokumen.

Caranya: Drag tombol split diatas ruler vertikal

Home | Insert  Page Layout  References Mailings Review  MyTab View  Developer dhe

¥ i Ju -
Eg Cla!mb;agvabsxzx’nll% M% &

Paste

- . . Quuick Change | Editing
- F AW A-Aa A Styles = Styles~ | ™
Clipboard 1 Font P Paragraph P Styles I
Elz'l'I'I'E'I'I'I'Z'I'J'I'4'I'5'I'G'I'?'I'B'I'9'I']_D'I']_]_'I']_Z'I']J'I'A'I']S'I'],G'I' ﬁ
| | T T T T T T T T |J T T

Atau gunakan tombol Zoom In dan Zoom Outyang terletak di status bar kiri bawah.

C 115 114 1]

b CE o

Maka jendela dokumen tersebut akan dibagi menjadi dua, yang mana masing-masing memiliki
scroll individu.

Home | Insert  Page Layout  References Mailings Review  MyTab  View  Developer ﬂhe

e B n JE-EE FE AL M (s
I 5 B I U -abe x, x| & = = I

_\=." .
Paste ) . . Quick Change | Editing

- | A A A | A Styles~ Styles~ | T
Clipboard = Faont P Paragraph [} Styles ]
|I||2|1-|-|-|-1E|z|3-|4|5|-6|?us|9|-m-|-u-|-1_z-|-u-|Au-ls-u-is-u ]
= 7 7 i i 7 7 i i 7 T e I
= (s 4 Cancel
: | l” g
= -

I TR ST S A T T T T S P T s o ﬁ
ATal EUNAKAN TOMB 0L Z00M [N'13N £00M UL Yang TeFIETaK ol STatus bar Kirl pawan., -
+
o
*

3 m m@—&—ﬁ

£.4 Membagi Jendela Dokumen
ika kita bekerja dengan dolumen panjang maka seringkali kita harus melakulan;

H O W 4

Page: 27 0f 53 | Words: 4,575 | ¢ English (US) | Insert | |@ B =

E . e ——

|
|

Untuk menghapus split tersebut, caranya: double klik garis split.
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5. Menampilkan Beberapa Dokumen Dalam Satu Layar

Ada kalanya kita ingin menampilkan dua dokumen berbeda dalam satu layar, maka Ms Word
memiliki fitur yang secara otomatis akan mengaturnya.

Ada dua caranya untuk melakukannya:
1. Buka dua buah dokumen, lalu pada tab View, pilih Arange All

T T
View Developer Design Layout

?‘I == | [} View Side by Side

| _'I: Synchronous Scrolling

Mew Arrange Split
Window p{.} +4 Reset Window Position

Window
ﬁ- 11 7
=] Arrange All

Tile all open program windows
side-by-side on the screen.

@ 9~ ) Aav|s MODUL MSWORD 2010 TINGKAT LANJUTAN. docMWherasoft Word (Produ... | = [ 35 |

Home Insert Page Layout References Mailings Review My Tab View Developer & e

| & web Layout V] Ruler t{ & 2 New window | 13 g@ -
EArrangeAll | .

i3

[ outline O Gridines | Y = = | &
Print |Full Screen = L Zoom 100% - . Switch Macros
Layout| Reading = Draft MNavigation Pane = Split 4 Windows ~ -
Document Views Show | Zoom Window | Macros |
[ NS Y R TR TN X SN R KRS S TS P T, TS SO IR
| N RN . : ] : : ; . : ; o il
-
T T
View Developer Design Layout

(]

? E (1] View Side by Side
| J: Synchronous Scrolling
Mew  Arrange Split

Window P{é #14 Reset Window Position %
Window o
o1 Artange All 7 o
4 [ Il ] 3
Page:29 0f 55 | Wordsi4771 | <% Englsh(us) | nset [ | ([l = = 1w00% o U——@)
; |
@“ Q ¥ - 10 Aav |+ Modul C5527102011.docx [Compatibility Mode] - {ﬂicrosoftWor... ‘ Table, Tee | = E‘Jﬂ

M Insert Page Layout References Mailings Review MyTab  View Developer Design Layout & e
[ 53 web Layout  [¥| Ruler HIE n.?._é,NeWWindow (R E@
[ outline [ Gridlines u E Arrange All | _1: | E

Print |Full Screen _ = o Zoom 100% _ . Switch Macros
Layout| Reading =l Draft Navigation Pane =l Split A4 | Windows ~ -
Document Views Show | Zoom Window | Macros |

||1“|']_'II'2;J\§}3'I'4'I'5'I'6'I'?'I's'l"J'I'].D'I'].].'I-]_Z'I']_'i'I'].4'I']5'|§'].6'I'].?'IP.‘_-.|
Perhatikan kotak yang dibentuk oleh selektor headline, didalamnys -

teradapat dua kotak lagi yang salah satu ukurannya lebih besar. Perhatikan

pula kotak dalam selektor content, terdapat 3 kotak dengan ukuran Eh
berbeda. Untuk kotak didalam selektor headline, kita mendefinisikaré - |l
selektor baru bernama headlinecol selebar 500 pixel dengan tinggi otomatis ;

serta selektor largecol dengan lebar sebesar 300 pixel dengan tingg |

4 [ Il |y

| Page: 47 of 59 | Words: 6,811 | <8 English (Australia) | Insert [ ||I£ B 3 100% (-—U—(3) J
- — ]

2. Carakedua, buka dua buah dokumen, lalu pada tab View, pilih View Side by Side.
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Wi o2

View

ﬂ
=

Window

Developer

Mew  Arrange Split
All #4 Reset Window Position

Window

===} View Side by Side

J: Synchronous Scrolling

@\vauu\v

e —————— T
MODUL MS WORD 2010 TINGKAT LANJUTAN.docx - Microsoft Word (.. | — | = | 52|

Craios foaars Mailngs  Review  MyTab | View | Developer & @

() 9 - © Aa- |5 Modul S5 27102011 docx [Compatibility Mode] - Microsoft Wor... ‘ SEIES

Home | Tnsert | Page Layot | References | Mailings | Review | My Tab | View | Developer | Design | Layout| & @)

\_\__JI B we

Cl Outii

Document Views

tayout | Q ‘ ) 3 New window jJ E? .

i 3 Sarngean \ i =5
ow | Zoom 1009 e

aom = ‘ St i acros

[ - window | wanes |

(2 outiine @3 = Arangean \ \
u\szveen Srmw Zoom  100% Sw\!zh Ma:m;

ding = Draft | (=] ‘ = spiit

Document Views Zoom

] Swewet g Q ‘,Jj 2 New Windaw ‘l

Window Ma:m;

unavailable.

® AMarked As Final banner appears at the top of the document.

document has been marked as final.

® AMarked As Final Icon appears on the status bar.

» APermissions flag on the Info page of the Backstage view indicates that

Further changes cannot be made to the document by you or anyone €

Som e e e e s |

H first Perhatikan kotak yang dibentuk oleh selektor headine,

B removing the Marked As Final designation. teradapat dua kotak lagi yang salah satu ukurannya lebih besar

= G Versi Dokumen g pula kotak dalam selektor content, terdapat 3 kotak den

e H Sharing Dokumen berbeda. Untuk kotak didalam selektor headiine, kita me

é Menyimpan Dokumen selektor baru bernama headlinecol selebar 500 pixel dengan tin|

B serta selektor largecol dengan lebar sebesar 200 pixel de

- Template Dokumen

B otomati.Infakan membuatsatu kotak untuk headinelebih besigy

3 kotak lainnya. Sementara untuk 3 kolom kotak isi didalam selek

B selektor largecol dapat digunakan kembali beserta selektor s

& | kolom yang lebih kecil.

E bl srormal ¢ B

B o Clear :both; o

o z *

q m ] v | i ] al

Page:30 of 55 | Words:4782 | <5 Engisn(us) | nsert | |[E|@R == 100 (= 0 & ||| ragea70r59 | Wordsignt | <5 english ustraiia) | Insert | ([E]EAR E S 100% (= U (&) J
— —

Hampir sama dengan cara sebelumnya, namun ada opsi untuk Syncronous Scrolling yaitu
jika satu dokumen di scroll keatas atau kebawah, maka scroll dokumen kedua akan

mengikuti.

View

Developer

=

Mew A
Window

[ 1 View Side by 5ide] g@

| [Lﬂ: 5ynchrun&t1}l§crurring] |

rrange Split

Window

Switch

All #4 Reset Window Position | windows = “

III. Menjelajah Dokumen dengan Mouse dan Keyboard

1. Seleksi Teks Menggunakan Mouse

a. Dalam Tubuh Dokumen

Untuk menyeleksi seluruh dokumen bisa dilakukan dengan menggunakan salah satu cara berikut:

0

+» Pada tab Home, group Editing, klik Select, kemudian Select All.
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33 Find -
aBbi (1) AaBb b Replace
ing4 Heading5 |—| Shange |/ 1

Stylesv hi Select =
S5 select Al
18 [+ Select Obje
Select All (Ctrl+A)
Select All Te
Select all items.
B, Selection Parem
l

R/

« Arahkan kursor mouse ke sebelah kiri dari teks hingga kursor mouse berubah menjadi
tanda panah (arrow), kemudian triple-click

ﬁ On the Insert tab, the galleries include items that are designed
your document. You can use these galleries to insert tables, he
other document building blocks. When you create pictures, ch
with your current d

1

ou can easily chan ;
v On the Insert tab, the galleries include items that are designed

selected text from- i )
your document. You can use these galleries to inserttables, he
the other controls ¢ o )
. pther document building blocks. When you create pictures, chz
theme orusing a fc H

:w'rth your current document look.

?'fou can easily change the formatting of selected textin the do
?:.electedtextfromthe Quick Styles gallery on the Home tab. ¥o
;ihe other controls on the Home tab. Most controls offera choi

:iheme orusing a format that you specify directly.

Berikut ini perintah yang bisa dilakukan untuk menyeleksi bagian dari suatu dokumen:

Seleksi
Satu kata
Satu kalimat

Satu paragraf

Satu baris teks

Lebih dari satu paragraf

Sebagian besar teks

Teks yang terpisah

Perintah
Double click pada kata tersebut
Tekan dan tahan tombol CTRL kemudian klik pada kalimat
Triple click pada paragraf atau Arahkan kursor mouse ke sebelah kiri
dari teks hingga kursor mouse berubah menjadi tanda panah (arrow),
kemudian double klik
Arahkan kursor mouse ke sebelah kiri dari teks hingga kursor mouse
berubah menjadi tanda panah (arrow), kemudian klik satu kali
Arahkan kursor mouse ke sebelah kiri dari paragraf pertama hingga
kursor mouse berubah menjadi tanda panah (arrow), kemudian klik
dan tahan tombol kiri mouse lalu drag kursor ke atas atau ke bawah
Arahkan dan klik kursor mouse di awal teks yang ingin diseleksi, lalu
tekan dan tahan tombol SHIFT, kemudian arahkan dan klik kursor di
akhir teks yang akan diseleksi.
Tekan dan tahan tombol CTRL, lalu seleksi teks yang ingin diseleksi.
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;"fou can easily change the formatting of selected textin the document text by choosir
iﬁelectedtextfromthe Quick Styles gallery on the Home tab. You can also format text
;the other controls on the Home tab. Most controls offera choice of using the look fr

;theme or using a format that you specify directly.

Tekan dan tahan tombol ALT, lalu seleksi teks yang ke atas atau
kebawah (vertikal)

%‘r’ou can easily change the formatting
?:relected textfrom the Quick Styles ga
;the other controls on the Home tab.

Satu blok vertikal

:theme orusing a formatthat youspe

b. Dalam Tabel

Seleksi Perintah
Arahkan kursor mouse ke sebelah kiri sel, hinggi kursor berubah

menjadi tanda panah kecil berwarna hitam, kemudian klik satu kali

+

No Nama Alamat
r1 Hafid Depok

2 Susan Bogor
Atau.

Klik pada sel. Pada menu ribbon klik tab Layout. Pada group Table,
klik Select, kemudian klik Select Cell.

= -
s B
Select | View  Propertis
e Gridlines

J B select cen L
EIE] SelegtCoIl%n |
B Select Row I

B SelectTable
ErTOOTTErTTY

Arahkan kursor mouse ke sebelah kiri sel, hinggi kursor berubah
menjadi tanda panah kecil berwarna hitam, kemudian double klik

Konten sebuah sel

1
No Nama Alamat
Konten satu baris 21 Hafid Depok
2 Susan Bogor

Atau, Arahkan kursor mouse ke sebelah kiri sel, hinggi kursor
berubah menjadi tanda panah berwarna putih, kemudian klik satu

kali
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Konten satu kolom

e

No Nama Alamat
ﬂ 1 |Hafid Depok
2 Susan Bogor

Arahkan kursor mouse ke sebelah atas kolom yang ingin diseleksi,
hingga kursor berubah menjadi tanda panah kecil berwarna hitam,

kemudian klik satu kali

&+ 1
No Nama Alamat
1 Hafid Depok
2 Susan Bogor

Konten dari sel, baris,

Seleksi sel, baris atau kolom dengan cara yang telah dijelaskan
sebelumnya. Kemudian tekan tombol CTRL untuk menambah area

seleksi yang lain.
3

atau kolom

terpisah

secara

No Nama Alamat
1 Hafid Depok
2 Susan Bogor

Seluruh konten dalam

sebuah table

Arahkan kursor mouse ke pojok kiri atas tabel hingga kursor berubah
menjadi tanda panah dan plus, lalu klik

i
' No Nama Alamat
1 Hafid Depok
2 Susan Bogor

2. Menggunakan Keyboard

a. Dalam Dokumen

Berikut ini perintah yang bisa dilakukan untuk menyeleksi teks pada suatu dokumen:

Seleksi
Satu karakter
Satu kata

Satu baris

Satu baris di atas/bawah

satu paragraf

Seluruh  teks

dokumen

dalam

Seluruh teks yang tampil

Perintah
Tekan tombol SHIFT + ARROW LEFT / RIGHT (panah kiri / kanan)
Tekan tombol CTRL + SHIFT + ARROW LEFT / RIGHT
Tekan tombol HOME, kemudian SHIFT + END, atau
Tekan tombol END, kemudian SHIFT + HOME
Tekan tombol HOME, kemudian SHIFT + ARROW UP (panah atas)atau
Tekan tombol END, kemudian SHIFT + ARROW DOWN (panah bawah)
Tekan tombol CTRL + SHIFT + ARROW UP / DOWN
Arahkan kursor ke awal dokumen (CTRL + HOME), kemudian tekan
tombol CTRL + SHIFT + END, atau
Arahkan kursor ke awal dokumen (CTRL + END), kemudian tekan
tombol CTRL + SHIFT + HOME, atau
CTRL+A
Arahkan kursor ke awal dokumen (CTRL + HOME), kemudian tekan
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dilayar tombol ALT+CTRL+SHIFT+PAGE DOWN

Satu blok vertikal Tekan tombol CTRL+SHIFT+F8, dan kemudian gunakan ARROW.
U blokv Tekan ESC untuk mematikan mode selection.

Untuk mengaktifkan mode selection tekan tombol F8, lalu gunakan ARROW untuk menyeleksi teks.
Tekan ESC untuk mematikan mode selection.

b. Dalam Tabel

Seleksi Keterangan
Satu sel setelahnya Tekan tombol TAB, dan
Satu sel sebelumnya Tekan tombol SHIFT + TAB
Lebih dari satu sel Tekan tombol SHIFT + ARROW

3. Bergerak Dalam Dokumen

Untuk bergerak dalam dokumen, kita bisa menggunakan windows scroll (vertikal maupun

horizontal), dengan cara mengarahkan kursor mouse ke scroll, lalu drag scroll keatas atau ke
bawah.

(» |

g7

Adapun pergerakan kursor dengan menggunakan tombol keyboard adalah sebagai berikut:

Tombol Keterangan
LEFT/RIGHT ARROW Bergerak satu karakter ke kiri / kanan
UP/DOWN ARROW Bergerak satu baris ke atas / bawah
CTRL + LEFT/RIGHT ARROW Bergerak satu kata ke kiri / kanan
HOME/END Bergerak ke awal / akhir baris tersebut
CTRL + HOME/END Bergerak ke awal / akhir dokumen
CTRL + PAGE UP/DOWN Bergerak ke awal dari halaman sebelumnya/setelahnya
PAGE UP/DOWN Bergerak (scroll) keatas/kebawah layar
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4. Bekerja dengan Shortcut

Meskipun Microsoft Word didesain dengan konsep WYSIWYG ( What You See Is What You Get)
namun untuk lebih meningkatkan efisiensi dan efektifitas dalam bekerja dengan dokumen Ms
Word, kita perlu mengetahui shortcut key yang sering dipakai dalam mengolah dokumen serta
menggunakannya sebagaimana mestinya.

a. Menampilkan Key Tips Di Menu Ribbon

Terkadang kita kesulitan menghafalkan shortcut-shortcut yang harus digunakan, tapi jangan
khawatir karena Microsoft Word (Office) 2010 memiliki fitur untuk menampilkan panduan
shortcut key (key tips) pada menu ribbon, yaitu ALT.

Tekan tombol ALT, maka shortcut key akan muncul pada menu ribbon sebagaimana yang tampak
pada gambar berikut ini:

TP — T —C T
01. Daftar Isi.docx - Mic
Flle me My Tab Insert Page Layout References Mailings Review Develgper
qi i @y W
v v E

Cambria (Headii ~ 14 ~ A™ A" | Aa~ l T AaBb(

:E' RO R R 1 Norg

53 Copy

Paste v 3y, v ||
- <J Format Painter (B] 7 U - e x x V- &

Clipboard % Font ] Paragraph

|Na\ngat|on > x‘ | igg “[Type the company ad

Artinya untuk membuka tab File pada menu Ribbon gunakan perintah: ALT + F, tab Home: ALT + H,
tab Insert: ALT + N, dst. Demikian juga untuk menampilkan shortcut key pada suatu tab, sebagai
contoh pada tab File: Tekan ALT, kemudian Tekan ALT + F

Home My Tab I
v |
h"s,i:Save As
:y%pen

Q)

[yClose
=
[R]
~Recent Do
N
kew
rint
[©]
~Save & Send
(H
Lelp

'_U—i)phons
—
(5% bt

Infq
C:\Usg

Artinya pada posisi ini, untuk menyimpan file gunakan shortcut ALT + S, Save As -> ALT + A, Open
-> ALT + O, Close -> ALT + C, dst
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b. Shortcut Key Yang Umum Digunakan

Berikut ini shortcut yang umum digunakan untuk mengelola dokumen:

Tombol Keterangan Tombol Keterangan
CTRL +C Copy CTRL+SHIFT+C Copy Formatting
CTRL +X Cut CTRL+SHIFT+V  Paste Formatting
CTRL+V Paste CTRL + ALT +V  Paste Special
CTRL +7Z Undo CTRL+1/2/5 Paragraf1 /2 /0.5
CTRL+Y Redo SHIFT + F3 Change case
CTRL+P Print CTRL+B Bold
CTRL+S Save CTRL+U Underline
CTRL +F Find CTRL +1 Italic
CTRL+H Replace CTRL +] Memperbesar huruf 1 poin
CTRL+ O Open CTRL + [ Memperkecil huruf 1 poin
CTRL+N New Document ALT + F4 Exit Word
CTRL+W  Close Document CTRL + F6 Pindah ke dokumen lain

Beberapa shortcut key diatas bisa di analogikan, misalnya :

+ Untuk menyimpan file CTRL + S maybe S = Save.
% Untuk mengcopy text CTRL+C maybe C = Copy
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5. Menggunakan Panel Navigasi

Navigation pane (fitur baru di Word 2010) terletak disisi sebelah kiri dokumen yang akan
mempermudah kita dalam melakukan suatu pencarian pada dokumen.

Home Insert Page Layout References Mailings Review My Tab View
EES " P
= T calibriBody) 11 /A" A7 | Aav | Z-iz-tzr [EE(R] T |
= SE|
- - 37 . -
Pﬂjtej B 7 U ~abe x, X | B2 - A
Clipboard a | Fant M | |
merigatiQn vx-‘lg L T T I O T O e - - e N B B
| — I L 1 0 T 0 i T
Search Document 2 -1
= (n]n] =l
Z (oo | &= -0 °
This document does not -
contain headings. _
To create navigation tabs, L g e -
create headings in your -|  On the Insert tab, the galleries include items that are
d tb lyi - : . .
Hg;ﬂﬁznsw}l.;?ppymg your document. You can use these galleries to insert
| other document building blocks. When you create pid
&l with your current document Iook.l
LA

Secara default, panel ini tidak ditampilkan, untuk menampilkannya klik tab View pada menu utama
kemudian centang opsi Navigation Pane.

out References Mailings Review My Tab View
¥ Ruler C{ 9t [ one Page 11 E
Gridlines | % % = Twn Pages J
Zoom  100% . Mew  Arr
l:ul' Mavigation Pana =| Page Width | window |
| Show [ Zoom [

Atau bisa juga dengan menekan tombol kombinasi keyboard CTRL + F untuk menampilkan panel

sekaligus melakukan pencarian. Semua kata atau frase hasil pencarian akan diberi latar belakang
kuning.
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[ Ty e aas aaas nax anEs annn amas e
o] R S MR KR M K AV MR AR
[[E

3 of 6 matches -| On the Insert tab, the galleries include items that are designed to coor
EENE & v ||| wyour document. You can use these galleries to insert tables, headers, f

other document building blocks. When you create pictures, charts, or

This document does not
contain headings.

ol with your current document look.

To create navigation tabs, “| ¥ou can easily change the formatting of selected text in the document
create headings in your i . A
document by applying _| selected text from the Quick Styles gallery on the Home tab. You can =

Heading Styles. - the other controls on the Home tab. Most controls offer a choice of us

_| theme or using a format that you specify directly.

To change the overall lock of your decument, choose new Theme elen
-| change the locks available in the Quick Style gallery, use the Change C
_| Both the Themes gallery and the Quick Styles gallery provide reset corl

~| restore the lock of your document to the original contained in your cy

Kita bisa mengatur opsi dari fitur pencarian ini dengan cara mengklik tombol arrow yang terletak
disamping kanan textbox/kotak pencarian

Navigation v %[
-
Find: Graphics ® = |7
Mo matches Options...
B = Advanced Find...
EE {8 2
2ac Replace..
Introduction = GoTo..
4 Conclusion Find:
|_ 4 Description & Graphics
Detail Analysis [ Tables
TU  Equations
AB'  Footnotes/Endnotes
[ Comments 4

Navigation pane mengorganisir dokumen kedalam tiga jenis tampilan (view) berbeda yaitu
Heading View, Page View, Search Results View.

Navigaticn v X
document x T

Click the arrows to continue your
search

=] | 00 | = -~
Z | oo | =]

This document does not
contain headings.

c. Heading View
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Tab heading pada Navigation Pane menampilkan menu bersarang (bertingkat), yang masing-

masing terhubung dengan dokumen heading. Fitur ini akan memudahkan kita dalam melakukan
navigasi dokumen dengan menggunakan heading.

Mavigation v X

document x o

Click the arrows to continue your
search

oo | =
oo | & S W

1Y

Introduction

4 Description
Detail Analysis

Conclusion

Kita juga bisa mengontrol konten melalui navigation pane ini, yaitu dengan mendrag-drop menu
heading yang terdapat pada navigation pane.

Mavigaticn v X
Search Document 2 -
= | oo | =
AEE -~

4 Introduction

| a Drescription '

Detail Analysis

Conclusion

Mavigation v X
Search Document 2 -

= | oo | =
= | oo | =] =

Introduction

4 Conclusion

| 4 Description ;

Dretail Analysis

d. Page View

Page view digunakan untuk menjelajahi dan menavigasi dokumen berdasarkan halamannya. Jika

kita melakukan pencarian pada page view maka hanya halaman yang terdapat hasil pencarian saja
yang ditampilkan.
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Mavigation - X
document x T

Click the arrows to continue your
search

5 | oo | = o~

= | oo | =]

e. Search Results

Tab search results (hasil pencarian) berisi daftar dari hasil pencarian

Mavigation - X
document x

6 matches

% | oo | = P

s |oo | =

to coordinate with the overall
look of your document. You
can use these galleries to
insert tables

, footers, lists, cover pages,
and other document building
blocks. When you create
pictures,

When you create pictures,
charts, or diagrams, they also
coordinate with your current
document look.

IV. Mengelola Konten Dokumen
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1. Memformat Teks

a. Memformat Huruf

Secara default, Ms Word menggunakan jenis huruf / font Calibri yang berukuran 11 point. 1 point
setara dengan 1/72 inchi. Namun kita diperkenankan untuk mengatur atribut huruf tersebut sesuai
dengan keinginan kita. Adapun atribut yang bisa kita atur antara lain:

=

Jenis huruf (Calibri, Arial, Cambria, Times New Roman, dll)
Ukuran huruf

Style huruf (Bold/Tebal, Italic/Miring, Normal)

Warna huruf

Garis bawah

Efek huruf (Superscript, subscript, dll)

Word Art

Bentuk huruf (huruf kapital semua, huruf kecil semua, dll)
. Jarak antar karakter (spasi)

10. Drop Cap

11. Ligature (seni style teks)

© O NG W

Berikut ini cara mengatur atribut tersebut:

1. Seleksi / blok teks yang akan diformat hurufnya

other document building blocks. When you create pictures, ch
vith your current documentlook.

¥ou can easily change the formatting of selected text in the dg
zelected text from the Quick Styles gallery on the Home tab. Y
the other controls on the Home tab. Most controls offer a cho,
theme or using a format that you specify directly.

iTa change the overall look of your document, choose new The

2. Padatab Home, group Font, lakukan pengaturan atribut sesuai dengan yang kita inginkan.

Home Insert Page Layout References Mailings
j e Cambria 11 - A A | Aam | &

F'_ : 53 Copy b7 . A
aste - 2 ~ 337 . -

- # Format Painter B 7 U-abex x —
Clipboard P Font P

Atau untuk pengaturan lebih lanjut, pilih launcer (ikon panan pada kanan bawah) pada
group font atau tekan CTRL + D
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Home Insert Page Layout References Mailings Review
4 cut - .. —
L ) Calibri (Body] =11 = A" A" | Aa~ | & = - i=
ot 53 Copy .
aste - 2 [ - 3BF . - =
- ;churmat Painter Lo abe X, X' | 1 — % = =
Clipboard [ Font IF} |
EEn=E v X |[d] ‘l—fluét (Ctrl+DJ

Atau klik kanan teks tersebut maka akan muncul menu popup, pilih Font.

with your current docump=s-t== " -
Calibriff~ 11 + A" A" £

]
n¥
I

BIUS¥-A-F

zelected text from the Qu p—y

¥ou can easily change the

the othercontrols onthe ™= — ";rachu
Cut

theme or using a format t

&
By Copy
F )

To change the overall loo Paste Options: 1ew The

rhange the looks available o ;e the C

Aoth the Themes gallery ¢ j rovide r

restore the lookofyourd A Font... ained in
=T Faragraph

3. Padajendela font dialog, lakukan pengaturan sesuai dengan yang kita inginkan.

Font )
— ¢
Font Advanced
Font: Font style: Size:
Cambria Regular 11
Brush Script MT - NRE -
Calibri Ttalic 9
Californian FB L |gold 10 E
Calisto MT Bold Italic
2 L E -
Font color: Underline style: Underline color:
| Automatic |ZI | (none) IZ| | Automatic - | .
Effects N
[ strikethrough [ small caps
[ Double strikethrough [T All caps |
[ Superscript [ Hidden
[ subscript
Preview 1
Cambria
This is a TrueType font. This font will be used on both printer and screen. ]

| set AsDefault | [TextEffects... | [ ok || cancel

4. Jika sudah, klik OK.
Efek Huruf
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Strikethrough (efek garis pada tengah huruf)

2l

o
TEE?TAT

Cambria 11 | A AT | Aa-

B 7 U ~ ahe x, x°

I:}ant

Cambria 11 - A A | Aa- | &
B 7 U ~ake x, X° -7 A~

Font

Cambria 11 - A A | Aam | &
B 7 U ~ake x, ¥ - B - A -

Font

WordArt

Subscript (efek huruf diperkecil dan diletakkan dibawah garis huruf normal)

Superscript (efek huruf diperkecil dan diletakkan diatas garis huruf normal)

Berbeda dengan versi Ms Word sebelumnya, WordArt pada Ms Word 2010 dibuat mirip dengan
WordArt pada Ms Powerpoint. Kita tinggal memilih jenis WordArt yang kita sukai atau jika kurang
sesuai, kita bisa mengkustomisasi Outline, Shadow, Reflection, atau Glownya.

Cambria 11 v A A | Aav | By == | EEEE | 4
B 7 U ~abe x, x° L}Hﬁ’?vévgééé = &
Font ~
ﬂ\\‘ .".Iﬂ".
| [c] \ /)
Lol |lm
: JF f A
- T, |'_ A
a“ v < L - S ."’Ir & G
uruf - N
g A A A\
N FA s
L=}
af N
1A A AA
tyle -
_ = | &  Qutiine 0
jrian pada Dokumen _
- £, Shadow 3
o
z Reflection 3
ragraf -
= Glow 3

Bentuk Huruf
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Untuk membuat teks judul, umumnya huruf pertama masing-masing kata adalah huruf kapital. Kita
bisa membuat format teks tersebut dengan otomatis yaitu dengan memanfaatkan fitur Change Case.
Ada lima bentuk huruf yang disediakan yaitu: Sentence case (teks kalimat normal/huruf kapital
diawal kalimat), lower case (huruf kecil semua), upper case (huruf kapital semua), Capitalize Each
Word (huruf kapital pada huruf pertama masing-masing kata/untuk judul), Toggle Case (huruf
kecil pada huruf pertama masing-masing kata/kebalikan judul).

Home Insert Page Layout References Mailings Review W
Cut - + [T — — i
! Cambria (11 - A A [|Aav|| | ==
4 Copy 1
- 2 - Sentence case.
i Format Painter B 7 U -abe x. X E
bboard a Font lowercase |
- - X IE UPPERCASE I
Capitalize Each Word
ocument s IR Lap
tOGGLE cASE II
=] " - | -
Drop Cap

Di koran atau majalah kita sering kita melihat penggunaan drop cap atau sebuah huruf yang
ukurannya besar diawal sebuah artikel.

Abstrak

epak bola adalah olahraga menggunakan bola yang dimainkan oleh dua tim yang masing-
S masing beranggotakan 11 (sebelas) orang, Memasuki abad ke-21, olahraga ini telah

dimainkan oleh lebih dari 250 juta orang di 200 negara, yang menjadikannya olahraga paling
populer di dunia. Sepak bola bertujuan untuk mencetak gol sebanyak-banyaknya dengan
menggunakan bola kulit ke gawang lawan, Sepak bola dimainkan dalam lapangan yang berbentuk
persegi panjang, di atas rumput atau rumput sintetis.

Word memungkinkan kita membuatnya dengan mudah. Yaitu pada tab Insert, group Text, pilih
Drop Cap.

Ligature

Merupakan fitur baru Ms Word 2010. Ligature adalah typography (seni styling teks) di Ms Word
yang memungkinkan kita membuat teks atau huruf menjadi berekor atau mempunyai efek tertentu.
Ligature bisa dimplementasikan jika jenis hurufnya memang support open type ligature. Secara
default ligature tidak diaktifkan.

Cara mengaktifkan ligature:

1. Padajendela Font, pilih tab Advanced
2. Pada Ligature, pilih All

Page 37 of 187



IImuKomputer Com

F @ ™
oty & #0BE S » L2 e
Advanced

Character Spacing
Scale:  |100% [~]
Spadng: |Mormal IZI By:
Position: |Mormal EI By:
[ Kerning for fonts: 2| Points and above I

L LANIR] L

OpenType Features

Ligatures: All E

Mumber spacing: Nane
= * |Standard Only

Standard and Contextual

Humber farms;: Historical and Discretionar L

Stylistic sets:
[ Use Contextual Alternates

Preview
]

Test

This is a TrueType font. This font will be used on both printer and screen.

| setasDefault | | TextEffects... | [ o« || cancel

3. Selesai

Pada contoh diatas, untuk kata “Test” terlihat bahwa huruf “s” dan “t” tersambung, inilah yang
dimaksud efek ligature.

Dengan menggunakan font tertentu dan beberapa pengaturan, kita bisa membuat efek ligature
yang bagus. Contoh:

f_‘;\-.\_\_\_

Gtﬁmaf Mml‘(mah

Hi;éﬁlgaﬂ Kami

Caranya: gunakan jenis huruf / font : Gabriola, lalu pilih Stylistic sets: 6
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=

12
e LPeel »
Adwvanced

Character Spacing
Scle: | 100% [~
Spacing: | Mormal El By:
Position: |Mormal IEI By:

[] Kerning for fonts: = Points and abave

¥ Ak

OpenType Features
Ligatures: Al
Mumber spacing: | Default
Mumber forms: Default

Stylistic sets: W

[ use Contextual Alternates

KN|EN|EN| KN

Preview

S_e_;[a_hmt Menikmati N

This is a TrueType font. This font will be used on both printer and screen.

[5etnsgefault] lTextEFFects... ] [ oK ] [ Cancel ]

é

b. Memformat Paragraf

Paragraf sebagaimana mana yang kita tahu merupakan kumpulan dari beberapa kalimat dalam satu
blok. Pengaturan format paragraf meliputi: perataan atau alignment, spasi, indentasi, tab, dan
hypenation.

Alignment

Kita bisa melakukan pengaturan alignment atau perataan teks pada suatu paragraf, yaitu dengan
rata kiri, kanan, tengah atau rata kiri dan kanan. Caranya:

1. Seleksi paragraf yang akan diformat alignment-nya
2. Padatab Home, group Paragraph, pilih salah satu alignment

E-E-E | EET
Paragraph fa |
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RATA KIRI

Omn the Inzert tab, the galleries include itemns that are designed to coordinate with the overall
ook of vour document. You canuse these galleries to insert tables, headers, footers, lists,

cover pages, and other document building blocks.
RATA TENGAH

When you create pictures, charts, or dlagrams, they also coordinate with your current
document look. You can easily change tfle formatting of selected text in the docwment text
by choosing a look for the selected texf from the Cuick Styles gallery on the Home tab.

RATA KAMNAN

Tou can also format text directly by using the other controls on the Home tab. Most
controls offer a cheice ofusing the look from the current theme or using a format that vou
specify directly.
RATA KIRI DAN KAMNAN
o change the overall lock of yvour documernt, choose new Thane elements on the Pagq

ayout tab. To change the looks available in the Cuick 53tyle gallery, use the Chang
wrent Chack Style Set command.

Masih berkaitan dengan alignment, pada Ms Word terdapat fitur hyphenation yang berfungsi
melakukan pemenggalan otomatis terhadap suatu kata jika diperlukan.

When wou create pictures, charts, or diagrams, they also coordinate with your current
document look.

When vou create pictures, charts, or diagrams, they also coordinate with your current doc- ‘
wment look.

Pada gambar di atas, teks pada paragraf pertama tidak menggunakan hyphenation, sedangkan pada
paragraf kedua menggunakan hypenation. Terlihat bahwa kata “document” pada paragraf kedua
dipenggal menjadi “doc-ument”.

Cara mengaktifkan fitur ini yaitu: pada tab Page Layout, group Page Setup, pilih Hyphenation,
kemudian pilih Automatic.

Page Layout References Mailings Review iy
yy Ij = Breaks ~ j
=) £ Line Numbers -
Crientation  Size Cnlumns[ 1 Watermark
- - - b~ Hyphenation - - a
Page Setup None I
¥ X |Docwr | | pautomatic
p - Ward Manual 4
the or
a v | |b¥ Hyphenation Options..
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Indentasi

Indentasi digunakan untuk mengatur posisi dan batas teks suatu paragraf. Secara umum ada 4 jenis
indentasi:

- First Line Indent : digunakan untuk mengatur baris pertama dari suatu paragraf.

- Hanging Indent : digunakan untuk mengatur baris selanjutnya dari suatu paragraf
- Left Indent : digunakan untuk mengatur batas kiri suatu paragraf

- Right Indent : digunakan untuk mengatur batas kanan suatu paragraf

Pada prakteknya Hanging Indent sama dengan Left Indent.

Paragraph T P Right Indent

I+ 3+ 1+ 4+ 1 5 1t &+ 1+ 701 B A1 1D

=l

21 oA
| |

On the Insert tab, the galleries include items
Hanging Indent |that are designed to coordinate with the overall look of
& Left Indent wvour document. You can use these galleries to insert
tables, headers, footers, lists, cover pages, and other
document building blocks. When you create pictures,

charts, or diagrams, they also coordinate with your

current document look]

Ada beberapa cara untuk mengatur indentasi suatu paragraf, yaitu:

- Gunakan tombol indentasi sebagaimana ditunjukkan pada gambar diatas yaitu dengan
menggeser posisi tombol tersebut dengan mouse kekiri atau kekanan.

- Atau gunakan tombol indentasi di menu ribbon, tab Home, tab Paragraf, klik tombol
Decrease dan Increase Indent

sen
Il
4

I
(il
il
Il
JT
5 7
4

s— = = i= 3= | A
==t |[IEE|EL| W
—_ = = = b= N
Paragraph *.
4-1-3-1-2-1-1-|-I-|-l:\"\31-

Pada jendela paragraph, lakukan pengaturan pada bagian Indentation:
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Paragraph “ M
Indents and Spacing | Line and Page Breaks

General

Alignment: Justified E

Cutline level: |Body Text IZ|

Indentation
Left: 1.27 cm= Spedial: By:
Right: Ocn = {none) IZ| z
! [ Mirror indents
Spacing L
Before: 0pt = Line spadng: At
s ) = | M
|| Afer: ept |2 Multiple E s [
Don't add space between paragraphs of the same style
|
L
Prewview
1
[
e Taom Sl T S e Taeo Sampa Tae Rergla Tem el e T ol a T Sarle. [
Tam fawole Tees Savole Tes Bawole Tees Samole T Ramole Tees Samole T Bamole Tes
Rergl s Tes gl e Tes Rargle Tes rgls Tes Rrgls Tes lamgla Tes
’ Tabs... ] [ Set As Default ] [ oK ] ’ Cancel
Tab

Berbeda dengan alignment paragraf yang mengatur perataan suatu paragraf, tab berfungsi untuk
mengatur perataan suatu teks pada suatu paragraf. Misalnya pada kasus seperti gambar dibawah
ini:

JMengetahui, J
Kepala Pusat, Sekretaris

NIP. NIP.

Caranya, gunakan tombol tab pada keyboard untuk memisahkan antara teks “Kepala Pusat,” dengan
teks “Sekretaris”, bukan dengan menggunakan tombol spasi ©. Karena ketika kita menekan tombol
spasi maka kursor akan begerak satu karakter ke kanan, padahal lebar suatu karakter berbeda-
beda tergantung jenis hurufnya sehingga untuk membuat perataan teks, penggunaan spasi tidak
cocok. Adapun tombol tab, menggerakkan kursor bukan berdasarkan karaker namun berdasarkan
ukuran panjang yang pasti. (cm/inchi tergantung pengaturan). Panjang tab ini disebut sebagai tab
stop (defaultnya 0,27 cm).
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» Jenis-jenis Tab
Kaitannya dengan tab stop ini, ada lima jenis perataan tab yaitu:

- Left Tab: mengatur posisi rata kiri suatu teks

- Center Tab: mengatur posisi rata tengah suatu teks
- Right Tab: mengatur posisi rata kanan suatu teks

- Decimal Tab: ?

- Bar Tab: membuat Left Tab dengan garis vertikal

Dalam satu baris teks dimungkinkan untuk mengatur lebih dari satu tab stop dan jenis tab.
Misalnya untuk membuat format kolom dan baris tanpa tabel.

_R'I'ILI'Z"'J'"""I'S"'G'J_'?"'ﬁ'|'9'"15'"'L|1|"17-"'13'"14"'15"'16')\
= O T T O O l

iDAFTAR STOK DAN HARGA BARANG

;i\lo Nama Barang Jumlah Harga
1. Ikan 4 (KG) Rp. 400.000
2. Tempe 10 Rp. 10.000

Tab stop ditandai dengan garis hitas pada ruler (penggaris) horizontal. Lebih jelasnya lihatlah pada
gambar berikut:

A B A C A DA
E-l-ll_l-l-l-].-|-4-|-5-|-E.-J_-?-|-:5-|-9-|-1c|-|-u||
:DAFTAR STOK DAMN HARGA BARANG
:!\Ic:- MNama Barang Jumlah Harga
1 lkan 4 (KG) Rp. 400.000

Keterangan:
A =Bar Tab
B = Left Tab

C = Center Tab
D = Right Tab
» Mengatur Tab

Ada dua cara mengatur tab:

1. Pilih jenis tab dengan cara mengklik ikon tab di pojok kiri atas
2. Klik horizontal ruler untuk mengatur tab stop

Page 43 of 187



IImuKom' uter.Com

3. Geser ke kanan atau ke kiri sesuai dengan yang diinginkan

323 cdy g

| e
:{}AFTAR STOK DANLeft Tabja E

Atau

1. Padatab Home atau Page Layout, klik menu launcher Paragraph.

2. Pada bagian bawah jendela paragraph, klik tombol Tabs.

|
I Tabs... [ Set As Default

3. Padajendela Tabs, masukkan pengaturan tabs.

i X
Tabs . m
Tab stop position: Default tab stops:
10 1.27 cm -
5cm
“| Tab stops to be deared:
Alignment
D Left ) Right
() Dedmal Bar
Leader
Il @ 1MNone o R ©3—
oDa_
[ Set [ Clear ] [ Clear all ]
[ oK J [ Cancel ]
e i

Masukkan panjang tab / tab stop pada kolom tab stop position, kemudian tentunkan jenis
tab pada Alignment, tentukan juga Leader (karakter untuk mengisi spasi kosong), kemudian
klik tombol Set.

4. Ulangi langkah nomor 3 untuk melakukan pengaturan tab selanjutnya.
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5. Adapun tombol Clear dan Clear All fungsinya untuk menghapus pengaturan tab.

Mengatur Spasi

Spasi yang dimaksud disini meliputi spasi atau jarak antar baris (line spacing) dan spasi antar
paragraf spacing. Satuan ukuran yang digunakan pada spasi adalah pt atau point, satu point setara
dengan 1/72 inchi.

Spasi Baris
Untuk melakukan pengaturan spasi baris, caranya:

1. Seleksi teks yang akan diformat
2. Pada tab Home, group Paragraf, klik ikon panah atas bawah (Line and Paragraph Spacing),
pada menu yang muncul pilih salah satu nilai (1.0 atau 1.15 atau 1.5 dst)

%EE%E & R Heading 3
Farag 1.0
v | 115
llowing files. Save 1.5 I})
' 2,0
2.5
tosaved)] & 30
from the last ...
Fdayr August ... Line Spacing COptions...

3. Untuk pengaturan lebih lanjut klik menu Line Spacing Options
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Paragraph [0
Indents and Spadng | Line and Page Breaks |
General
Alignment: Justified IZ|

Outline level: |Body Text |Z|

Indentation
Left: 0.63 am = Special: By:
Right: Oon  [= Hanging |E| 0.63 cm=

[ Mirror indents

Spacing
Before: Opt = Line spacing: At:
after: &pt = Multiple -| 115 =
Don't add space between paragia Singl_e
1.5lines
Double
Preview At least
review Exact
1]
’ Tabs... l [ Set As Default ] I[ QK JI[ Cancel
4. Selesai.

To change the overall look of your document, choose new Theme elements on the Page
Layout tab. To change the looks available in the Cuck Style gallery, use the Change Cur-
rent Quick Style Set cormmand. Spasi 1.15

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa.
Fusce posuere, magna sed pulvinar ultricies, purus lectus malesuada hbero, =it amet

commeodo magna eros quis uma.l Spasi 2

Spasi Paragraf

Spasi paragraf merupakan jarak antara paragaraf dengan paragaf sebelum dan sesudahnya. Cara
mengaturnya:

1. Seleksi paragaraf yang akan diformat

2. Pada tab Page Layout, group Paragraph, kemudian pada bagian Spacing, tentukan kolom
before dan after. Before yaitu jarak antar suatu paragraf dengan paragraf sebelumnya,
sedangkan after yaitu jarak antar suatu paragraf dengan paragraf sesudahnya.
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Indent Spacing

iS leftt 064cm o | }= Before: Opt :

£= Right: 0 cm s S after 6 pt %:
Paragraph a

3. Atau bisa juga dengan mengklik ikon launcer di kanan bawah.

c¢. Tips Trik

Untuk mencoba suatu fitur khususnya yang berkaitan dengan formatting, kita menggunakan teks
dummy atau teks asal. Beberapa orang membuat teks dummy dengan mengetik di keyboard dengan
cepat tanpa melihat, beberapa lagi memilih mengcopy dari dokumen lain atau internet.

Sepertinya pengembang Word (Microsoft) memahami akan hal ini, oleh karena itu dibuatlah fitur
untuk menggenerate teks dummy. Yaitu dengan mengetikkan teks2 berikut lalu tekan enter makan
teks dummy akan degenerate otomatis.

LOREM

=lorem()

Hasilnya

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce
posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna eros
quis urna.

Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus.

Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. Proin
pharetra nonummy pede. Mauris et orci.

RAND
=rand([x],[y])

Dimana x=jumlah paragraph, dan y = jumlah baris minimal pada setiap paragraph

=rand(2,1)

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of
your document.

You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document
building blocks.
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2. Mengatur Layout Halaman

Layout halaman merupakan tata letak halaman dalam sebuah dokumen yang bisa kita atur sesuai
dengan keinginan kita. Meliputi: margin, orientasi, ukuran, kolom dan break.

a. Margin

Margin merupakan jarak antara area utama konten dengan batas kertas.

When you create pictures, charts, or diagrams, they also coordinate with your current doc-
ument look.

‘When you create pictures, charts, or diagrams, they also coordmate with your current doc-

é ument look.

Kita bisa melakukan pengaturan margin, caranya:

1. Pada tab Page Layout, group Page Setup, pilih Margin
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Insert Fage Layout References kdailir

F‘. 3 13 -| %= Breaks *
S =]
= — #3 Line Nu
Margins| Orientation Size Columns a
- - - - he Hyphen
Last Custom Setting ]
Top: 4 cm Bottom: 3 cm i
Left: 4 cm Right: 3 m A

T

Normal
Top: 254 cm Bottom: 2.54 cm
Left: 254 cm  Right: 2.54 cm

MNarrow
Top: 1.27 cm  Bottom: 1.27 cm
Left: 127 cm  Rightt 1.27 cm

(I ———

Moderate
Top: 254 cm Bottom: 2.54 cm
Left: 1891 cm Rightt 191 cm

Wide
Top: 254 cm  Bottom: 2.54 cm
Left: 508 cm  Right: 508 cm

Mirrored
Top: 254 cm  Bottom: 2.54 cm
Inside: 315 cm Cutside: 2.54 cm

Office 2003 Default
Top: 254 cm  Bottom: 2.54 cm
Laft: 318 cm  Right: 318 cm

Custom Margins... .

2. Pada menu yang muncul, pilih salah satu pengaturan margin yang telah disediakan. Namun
jika menginginkan lain, maka pilih Custom Margin...
3. Padajendela Page Setup, lakukan pengaturan pada bagian Margin
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P——— 3

Page Setup @

Margins | Paper ILayout |

Bottom:

Right:

Gutter position:

Orientation

Al || [A)

Portrait Landscape

Pages

Multiple pages: Mormal IEI

Preview

apply to: | This section =
This section

L This point forward

Get As Defa ywhole document oK ] ﬂ]

Top menunjukkan margin atas, left adalah margin kiri, dst. Adapun Gutter menunjukkan
jarak untuk keperluan penjilidan dokumen, lebih jelaskan lihatkan gambar berikut yang
ditunjukkan oleh angka 1.

1

" s

% | T =
: Vi —
V i '
C a1 L) J
i H :
M

Secara default nilai gutter adalah 0. Untuk gutter position tergantung jenis page atau
halaman yang digunakan. Pada page normal ada dua opsi yaitu left (kiri) dan top (atas).
Adapun gambar diatas menggunakan setting page buku yaitu Mirror Margin, maka gutter
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positionnya secara default akan dinonaktifkan atau disable karena diasumsikan posisi

gutternya ada ditengah.

IITsne, gy il | — OTSe, T I —
Gutter: 0 cm = Gutter position: Left

Orientation

A !

Portrait Landscape

FPages

Multiple pages: Mirrar margins
Maormal

Mirror margins *
2 pages per sheet
Book fold

4. Lalu pada bagian Apply to, pilih whole document agar pengaturan ini berpengaruh pada
semua halaman dalam dokumen tersebut.

b. Ukuran

Ukuran yang dimaksud disini adalah ukuran kertas yang digunakan. Apakah A4, Folio, Legal, Letter,
dsb. Caranya:

1. Pada tab Page Layout, group Page Setup, Pilih Size,
2. Pada menu yang muncul pilih salah satu ukuran kertas
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Page Layout References Mailings

EY M EFE
£ Line Numbers
Orientation | 53ize |Columns

- - - b~ Hyphenation

Letter |
|:| 21.58 cm x 27.94 cm |

Legal B
I:I 21,59 cm x 35.56 ¢m E

a4 :
Do S

kf"aﬁr.ﬂﬂmc@ 21 emx29.7 cm !
m

o

EMan Versi -

; AS
"1 Saat Ini |:| 148 cmx 21 cm
k"m-'-::ukumvzn
men Envelope #10

. 10.48 cm x 24,13 cm
5i D

te Envelope Monarch
9.54 cm x19.05 cm
w

"plamlate More Paper Sizes... % 1
E |

3. Atau pilih More Paper Size untuk melakukan pengaturan manual.

Page Setup
@ Paper Layout
Paper size:
A4 -
Width: |21cm =
Height: |29.7cm =
Paper source
First page: Qther pages:

c. Orientasi

Orientasi atau sudut pandang dokumen berkaitan dengan pengaturan ukuran kertas. Umumnya
ukuran kertas memiliki panjang dan lebar yang berbeda, oleh karena itu diperlukan pengaturan
orientasi. Ada dua jenis orientasi yaitu : Portrait (Vertikal) dan Landscape (Horizontal). Caranya:

1. Pada tab Page Layout, group Page Setup, pilih Orientation
2. Pada menu yang muncul pilih salah satu jenis orientasi
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Brt Page Layout Ref

[ —

i =Rl

gins |Orientation| Size Co

- -

R
— Partrait
| Landscape

d. Kolom

Secara default, Ms Word menampilkan teks dalam satu kolom, namun kita bisa menampilkan suatu
teks paragraf dalam beberapa kolom sebagaimana yang biasa digunakan pada majalah atau koran.
Dalam satu halaman dimungkinkan untuk diformat dalam dua (atau lebih) pengaturan kolom.

Caranya:

1. Seleksi teks paragraf yang akan diatur kolomnya

formatting of selected text in the document text by choosing a lock for the selected text
from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls onthe Hometab.

Most controls offer a choice of using the look from the current thame orusing a format that
wvou specify directly. To change the overall look of vour documernt, choose new Theme el-
ements on the Page Layout tab. To change the looks available in the Cuuck Style gallery,
use the Change Current Quick Style Set command. Both the Themes gallery and the Chuck
Styles gallery provide reset commands so that vou can always restore the look of yvour doe-
urnert to the onginal contained in vour current template. On the Insert tab, the galleries m-
clude items that are designed to coordinate with the overall look of vour document.

You can use these galleries to msert tables, headers, footers, lists, cover pages, and other
document building blocks. When vou create pictures, charts, or diagrames, they also coordi-

2. Pada tab Page Layout, group Page Setup, pilih Columns
3. Pada menu yang muncul, pilih jumlah kolom yang diinginkan, misalnya 2, maka pilih Two.
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|_—'—‘n [j = Breaks ~
= £ Line Numbers
Crientation Size |Columns
= = - be~ Hyphenation
Page Se
| = One
| | =—
2o
== Two
- v %
ERE= Three
emplate
= Left
=t Right
raf
More Columns...

4. Atau untuk pengaturan lebih lanjut, pilih More Columns

Columns @

Presets
One Two Three Left Right
Mumber of columns: |2 = [ Line between
Width and spacing Preview
Col #: Width: Spacdng:

.37 =] [L27em |2
6.37am | :
| — :

Equal column width

Apply to: | This section E| Start new column

[ 0K J[ Cancel l

Untuk memaksa suatu teks kata atau kalimat berpindah ke kolom selanjutnya, gunakan menu
Breaks > Column
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Page Layout References Mailings Review My Tab View D

3 j J L=, (/= Breaks - | H g;h 'm Inde

Page Breaks

Orientation 5ize  Columns

- = = Bage
» Mark the point at which one page ends
PR SET ﬁ and the next page begins,
* X | Docut
b Column

. ]
2o Ezr;l[ = Indicate that the text following the column
= break will begin in the next column,

Text Wrapping %
Separate text around objects on web
pages, such as caption text from body text.

. ~
Avail

3 - el
L
Template

e. Memahami Section Dokumen

L il L

Pernahkah Anda melihat sebuah dokumen Word yang memiliki format orientasi dokumen yang
berbeda misal halaman pertama vertikal dan halaman kedua horizontal?, atau pernahkan Anda
menjumpai format page number yang berbeda terutama pada karya tulis yaitu halaman kata
pengantar, daftar isi, daftar gambar menggunakan format huruf romawi kecil, sedangkan halaman

isi menggunakan format angka?

[tulah implementasi dari section, sebuah istilah yang cukup penting berkaitan dengan pengaturan
layout dokumen. Section membagi sebuah dokumen menjadi beberapa bagian yang mana masing-
masing bagian bisa kita atur layoutnya secara berbeda. Sebuah dokumen Ms Word minimal

memiliki satu section.

Membuat Section Baru

Untuk membuat section baru gunakan menu ribbon tab Page Layout | Breaks (pada group Page
Setup) | pilih salah satu dari Section Breaks, misal pilih Next Page artinya section baru akan

diimplementasikan pada halaman berikutnya.

Page Layout References Mailings Review My Tab View De
,—,Breaks - H (L:h 'T Inden
' Page Breaks i
Orientation 5Size Columns
- - - Page 4
¥ Mark the point at which one page ends
(EEE S and the next page begins.
- X
Column
P~ Indicate that the text following the column |
I:_I] _ = break will begin in the next column.
Text Wrapping
. = Separate text around objects on web
itain pages, such as caption text from body text,
reate headings . Section Breaks
ng Heading — Next Page
b Insert a section break and start the new

— section on the next page.

Continuous
Insert a section break and start the new
— section on the same page.
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Untuk melihat apakah kita berhasil membuat section caranya adalah double klik header dokumen
halaman kedua.

| Header -Section 2- | Same as Previous |

Tampak bahwa dua halaman tersebut memiliki section yang berbeda.

Studi Kasus 1 : Mengatur Orientasi Yang Berbeda Antar Halaman

Letakkan kursor pada section kedua, lalu pada menu ribbon tab Page Layout | pilih menu launcer
(pojok kanan bawah) pada group Page Setup:

Insert Page Layout References Mailings R

0B 0 g
kY
= {3 Line Numbers -

Margins Orientation Size Columns

- - - b~ Hyphenation ~
‘ Page Setup P
1 [ —

Atur orientasi halamannya menjadi landscape, dan pastikan orientasi ini diaplikasikan hanya untuk
section tersebut.
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atloh limu deenaan »‘4.:,-.;4.’.i5oc_a.‘.,‘.3;1

Margins Paper | Layout

Maragins
Top: 2.54am lil Bottom: 2.54am lil
Left: 2.54cm | right: 2.54cm =)
Gutter: 0cm lil Gutter position: Left n
Orientation

>

Portrait Landscape

Pages

miwepsgs [roms [3

Preview

Hasilnya:

Footer -Section 1-

Header -Section 2- Same as Previous

Studi Kasus 2 : Mengatur Page Number Yang Berbeda Antar Halaman

MEMBUAT PAGE NUMBER SECTION 1 (ROMAWI KECIL)

Caranya: arahkan kursor ke footer pada halaman pertama section 1, lalu pada menu ribbon pilih tab
Insert | Page Number | lalu pilih Page Number yang sesuai. Misal pilih Plain Number 2
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A= A g | &% signature Line ~ Tc Q

5}, Date & Time
Text Quick WordArt Drop )
Box~ Parts~ - Cap~ "8 Object ~ ‘

Top of Page b | Text

Equation Symbol

Symbols ‘

Bottom of Page k| Simple
Page Margins ¢ | Plain Number 1

Format Page Mumbers... 1

=
&
=
|ﬂ Current Position »
oy
#x

Eemove Page Numbers

Plain Number 2

Hasilnya

Footer Sectont- |

Karena secara deafult masih menggunakan format angka, maka ubah menjadi format romawi kecil,
caranya: pada menu ribbon tab Design, pilih Page Number | Format Page Numbers

5 [ b

Date Quick Picture

& Time Parts -
; @ Top of Page ¥
@ Bottom of Page k
g EI Page Margins k
[ﬂ Current Position k
@ Format Page Mumbers,..
1 |£3g Bemove Page Mumbers

Lalu pilih number format yaitu romawi kecil, dan start at i
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i )

Page Number Format @
Mumber format: |i, ii, ii, ... IEI
[ tndude chapter number

Chapter starts with style: |Heading 1

|Ise separator: - (hyphen)

Examples: 1-1, 1-A

Page numbering

(7} Continue from previous section

-

i@ Startat: i =

Hasilnya

Footer -5ection 1- |

MEMBUAT PAGE NUMBER SECTION 2 (ANGKA)

Caranya: arahkan kursor ke footer pada halaman pertama section 2,

Format page number halaman ini mengikuti page number section sebelumnya, karena demikianlah
defaultnya. Untuk mengatur agar berbeda dengan format sebelumnya maka hilangkan keterangan
same as previous. Caranya: pada menu ribbon tab Design, matikan Link to Previous

j‘ | 51, Previous
= 5 Next

Goto Goto
Header Footer [l%la Link to Previous

Mavigation

Lalu lakukan format Page Number
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i

Page Number Format
Mumber format: |1, 2, 3, ... IEI
[ tndude chapter number

Chapter starts with style: |Heading 1
|Ise separator: - (hyphen)
Examples: 1-1, 1-A

Page numbering
(7} Continue from previous section
@ Startat: |1 =

| ok || cancel

Hasilnya

Footer Secton2- |

Studi Kasus 3 : Menghitung Total Halaman dalam Satu Section

Gunakan Quick Parts.

A 4 A= [& signature Line -

(5} Date & Time
Text | Quick 'Wordart Drop )
Box~ |Parts~ - Cap~ *§d Object ~

I_ B2 AutoText 3
ﬁ@&] Document Property L4
x
=1 Field...

Insert Field

Insert a field.

Lalu pilih Section untuk menampilkan section, atau SectionPages untuk menampilkan Halaman
Section
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Field
Please choose a field Field properties Field options
Categories: Format:
_—
{al B3 -
: 1,2,3, .. -
Field names: a, b, ..
MumWords o~ ﬂ{_B{_C, 1
Page i, i i, .. E
PageRef I I, 100, ...
Print 1ist, 2nd, 3rd ...
PrintDate One, Two, Three ... s
Private First Second, Third ... Mo field options available for this field
Quote hex ...
RD Dallar Text i
Ref
RevMum Numeric format:
SaveDate s
SectionPages E 0 -
Zeq 0.00
cat e #7500
Skiplf % ##0,00
StyleRef S#,##£0,00;(s#, #£0.00)
Subject < 0% _ ]
0.00% b Preserve formatting during updates
Description:
Insert the number of the current section
Field Codes [ OK ] ’ Cancel

3. Menggunakan Bullets dan Numbering

Bullets dan Numbering ini fungsinya adalah untuk membuat daftar teks dalam bentuk menu.

a. Bullets

Bullets yaitu daftar teks yang menggunakan ikon

Menggunakan Bullets Bawaan

Caranya:

1. Seleksi teks yang akan dijadikan bullets

Menu:
Sate
Bakso

Awam Balkar

Soto |/\@
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“hEr | EE T

=== = t=- ThE

= = i

Paragraph s

3. Pilih salah satu jenis bullets yang tersedia

%E*‘“E' FE 2T 4 aebe

Recently Used Bullets

e,
-

.
Bullet Library
f
F‘ Mone ® O | 0:0

*
s

Contoh:
Menu:
+ Sate
4+ Bakso
+ Ayvam Bakar
+ Soto

Mendefinisikan Bullets Sendiri

Kita juga bisa mendefiniskan bullets sendiri, misalnya menggunakan gambar pilihan kita sendiri.
Caranya:

1. Seleksi teks yang akan dijadikan bullets
2. Padatab Home, group Paragraph, klik ikon Numbering, lalu klik Define New Bullets
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Recently Used Bullets

-

Bullet Library ]
f
Fll w *
one ® O | + 0‘4

1 |[v

| Document Bullets

+ i,
¢¢¢ ® »” O -

T 3

Define New Bullet... L\x,

3. Kita bisa menggunakan Symbol, Gambar, atau Font pilihan kita.

[ Define New Bullet =

Bullet character

Symbal. .. ]

Alignment:

Left IEI

Preview

B

Ok ] [ Cancel

4. Klik OK

Contoh:
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¥ Sate
v Bak=o
v  AyamEBakar
v Soto

Mengubah Level Bullets

Secara otomatis, Ms Word membuat leveling bullets. Maka kita bisa mengubah level bullets untuk
membuat sub menu atau sub daftar. Caranya:

1. Kilik teks yang telah diformat bullet

Menu:

Sate

Sate Ayam
Sate Kambing
Bakso

Ayam Bakar

4 € € € € <

Soto

2. Klik menu Bullets

Darsmramly

3. Pilih Change List Level..
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EE’EE’lE’|£§§§|%l| ﬂ AaBhCcDé
Recently Used Bullets =
| ! b"-\-._
v I+
Bullet Library

E]E ollolla

“*-  Change List Level »

Define Mew Bullet...

4. Pilih level bullets, misal level 2.

Ly

5. Maka teks yang diselect akan berubah menjadi level 2 atau dibawahnya.

Menu:
v Sate
5] ate Ayam
o Sate Kambmng
v Bak=o
¥  Avam Bakar
v  Soto|

Atau kita bisa menggunakan cara yang lebih cepat yaitu dengan memanfaatkan tombol Indentasi
(decrease dan increase). Decrease Indent untuk menurunkan satu level, sedangkan Increase Indent
untuk menaikkan satu level.
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Paragraph Fa

b. Numbering

Numbering yaitu daftar teks yang menggunakan angka dan huruf.

Menerapkan Numbering

Caranya:

1. Seleksi teks yang akan dijadikan Numbering

Menu:

Sate

Baks=o
Awam Balkar

Soto

2. Tab Home, group Paragraph, pilih ikon Numbering

Paragraph I |

3. Pilih salah satu jenis Numbering yang tersedia
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i i | E=EEE | A
=-[E[LE (#2287 A aamn
é Recently Used Number Formats &

1—
2 —
33—

Followin
b,

Mumbering Library

1 1)

Itosave 3 2)

from tf Mone : Y
sday, £

l. A a)

Il. B. b)

i c.—y—1 |0

4. Maka hasilnya:

Mlenu:
A Hate
E. EBak:=o
C. Ayam Bakar
D. Soto

Mengubah Level Numbering

Sama dengan bullets, disini kita bisa mengubah level Numbering
Caranya:

1. Seleksi teks numbering yang akan diubah levelnya

Menu:

Sate

Sate Ayam
Sate Kambing
Bakszo

Ayam Bakar
Soto

mmg 0w

2. Pada tab Home, group Paragraph, pilih Numbering
3. Change List Level
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h limu dengan menuliskannaya
=— = = i= 3= | A
= i: - 1“-_." | §= t.-—l zl | qr 1. .Aaﬂh'ci_
= é Recently Used Mumber Formats |:|
A 1.
B. 2. i
I
C. 3
ollowing
Numbering Library
1. 1)
tosave Nane 3 2)
from th 3 3)
sday, £
| Document Number Formats
1 A a
2 B. b
3 C. C )
hd
<3-  Change List Level k|
Define Mew Number Format...
gf Set Numbering Value...

4. Plih level tertentu, misalnya satu level dibawahnya:

A

r

B

L

a.

Atau bisa juga dengan menggunakan tombol Indentasi

Paragraph a

5. Maka numbering teks akan berubah
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Menu:

A Sate
a. SateAwyam
b. Sate Kambing
E. Bakso
C. Ayam Bakar
D. Soto|

Memodifikasi Multilevel Numbering

Secara default, Ms Word telah membuat aturan format level numbering sendiri. Namun kita bisa
memodifikasinya sesuai dengan keinginan kita.

Misalnya pada numbering berikut:

I PENDAHULUAN
IL. LATAFR BELAEANG
I SEJARAH
Iv. ISI
V. DASATR TEORI
VI IMPLEMENTASI
VIL PENUTUF
VIIL ERITIE
IX SARAN

Kita ingin mengubah numbering I. menjadi BAB I . Caranya:

1. Seleksi teks numbering yang akan dimodifikasi

L PENDAHULUAN
II. T1ATAR BELAEANG
1. SEJARAH
Iv. ISI
V. DASAR TEORI
VI IMPI EMENTASI
V1L PENUTUP
WIII. EKEITIE
IX SARAN

2. Padatab Home, group Paragraph, klik ikon Numbering
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3. Pada menu yang muncul, pilih Define New Number Format...

c) C. iii.

<= Change List Level
Define Mew Mumber Format.

1 set Mumbering ¥alue...

4. Pada jendela yang muncul, kolom Number Format, tuliskan kata BAB didepan huruf romawi

L

L.
Define Mew Mumber Format @ Define Mew Mumber Format @
Mumber format Mumber format
Mumber style: MNumber style:
II, I, .. [~ 1,1, 10, ... v
Mumber format: \ MNumber format:
L | l>|BAB I |
Alignment: Alignment:
Right [~ Right [~
Preview Preview
| ok || cancl ok || Ccancel

5. Lalu klik OK
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EAE1 PENDAHULUAN
BAEBII LATAR BELAEANG
EAB III SEJARAH
BAB IV I51
BEAEWV DASAR TEORI
EAE VI IMPTEMENTASI
EAE VII PENUTUP
EAE VIII ERITIE
EABIX SABAN

Kita juga bisa memodifikasi format numbering pada level dibawahnya

BAEI PENDAHULUAM
LATAR. BELAKANG
SEJARAH
BABII  ISI

a. DASAR TEORI

b. IMPLEMENTASI
BABIII PENUTUP
KRITIK
SARANM]|

N

o o

Pada gambar numbering di atas, level ke dua kode numberingnya adalah huruf abjad kecil (lihat
LATAR BELAKANG, SEJARAH, dst), kita bisa memodifikasi sesuai dengan keinginan kita, misalnya
dari a. menjadi I. A. menyesuaikan dengan numbering level diatasnya. Caranya:

1. Arahkan kursor mouse pada numbering diatas

BAET  PENDAHULUAN
. [LATAR BELAKANG
SEJARAH
BABII  ISI
DASAR TEORI
b. IMPLEMENTASI
BABIII  PENUTUP
KRITIK
b. SARAN

=

o

fa

2. Padatab Home, group Paragraph, klik ikon Multilevel List
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Paragraph s

3. Lalu pada menu dropdown, pilih Define New Multilevel List...

1. a [

L Jp— ) P 121 —

=== Change List Level L4

Define New Multilevel List... I}
Define Mew List Style...

4. Padajendela yang muncul,

' Define new Multilevel list )
Click level to modify: Apply changes to:
1 . i
\B ‘Whnle list El
i 3 Link level to style:
5 i (o style) -]
g K a Level to show in gallery:
g i p ‘Level 1 El
- a- ListMum field list name:
- — |
Murmber format
Enter formatting for number: Startat: |5 Iil
|a_ | Font... Restart list after:
Mumber style for this level: Indude level number from: |Leve| 1 El
ab ¢ .. E' | El Legal style numbering
Paosition
Mumber alignment: Aligned at: Follow number with:
Text indent at: .54 am El [ Set for All Levels... ] i;::a;abctet; t El
b stop at:
[ ok J[ concel |

5. Pada bagian Click level to modify, pilih level numbering yang akan di modifikasi, yaitu level
2.
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Define new Multileve
Click level to modify:
el Bl —

B

6. Lalu pada bagian Numbering style for this level:, ubah menjadi huruf abjad kapital

Mumber format
Enter formatting for number;

2
Number style for this level: Inch
ab,c, ... -~ I:
(none) A

Pa1, 2, 3, ...

Il
?ﬁ%%m I
a b, .. [g e g|

7. Arahkan kursor pada kolom Enter formatting for number, di sebelah kiri teks abjad.

Mumber format
Enter formatting for number:

A

Mumber style for this level: Incude |

A,B,C, .. =] |

8. Kemudian pada Include level number from, pilih level 1

Mumber format
Enter formatting for number:

A || Font...

Mumber style for this level: Indude level number from:
AE,C, .. []

Position

9. Edit dan sesuaikan pada kolom Enter formatting for number,

Mumber format
Enter formatting for number:

B

Mumber style for this level: Indude le’

AB,C, .. []|

Menjadi
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Define new Multilevel list

Click level to modify:

| Bl

1.

mm-qm-.n.hf-uﬁl—l

2k}

-

Mumber format

|1a |E

Mumber style for this level: Induge level number fr
AB,C,
10. Klik OK
BAE1I PENDAHULUAN
I.A LATAR BELAKANG
I.BE. SEJARAH

EAEII
II.A  DASAR TEOERI

II.BE. IMPLEMENTASI
BABIII  PENUTUP

I A KEITIE
II.B. SARAN

Dengan cara yang kita bisa memodifikasi numbering pada level berikutnya.

4, Memformat Tabel

Ada beberapa cara untuk membuat tabel pada Ms Word selain dengan cara insert manual, yaitu:

Menggambar Tabel
Konversi Teks ke Tabel
Tabel dari Ms Excel
Quick Table

BN e

a. Menggambar Tabel

Kita bisa membuat sebuah tabel dengan cara menggambarnya manual dengan mouse. Caranya:

1. Pada tab Insert, klik tombol Tabel, Ialu pilih Draw Tabel
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Hame

nk FPage
j&  Break

I

.2 Pengaturar
vigasi dan Pe
lentasi dan Tz
1 Indentasi
.2 Tab

jnipulasi Tabe
w1 Menggamk

w2 Konwersi Te

Insert

Page Layout References

g P X

Clip Shapes Sma
Art -

HE

Table

W

Faal

Picture

llets dan Mum

Insert Table

I
I
I
I
I
I
I
I o ¢

Insert Table...

Draw Table

rt Text I"\‘?_-

Excel Spreadsheet

B &l E E

Quick Tables 3

Maka kursor mouse akan beruah menjadi gambar pensil.

g
I

Drag dan tarik untuk membuat sebuah sel

__________

Maka jadi sebuah kolom

Tambahkan kolom berikutnya dengan cara yang sama

¥
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dst.
5. Berikut ini contoh hasilnya:

Jika telah selesai menggambar tabel, untuk mengembalikan kursor mouse ke mode normal caranya:
Pada tab Desain, group Draw Borders, klik Draw Table.

I &% shading~  —— -

Design Layout

_____ ¥ pt -

Draw | Eraser
Table

Draw Borders u

= ﬁF‘en Colar =

Pada group Draw Borders diatas, kita bisa mengatur warna, ketebalan, dan model garis tabel yang
akan kita gambar. Disamping itu juga ada fasilitas Eraser yaitu untuk menghapus sel pada tabel
yang telah kita gambar sebelumnya.

b. Konversi Teks ke Tabel

Suatu teks berpola kolom dan baris, bisa kita konversi menjadi sebuah tabel.

Misalnya untuk teks berikut:

No;Nama Barang;Jumlah;Harga Satuan;Total
1;Mouse;2;25.000;50.000
2;Keyboard;4;100.000;400.000
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Teks diatas memiliki pola kolom dan baris yaitu dengan delimiter antar sel adalah tanda titik koma
“;”. Untuk mengkonversinya menjadi tabel caranya:

) .

1. Seleksi teks tersebut
2. Pada tab Insert, pilih Table, kemudian Convert Text To Table...

Home

LN

k!l

GAPLIKASIEAMN
ink ke File

ink ke Halam
.ink ke Lokasi
SUAT ENDMOT

vienambahkar

Insert

Page Layout References

hd B8 [P T

Picture Clip Shapes Smal
Art -

HEE

Table

M |

Insert Table

I o
I
| o
I o
I
I
I o
o T

Insert Table...

Draw Table

Convert Text to Table..,
Excel Spreadsheest

vienambahkar

Bl sl [ B E

Quick Tables 3

Pada jendela Convert Text to Table, bagian Separate text at, pilih Other, lalu ketikkan tanda
titik koma “;” (tanpa tanda petik)

Convert Text to Table

Table size

MNumber of columns:

[

Number of rows:

AutoFit behavior
Auto

| @ Fixed column width:

[

| @ Autoit to contents
|| D) AutoFit to window
|| Separate text at

(") Paragraphs () Commas

) Tabs @ Qther:
[ o ]

Klik OK, Maka teks tersebut akan berubah menjadi tabel
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No Nama Jumlah Harga Total
Barang Satuan

1 Mouse 2 25.000 50.000

2 Keyboard |4 100.000 400.000

c. Tabel Dari Ms Excel

Kita bisa membuat tabel dengan meng-embed Ms Excel ke dalam dokumen Ms Word. Dengan cara
ini maka tabel yang kita hasilkan akan memiliki kemampuan layaknya Ms Excel. Caranya:

1. Tab Insert, group Tables, pilih Table,
2. Pada menu yang muncul, pilih Excel Spreadsheet

Insert Page Layout References

| bd 88 @ =

Table Ficture Clip Shapes Smai
- .IE'.l't -

Insert Table
| O
N O
| I O O
N 4
aman| IO |
O | o o
S
o I I

I InsertTable...
Tabi.ﬁ Draw Table

gaml ==
rsi Te |_E| Excel Spreadsheet %
Dari| ] Quick Tables 3

LU M

= m

3. Maka akan muncul worksheet Ms Excel dalam dokumen Ms Word
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A B C D E F G L
1
2
3
a
5
B
7
8
9
10 A
M 4+ M| Sheet1l ~¥7 7 4 1l | »

4. Kita bisa memasukkan data pada tabel secara manual atau dengan mengcopy dari dokumen
Ms Excel lain.

A B C D E F iz

1 MNo MName Qty Price Total E|
2 1 Mouse 15 25,000 375,000

2 3 2 Keyboard 5 100,000 500,000
fu 3 Speaker 10 200,000 2,000,000
5 Total I E,S?S,D{HJ!:

7]
M4k M

5. Kalau sudah selesai, arah kursor mouse keluar area worksheet ini.

No  MName Qty Frice Total
1 Mouse 15 25,000 375,000
2 Kevyboard S 100,000 S00,000
3 Speaker 10 200,000 2,000,000
Total 2,875,000
I

6. Selesai.

Untuk melakukan mengedit tabel ini caranya: klik kanan tabel, lalu pilih Worksheet Object > Edit
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Mo  MName Qty Price Total
1 Mouse 15 25,000 375,000
2 Kevboard S 100,000 500,000
3 Speaker I — R 01
: % o i
) », 000
S5 Copy
[, Paste Options:
=
Worksheet Object k Edit I})
Hyperlink... Open
Insert Caption... Conyert..,

Borders and Shading...

& O [= @

Format Object...

d. Quick Tabel

Quick Tabel sebagaimana namanya adalah cara membuat tabel dengan cepat, yang dimaksud
adalah langsung dengan format tampilannya. Caranya:

1. Tab Insert, group Tables, pilih Table,
2. Pada menu yang muncul, pilih Quick Table

Page 80 of 187



limuKomputer.Com

Lr-e Insert Page Layout References

[ 7
= baal Bk j
Page Table Picture Clip Shapes Smi

Break - || At -
Insert Table

N O
e 1 I I I [ [
N [ R
N O
Hataman | 1L 1CICICCICICIC]
argin DDDDDDDDDD
wran | JCICICICICICICICIC]
o I I I |

hlom G Insert Table...

ulasi Tab¢ (& Draw Table

lenggamk E Convert Text to Table...

3. Lalu pada submenu yang muncul, pilih salah satu model tabel
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Double Table
The Greek alphabet

Letter name  Uppercase Lowercase Letter name  Uppercase Lowercase

Alpha A v
Beta B B i
I ¥

Gamma

5
' §
g

Matrix

City or Town Point A Point B Point C Point D Paoint E

Paoint A -

Paint B B’y —
Paint C [ L -
Paint a7 a2 91 —_—

Poloa P e A ra an

Tabular List

Books
Magazines
Notebooks

[ —

I T

. |

4. Selesai

Books
MMagazines
Notebooks
Paperpads
Pens
Pencils 2
Highlighter | 2 colors

Scissors 1 pair

[ e A T

e. Perhitungan Sederhana pada Tabel

Ms Word memungkinkan kita menangani formula atau perhitungan sederhana sebagaimana yang
dimiliki table Ms Excel.

Caranya:

1. Arahkan cursor ke dalam cell tabel
2. Pada menu ribbon, Tab Layout > Formula
3. Padajendela yang muncul, masukkan formula.
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+ Microsoft Word (Trial) = B =
ngs Review View Developer Design Layout = 0

m:iiﬂﬂﬂgJ .}1

m 1 SHeE — % ConverttoTed AL | L"
Tet Cell Sont
e = = =l prection Margins Jx Formula —

2
k2]

: Formula @
Nama Sales | This 2008] Tha 2008] | & 3

Revin 20000] 19000 =SUM{ABOVE)

ra 24000 21000 Number format:

Marsha 25000 18000

Evenyn 21000 25000

Jessica 19000 16000 Paste fncton: Pazte bookmark
Nicole 1800017 24000 3

Total C -

Rata-Rata \ —
- . = 0 e
Maksimal T -

WMinimal ﬂ

Perlakukan Tabel Ms Word Layaknya Worksheet Ms Excel

Al _[s] [c

1 |[NamaSales| Thn2008| Thn 2009

2 || Kevin 20000{ 19000 Menghitung Rata-Rata
3 |[Ira 24000/ 21000

4 || Marsha 25000 18000 =AVERAGE(B2:B7)

5 |[Evelyn 21000] 25000

6 || Jessica 19000 16000

7 |[Nicole 18000 24000

8 |[Total I

9 |[Rata-Rata

10 || Count

11 || Maksimal

g Mnimal /i .\M.MMM\MMLL\M “

5. Memformat Grafis

Dalam sebuah dokumen, kurang lengkap rasanya jika tidak menyertakan grafis baik dalam bentuk
gambar, chart, maupun yang sejenisnya. Bagian ini akan menjelaskan tentang bagaimana cara
memasukkan grafis ke dalam dokumen dan bagaimana mengaturnya sehingga menyatu dengan
dokumen.

Semua tentang grafis ini, bisa kita jumpai pada tab Insert, group Illustrations
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B limu dznaan

Lll!' Insert Page Layout References Mailings

= | g8 P 2 ull

Page Table Clip
Break < Art

Tables

Shapes Smartart Chart Screensho

-

-

Hllustrations

a. Gambar

Memasukkan Gambar

Caranya:

1. Tab Insert, pilih Picture

Insert Page Layout References Mailings Review

I E ElE] @ ‘— ﬁ

1 ral|| @] | (-—+

B Table Picture | Clip Shapes Smartart Chart Screenshot

k - Art - -
Tables

Tllustrations

2. Pada jendela Insert Picture, pilih file gambar yang ingin dimasukkan

S
Insert Picture @
vl .. < Pictures » Public Pictures » Sample Pictures - |$f | | Search Sample Pictures pel |
Organize « Mew folder e+ [ @
MicrosoftWord —  Pictures library Arange by Folder +
Sample Pictures
0 Favorites
B Desktop —" —" T T T —"
B Downloads | | R [ [ [ [ [
8= Recent Places 3 Chrysanthe Desert.jpg Green-Matu  Green-Matu Hydrangea  Jellyfish.jpg
= mum.jpg re-with-sun  re-with-sun s.jpg
rise-wallpa rise-wallpa
4 Libraries per (1).jpeg perjpeg
@ Documents _— _— _— _—
o Music o e | e e
[] Pictures Koalajpg Lighthouse, | Penguins.jp Tulips.jpg
B8 videos ipg 9 I
Lol Computer =

File name: Penguins.jpg - ’Aiipictuls (*.emf* wmfi* jpg;” v]

Tools - I Insert |vl [ Cancel ]

3. Selesai, gambar telah masuk ke dalam dokumen.
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D N R T S I A ZCA - - A U G S CA S PO € S e (o A

USIU Gl LTl i

™1
LF

Jn the Insert 1, the mallenss 1 -
look of your doaumsant You can usethese 2 tables, . s,
cover pages, and other document buildinz blocks. When you create pictuses, charts, or dia-

Memformat Gambar

Gambar yang dimasukkan tentunya perlu kita format atau atur agar lebih enak dipandang. Dalam
hal ini Ms Word menyediakan fitur yang cukup lengkap untuk melakukan pemformatan gambar.

+ Ubah Ukuran dan Sudut Pandang Gambar
Caranya:
1. Klik pada gambar, maka pada sudut-sudut gambar akan muncul bulatan kecil yang
berfungsi sebagai ikon untuk mengubah ukuran gambar. Adapun bulatan yang diatas
untuk mengubah sudut pandang gambar.

)

2. Draglengkaran tersebut untuk mengubah ukuran gambar
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3. Gunakan bulatan diatas untuk mengubah sudut pandang gambar. Arahkan kursor ke
bulatan, maka kursor akan berubah menjadi tanda panah melingkar, drag ke kanan atau
ke kiri

4. Selesai
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&

+ Mengcroping Gambar
Caranya:
1. Klik gambar

2. Pada tab Format group Size, pilih tombol Crop, lalu klik menu Crop

|N= 4] Height: 8.75 ¢

Crop |73 Width: 111,67

L .|'." Lrop L
: L_l? Crop to%hape 4
Aspect Ratio 4

b Fill

g Fit

3. Maka pada bulatan kecil pada sudut gambar akan berubah menjadi tanda garis dan siku

C*I;—; | — ﬂ)

=

4. Drag tanda garis dan siku disudut gambar untuk melakukan cropping
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Ms Word 2010 juga memfasilitasi Crop To Shape atau mengcrop suatu gambar menjadi
bentuk shape tertentu.

F Bring Forward = Align ~ =
ﬂ oz H °ring romwal I':"_ 2l {1__|J Height: 6.11 cm
1 5end Backward ﬁ Group

. 1{“:;2‘3 E-T;, Selection Pane 5 Rotate = Cr::up w5 Width: 812 cm
Arrange J& Crop o
Rectangles L_l? Crop to Shape »
[E (€ [& & (& S = (E & Aspect Ratio  »

Basic Shapes fe

CANOLOOOOGO®®® [T T
cOo0Or L/ooaean |
ORAOOV XL CT™()
0142

Misal kita f)ilih shape gambar awan, maka gambar akan berubah sebagai berikut:
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+ Menghapus Background Gambar
Dengan Ms Word, kita juga bisa menghapus background atau latarbelakang gambar.
Caranya:
1. Klik gambar
2. Padatab Format group Adjust, p111h Remove Background
" n m ﬁCnmpress Pictures
ﬂ- % Change Picture
Remove Correctlcnns Colar Artlstu:

Background - - Effects = qERESEt Picture -
Adjust

3. Maka gambar akan nampak seperti berikut:

Area warna merah muda adalah area yang akan dihilangkan atau Ms Word
menganggapnya sebagai background, atur area ini dengan cara mendrag bulatan kecil.
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4. Gunakan menu pada tab Background Removal jika masih ada area kurang tepat.
@|H"?*F.&a*|= Picture Tools

Background Removal View Format

@ Qe v
ark Areas Mark Areas Delete § Discard All  Keep

to Keep to Remove Mark Changes Changes
j Close

5.

+ Menambahkan Style pada Gambar

Caranya:

1. Klik gambar

2. Pada tab Format group Picture Styles, pilih salah satu style
IINGKAT LANJU I AN.docx - Microsott Word S

Mailings Review My Tab View Developer

Picture Border ~

’ d’ ‘ ‘ d - - §< Picture Effects -

. R’ = Picture Layout ~

Picture Styles
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3. Selesai.

Y/
°

Menambahkan Efek Seni pada Gambar

Caranya:
1. Klik gambar

2. Pada tab Format, group Adjustment, klik Artstic Effects, lalu pilih salah satu efek.
iert Page Layout References Mailings Review My Tab

33: Compress Pictures

Byrgerce ||t || |l

Color Artlstlc
v |Effects v“:ﬂ Reset Picture ~

ﬂm@:{:@g ﬂnzﬁ,
A K AR

n?‘f)‘i;,":u

ain Pada
IDANFC | y

Footnot

Endnots
NENH &y, Artistic Effects Options...

cr

3. Selesai.
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@,

« Mengatur Posisi Gambar Pada Teks
Caranya:
1. Klik gambar

On the Insert tab, the gallenies nclude items that are designed to coordinate with the overall
look of your doannent. You can use these galleries to insert tables, headers, footers, lists,
cover pages, and other document buillding blocks. When you create pictures, charts, or dia-
grams, they also coordinate with your current document look. You can easily change the
formatting of selected text in the document text by choosing a look for the selected text
from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls onthe Home tab.

2. Pada tab Format, group Arange, klik tombol Position atau Wrap Text, kemudian pilih
salah satu posisi gambar yang diinginkan.
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Hj 4y Bring Forward |= Align ~
ﬁ Group

11 Send Backward
Wrap
Text= -f;Selection Pane %) Rotate ~

In Line with Text

With Text Wrapping

@ Eﬁ Eﬁ ...............................

L]L’E I:ﬁ tﬂ

NrEREERE

1
. @ More Layout Cptions...
i1

an

L T T e S

3. Selesai

. i

,;Dn the Insert tab, the galleries mclude items that are
designed to coordinate with the ovemll look of your

iﬂocument. You can use these galleries to msert tables,
;ileaders, footers, lists, cover pages, and other docurmernt
}.:u.lldmg blocks. When you create pictures, charts, or
iagrams, they also coordinate with your current docu-
:ment lock. You can easily change the fommatting of

fselected text in the document text by choosing a look
for the selected text from the Cuck Styles gallery on the Home tab. You can also format
text directly by using the other controls on the Home tab.

Optimasi Ukuran File Gambar

Ketika kita memasukkan sebuah gambar ke dalam dokumen kita, maka besar file gambar
adalah tetap sesuai dengan ukuran file aslinya, meskipun gambar tersebut telah kita
perkecil ukurannya (dengan crop atau resizing) ataupun kita format. Oleh karena itu kita
perlu mengoptimize gambar tersebut, caranya:

1. Klik gambar yang akan diformat

2. Pada tab Format, group Adjust, pilih Compress Gambar

|' a % 13 Compress Pictures
o %3 Change Picture L\)

Color  Artistic
- Effects~ qEI:'\nesvat Picture =
Adjust

3. Padajendela yang muncul, atur sebagai berikut,
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Delete cropped areas of pictures
Target output:

Print (220 ppi): excellent quality on most printers and screens

Screen (150 ppil: good for Web pages and projectors

4. lalu klik OK

b. Shapes

Shape merupakan objek yang memiliki bentuk tertentu. Ms Word menyediakan berbagai shape
yang bisa kita gunakan sesuai keinginan kita.

Memasukkan Shape

Caranya:

1. Pada tab Insert, group Illustrations, klik Shapes,

Insert Page Layout References Mailing

H B @ 2 il

Table Picture Clip Shapes Smartart Chart

- Art - %
| Tables | INustrations

2. Pada menu shape, pilih salah satu jenis shape.

L LA | LR
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Shapes|SmartArt Chart Screenshot | Hyperlin

Recently Used Shapes
CENNOOOALLe S
(5 % ™
Lines
NSNS TLL T LG G
Rectangles
[ (9 [& (& (&) () [ () (]
Basic Shapes
HEOoAMNIASCOOO®®
@GLOJOr Ly dd
OO0O@AHEV XSS
(4011 R

3. Dragpada dokumen

Menggunakan Drawing Canvas

Jika kita ingin menggabungkan beberapa shape, maka kita sebaiknya menggunakan Drawing
Canvas, agar shape kita tidak terpisah-pisah. Caranya:

1. Pada tab Insert, group Illustration, pilih Shape

2. Kemudian klik menu New Drawing Canvas
Callouts

AQPOE.OOmA Ad: A0 s
g+ A0 AD0 o

c@ Mew Drawing Canvas h

3. Maka sebuah canvas akan muncul pada dokumen kita. Pada canvas atau bingkai inilah kita
akan memasukkan dan mendesain shape
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ok limu d2eaan rmenuliskannind

4. Masukkan beberapa shape, dan mulailah merangkainya menjadi bentuk baru

<
S

5. Jika sudah, aturlah area canvas mengikuti area gambar

6. Klik area kosong diluar canvas. Selesai

Memformat Shape

Hampir sama dengan gambar, kita bisa memformat shape sesuai dengan keinginan kita. Yaitu
melalui menu tab Format.
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View Developer Format
_ A Text Fill ||} Text
“fé\\ _ | ;”Tex‘t Outline - | [ alig
(ay Text Effects - =0 Creg
P WordArt Styles |

Pada tab Format ini ada beberapa group menu yang bisa kita gunakan:

1. Insert Shapes

D @E N,  [<Edtshape-~
OO A LL |- B Draw Text Box
UG %N

Insert Shapes

Melalui menu ini kita bisa menambahkan shape baru, dan mengubah jenis shape
2. Shape Styles

> e
= Shape Effects =

Shape Styles a
Melalui menu ini kita bisa menerapkan style pada shape

<33 shape Fill =

L_d_’ Shape Outline -

F

4

L]l

=

3. WordArt Style dan Text
Melalui menu ini kita bisa mengatur teks yang ada dalam shape.

- A . . -
&Text Fill ““ Text Direction

A A A0 |+ &7 Text Outline ~ | =] Align Text =

= | s\ Text Effects = == Create Link
WordArt Styles E Text

Namun terlebih dahulu kita harus memasukkan suatu teks dalam shape, caranya: klik kanan
shape, pada menu yang muncul pilih Add Text.
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atloh lbmu denaan menuliskanaya

=

Add Text

Edit Points I/\'}

Group F
Ering to Front | »
send to Back | »

Hyperlink...

Insert Caption...

[E @ & o7 [ [ [

il

o
111

Wrap Text 4

Set as Default Shape
More Layout Options...
Format Shape...

S

& [H

Tuliskan sebuah teks.
™

Silahkan diformat sesuai dengan yang diinginkan. Jika area text kurang lebar, maka caranya:
1. Klik kanan shape
Set as Default Shape

ha

2. Pilih Format Shape
3. Padajendela Format Shape, pilih tab Text Box
4. Atur Internal margin menjadi nol.
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b linu dengan

Format Shape ||

Fil Text Box
Line Color Textlayout
Line Style Vertical alignment:
Shadow Text direction: n
Reflection Do not rotate text
Glow and Soft Edges Autofit

= )
20 Format Resize shape to fit text
2D Rotation Internal margin

Left: |0 cm E” Top: |Ilt- E”
Picture Corrections

Right: |0 cm E” Bottom: |0 cm E”
Picture Color

Virap textin shape
Artistic Effects
Crop
Alt Text
| Close |
5. Selesai.

4. Arrange dan Size
Fungsinya sama dengan penerapan gambar, yaitu arrange untuk mengatur posisi shape
pada teks, sedangkan size untuk mengatur ukuran shape.

7] = L4 Bring Forward = |& Align -
Yy send Backward ~ E Group
Pasition Wrap
- Text= -f;Selection Pane % Rotate -

Arrange Size ra

5] 347em

—
o+ 432 cm

-

c. Smart Art

SmartArt sebenarnya merupakan gabungan dari shape dan teks yang berpola tertentu (diagram).
Fungsi SmartArt umumnya untuk menggambarkan suatu konsep tertentu seperti proses kerja,
siklus, hirarki, atau hubungan.

Memasukkan SmartArt

1. Pada tab Insert, group Illustrations, klik tombol Insert SmartArt Graphic
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Insert Fage Layout References 0

| e B @B

Table Picture Clip Shapes SmartArt

- Ar‘t - ‘%
Tables Mustratio
2. Padajendela yang muncul, pilih model SmartArt yang diinginkan
Choose a SmartArt Graphic @
[ﬁ List o
= Lt == -.as -
3 Process -] | | .- -
S Cyde PR
==-— K&
g,-',l,'-'h Hierarchy o T
Eﬂ Relationship e -
& Matrix iil ;\;l e 9 - - -
A2 Pyramid - . .
Basic Block List
& Picture - - -
Use to show non-sequential or grouped
-H- ags blocks of information. Maximizes both
(- F=. L]
horizontal and vertical display space for
M . [ s shapes.
! — 1 (N K=
— 1 (e e .
[ OK. ] [ Cancel

3. Klik OK.

= | Text]

= | Text]

= | Text]

Memasukkan Text dan Atau Gambar ke dalam SmartArt

SmartArt bisa berisi teks saja atau gambar saja atau teks dan gambar sekaligus. Tidak semua model
SmartArt mendukung gambar, hanya group model picture saja.

Untuk memasukkan sebuah teks, caranya:

1. Klik pada SmartArt,
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2. Lalu klik teks [Text]
3. Ketikkan teks yang ingin dimasukkan

Atau

1. Klik pada SmartArt,
2. Pada tab Design, group Create Graphic, pilih Text Pane

] Add Shape * <& Promote *+ Move Up
=] Add Bullet & Demote ¥ Move Down
] TextPane| 2 Rightto Left ayout

Create Graphic

3. Maka akan muncul panel text,

T}rpe your text here

* Ketik Disini &3 Ketlk Dl Slnl

S
4. Masukkan text
Type your text here 52
8 Jellyfish

* Koal|

® [Text]

\u\m‘w

Vertical Picture Accent List

Use to show non-sequential or grouped
blocks of information. The small drdes are
designed to contain pictures,

Learn more about SmartArt graphics

* Penguin

LIEE

Vertical Picture Accent List

Use to show non-sequential or grouped = .
blocks of information. The small drdes are :ﬁ n ln
designed to contain pictures.

Learn more about SmartArt graphics

5. Selesai
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= Koala

= Penguin

Untuk memasukkan sebuah gambar, caranya:

1. Klik SmartArt
2. Klik ikon gambar

Jellyfish

= Koala

= Penguin

3. Padajendela yang muncul, pilih gambar yang ingin dimasukkan, dan klik Insert
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@]nser! Picture @
X . « Pictures » Public Pictures » Sample Pictures - |+ Search Sample Pictures P |
it P ’

Organize » Mew folder B o~ Ol '@'

@] MicrosoftWord  Pictures library

) Arrange by:  Felder =
Sample Pictures

[ Favorites

. DESktDp | = | __ = | = | ___ = | =
8 Downloads || e e - e
%] Recent Places 3 Chr_',rsaljthe Desert,jpg Greep—Natu Gree.n-Natu Hydr.angea
mum.jpg re-with-sun  re-with-sun s.jpg
rise-wallpa rise-wallpa
- Libraries per (1}.jpeg perjpeg
3 Documents — —— — —
J'. Music b h‘ h‘ h‘ h‘
| Pictures Koala.,jpg Ligh.thouse. Penguins.jp Tulips.jpg
B2 videos irg g
1M Computer ha
File name: Jellyfish,jpg ~ | All Pictures (*.emf:*wmf;™ jpg;” v]

Tools = Insert |v Cancel

4. Lakukan untuk gambar lainnya.
5. Selesai.

Jellyfish

Koala

Penguin

Memformat SmartArt

Sama dengan gambar dan shape, kita bisa melakukan format SmartArt. Caranya dengan
menggunakan menu-menu yang disediakan pada tab Design dan Format.

Design

Pada tab Design kita bisa mengubah layout, warna, style, posisi gambar dan text
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) - Microsoft Word SmartArt Tools

Review My Tab Vil Developer Design Format

2w
= L Ili °| oge H & .
BN | = =) | o H I .

Layouts SmartArt Styles

Misal:

- Layout: tetap
- Warna: Colorful Range - Accent Color 3 to 4
J Dresign | Format |

| Cll

Accent 1 ICUIﬂrfuI Range - Accent Colors 3 to

|
|
|

- Style : Metalic Scene,

Best Match for Document

- Posisi gambar dan text : Right to Left
._:I Add Shape = <& Promote % Mowve Up
iT| &dd Bullet & Demote ¥ Move Down

T]TextPane | 2 Rightto Left| - Layout

Create Graphic

Berikut ini hasilnya:
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r Jellyfish

Koala

Format

Pada tab Format kita bisa mengubah bentuk shape, format shape, dan ukuran shape. Disamping itu,
kita juga bisa mengubah format serta posisi text.

docx - Microsoft Word SmartArt Tools
ilings Review My Tab View Developer Design Format
J— &4 shape Fill ~ A Text Fill » [ Bring
Abe Abe Abe [ shape Outline = A || &2 Text Outline ~ - [ send
— i —| Position Wrap
‘= Shape Effects = ~ | (&) Text Effects = - Text = Eh. Selecti
Shape Styles P WordArt Styles P Arrange

d. Chart

Chart digunakan untuk menyajikan data dalam bentuk gambar sehingga lebih mudah untuk
dipahami. Ms Word menyediakan berbagai macam jenis chart yang bisa kita pilih dan format sesuai
dengan keinginan Kkita.

Membuat Chart

Caranya:

1. Pada tab Insert, group Illustrations, pilih Chart

Insert Page Layout References Mailings Re

Z E Elgl [i]j i i
3 hal| BE = (-
e Table Picture Clip Shapes Smart&rt Chart Screen:
ik < Art 7 1} =

| Tables | INustrations
2. Pada jendela yang muncul, pilih salah satu model chart kemudian klik tombol OK
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Insert Chart (-7 s
£3 Templates CD'T - - - - - R
du 28] 24 ‘95) =3 43 33
- i) o8| (08 B b Jad] JA4
e | 8] L] oA 104]
e\ A T2 1] e [ R
Bubble ‘A/ W IA/ W H/\j‘ HQ
- EYIPNIESNEr e =
| Menage Templates... | | SetasDefault Chart | | ok || cancel ]

Maka pada layar akan ditampilkan dua jendela yang saling berdampingan, yaitu Ms Word

dan Ms Excel.

W90 s Latihan.docx - Microsoft Word [Chiart Tools [NFS B S V4 = I, A R Chart in Microsoft W
Home | Insert | Page La | Referen | Mailing Review | MyTab | View | Develog Deslgn‘ Layout | Format | & @ Home Insert  Pagelayout  Formulas
A=Y N RA o,k o EE
Ba- I U~ A = -
Change Save As Switch  Select Edit Refresh  Quick Quitk Paste
Chart Type Template Row/Column Data Data Data Layout ~ Styles - 7 = R E | @
Type Data Chart Layouts| Chart Styles Clipboard 1 Font G| mignment
-\“1‘|‘%-\‘?-\-n‘t‘|‘$-\-9‘l‘?-\-:Iz-\-‘5‘|‘1§)-\-1‘1‘|‘le-\-17}-\-1‘4‘\‘jTS-\-L‘ﬁﬂ A6 - A
B 3 A | 8 | c | b
- 5 | 1] Series1  Series2  Series3
2 | 2 |Category 1 43 24 2
N | 3 |Category2 2.5 4.4 2|
313 | 4 |category 3 3.5 18 3
- | 5 |Category4 4.5 2.8 5
I 6
B 17
B W Series 1 8 To resize chart data range, drag lowel
412 m Series 2 |9 |
- = Series 3 | 10|
o |2 e
E 112
EEE e
= |14 |
& |15
oo 16
B Category 1 Category 2 Category 3 Category 4 =l

Data dari chart kita masukkan pada jendela Ms Exczl, tampilan chartnya akan dimunculkan

pada jendela Ms Word atau dokumen kerja kita.
Masukkan data pada jendela Ms Excel

Fa

B6 - 5|
A B | ¢ | b
1 2010 2011 2012
2 Honda 10 13 17
3 Yamaha 10 15
4 |Suzuki 7 5 B
5 Bajaj 2 a 5
- I 1
Jika sudah, tutup jendela Ms Excel.
Selesai
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13

m2010
m2011
m2012

Honda Yamaha Suzuki Bajgy

Memformat Chart

Ada 3 tab yang bisa kita gunakan untuk memformat chart, yang tergabung dalam Chart Tools, yaitu
Design, Layout, dan Format.

Design Layout Format

+ Tab Design
Tab ini digunakan untuk mengubah model chart, memilih dan mengedit data chart pada Ms
Excel, serta mengubah style chart

13

16

14

12

10 - |2010

g ®2011
@=2012

Honda Y amaha Suzuki Bajay

+ Tab Layout
Tab ini digunakan untuk :
1. Menambahkan gambar, shape, dan teks
2. Melengkapi atribut chart seperti judul, legend, label
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3. Memasukkan trendline

Penjualan Motor di Indonesia
(dalam ribuan)

18 - 11
16 - - 15
14 | |
12
10
B - m2010
6 - 3
==— m2011
7 2 m2012
) L
0 . -
Honda Y amaha Bajg
2010 10 8 7 2
2011 13 10 3 4
2012 17 13 [ 3

+ Tab Format
Tab ini digunakan untuk mengubah format teks, format shape yang menyusun chart, serta
posisi teks,.

6. Header & Footer

Word juga menyediakan fitur untuk membuat header dan footer suatu halaman dalam dokumen.
Perintah tersebut bisa kita dapati pada tab Insert | group Header & Footer. Anda bisa memilih
model tampilan header / footer yang telah disediakan atau membuat sendiri.

Untuk tingkat lanjut misalnya membuat header dan footer yang berbeda pada setiap bab dokumen,
maka sebaiknya Anda memahami section yang telah dibahas pada bagian sebelumnya serta
memahami penggunakan quick part yang akan dibahas pada bagian selanjutnya.

7. Menggunakan Konten Berulang

Word mengenalkan istilah baru yaitu Quick Part merupakan tool yang berfungsi untuk
menambahkan komponen tertentu ke dalam dokumen dengan cepat. Komponen tersebut yaitu:

a. Auto Text

Teks atau kalimat yang sering digunakan sebaiknya disimpan dalam Quick Part, agar jika suatu saat
diperlukan, bisa ditampilkan kembali dengan cepat.

Menyimpan Teks ke Quick Part

1. Select teks yang ingin disimpan, misal:
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| signature Line ~ J'C Q

(5], Date & Time
Equation Symbaol
*gd Object - = -
| EE putoText P |2 save Selection to AutoText Gallery
g |1 Document Property b doox || | h

= Field...

115 1 t1fr A 1T 1 18 1+ 18 E

Q Building Blocks Organizer... :
\_jh Save Selection to Quick Part Gallery... |

Menggunakan Auto Text

Tab Insert | Quick Parts | Auto Text, lalu pilih teks yang tersedia

b. Document Property

Digunakan untuk memasukkan variabel property dokumen seperti: abstaksi, penulis, judul
dokumen dll.

c. Field

Hampir sama dengan document property, namun lebih lengkap lagi.

d. Building Block Organizer

Fungsinya untuk mengelola galeri konten. Galeri konten bisa juga disebut sebagai model konten
seperti model cover, model penomoran halaman, model header & footer, model watermark. Dengan
adanya galeri konten ini maka jika dikemudian hari kita akan membuat konten tertentu maka kita
cukup memanggil konten tersebut dari galeri konten. Konten dalam Galeri konten ada dua macam,
yaitu built in (bawaan Ms Word) dan hasil tambahan dari user.

Menampilkan Building Block Organizer:

Pada menu ribbon, pilih tab Insert > Quick Parts > Building Block Organizer

. Building Block.docx - Microsoft Word (Trial

Insert Page Layout References Mailings Review View Developer
 HEPRd. Q0 B 6 E@FA Sz
Ball g 4 = [+ E = =| = # ¢ [ [8) Date & Time
e | Picture Clip Shapes SmartArt Chart Screenshot = Hyperlink Bookmark Cross-reference | Header Footer  Page Text | Quick \WordArt Drop 3
At v - - *  Number~ | Box~ |Pasv| ~  Cap~ "8 Object ~
35 Tllustrations Links Header & Footer \‘: AutoText N
1']ﬁfff:?:‘f (&1 Document Property 4
[=]  Field...

Q Building Blocks Organizer...
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Building blocks: Click & building block to see its preview

Marme Gallery Category Template i |«
Works Cited  Bibliograp...  Built-In Built-In Buil... |=

Bibliography Biblicgrap.. Built-In Built-In Buil...

Puzzle Cover Pages  Built-In Built-In Buil...

Cover Pages Built-In Buil...

Contrast Cover Pages  Built-In Built-In Buil...

Sideline Cover Pages  Built-In Built-In Buil...

Grid Cowver Pages  Built-In Built-In Buil...

Annual Cowver Pages  Built-In Built-In Buil... |

Mod Cover Pages  Built-In Built-In Buil...

Alphabet Cover Pages  Built-In Built-In Buil... =

Exposure Cover Pages  Built-In Built-In Buil...

Cubicles Cover Pages  Built-In Built-In Buil...

Stacks Cover Pages  Built-In Built-In Buil...

Perspective  Cover Pages  Built-In Built-In Buil...

Newsprint Cowver Pages  Built-In Built-In Buil...

Austin Cowver Pages  Built-In Built-In Buil...

Tiles Cover Pages  Built-In Built-In Buil...

Conservative Cover Pages  Built-In Built-In Buil...

Austere Cover Pages  Built-In Built-In Buil...

Transcend Cover Pages  Built-In Built-In Buil... =

Pinstripes Cover Pages  Built-In Built-In Buil... 4
TeTdeesin Feeaioo N T noow o men | Motion

4 L} | ¢ Shaded title with contrasting shaded sidebar containing

[ Edit Properties. . ] [ Delete l [ — prominent date, photograph, and author information block
L

8. Mengontrol Format Dokumen

a. Style

Style merupakan nama untuk sekumpulan pengaturan format paragraf, karakter, link, tabel dan list.
Jenis-jenis style secara default telah tersedia, namun kita juga bisa memodifikasinya menjadi style
yang baru. Keuntungan jika kita menggunakan style disamping mempercepat dalam memformat
suatu dokumen, adalah membuat tampilan dokumen kita lebih konsisten.

Oleh karena itu, sebaiknya kita menggunakan fasilitas Styles ini untuk melakukan pemformatan
suatu dokumen bukan dengan cara manual agar format dokumen kita mudah dikontrol.

Menerapkan Style Dokumen

Pada masing-masing style, kita bisa menggunakan atau mengatur (modifikasi) format dari masing-
masing komponen suatu dokumen seperti Heading, Title, List Paragraph, dIL

AaBbCcDc | AaBbCcDc AaBbC: AaBbCc Aalj AaBbCc. AaBbCcDi | %

TMormal | T Mo Spaci.. Headingl Heading 2 Title Subtitle Subtle Em... |- EF;I‘”EJE
es
Styles [}
Caranya:
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1. Seleksi teks yang ingin kita format

V. MENGAPLIKASIKAN REFERENCES DAN HYPERLINKS
A MENGAPLIKASIKAN HY PERLINK

Al Link ke File

A2 Link ke Halaman Web

A3 Link ke Lokasi Lain Pada Dokumen

B MEMBUAT ENDNOTE DAN FOOTNOTE
B.1 Menambahkan Footnote

B.2 Menambahkan Endnote

C MEMBUAT DAFTAR 151

.1 Menggunakan Daftar Pustaka Built-In
€2  Membuat Daftar Pustaka Secara Kustom

2. Pilih salah satu komponen style dokumen, apakah teks tersebut sebagai Heading 1 atau 2,

Title dsb.
AaBbCcDc AaBbC: AaBbCc AaBbCcl H&H AaBbCc. | %
_ . ) . ] i —_| Change
T Marmal Mo Spacing Heading 1 Heading 2 Heading 3 I} Title Subtitle 7| styles -
Styles =

3. Lakukan langkah no 1 dan 2 diatas untuk memformat teks lain.

V. MENGAPLIKASIKAN REFERENCES DAN HYPERLINKS

A MENGAPLIKASIKAN HYPERLINK

A1 Link ke File

A.2 Link ke Halaman Web

A.3 Link ke Lokasi Lain Pada Dokumen

B MEMBUAT ENDNOTE DAN FOOTNOTE
B.1 Menambahkan Footnote

B.2 Menambahkan Endnote

C MEMBUAT DAFTAR ISI

C.1 Menggunakan Daftar Pustaka Built-In
C.2 Membuat Daftar Pustaka Secara Kustom

4, Selesai.

Untuk lebih memudahkan, kita bisa menampilkan komponen style dokumen tersebut menjadi
panel disebalah kanan area kerja. Caranya dengan mengklik tombol launcer di pojok kanan bawah
group Styles tab Home. Atau ALT + CTRL + SHIFT + S

AaBbCcD I, AaBl A AaBb | %

T Mo Spaci.. Headingl Heading2 |[= Change

Styles =
1011 12 1 Styles (AltChl+Shift=S)

o
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Styles v X
Clear Al -
Marmal T
Mo Spading Ta

| Heading 1 1a|
Heading 2 a
Heading 3 1a
Title Ia
Subtitle Ta
Subtle Emphasis a
Emphasis a
Intense Emphasis a
Strong E
Quote Ta
Intense Quote hE]
Subte Reference a
Intense Reference a
Book Title a
List Paragraph T

[] show Preview
[ Disable Linked Styles

Options...

Memodifikasi Style Dokumen

Adakalanya komponen style yang disediakan kurang sesuai dengan yang kita inginkan, maka kita
bisa memodifikasinya. Caranya:

1. Klik kanan komponen style yang ingin diubah

AABBCCHN:V:Y:]:Te(ad]

Heading 1 Heading 2

AaBbCcDdl  AaBbCchdE

T Marmal Mo Spacing

h Styles

2. Pada menu dropdown, pilih Modify...
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AaBbCcDdi  AaBbCcDdi | WL:1:{&d | AABBCCI AABBCCI AAB A

T Mormal Mo Spacing | Headingl Heading 2 Heading 3 Title 9
Update Heading 1 to Match Selection
™ Modify...
- - -
! ! ! ! Select All: %ﬂ Data)
Fename...

Remove from Quick Style Gallery

Add Gallery to Quick Access Toolbar

3. Padajendela Modify Style, lakukan modifikasi:

| Madify Style — e [ =
Properties
Mame: |Heading 1 |
Style type: |Linkec| (paragraph and character) Izl
Style based on: | T Normal |z|
[=]

Style for following paragraph: | 1 Normal

Formatting

it REREz o] B
— i

=== =z

"
»

i

m
_ —
——

B MEMBUAT ENDNOTE DAN FOOTNOTE

Font: 11 pt, Bold, Font color: Background 1, All caps, Expanded by 0.75 pt, Space - II
After: 0pt, Level 1, Border: D
Top: (Single solid line, Accent 1, 3 pt Line width)

Bottom: (Single solid line, Accent 1, 3 pt Line width) &2

Add to Quick Style list Automatically update
@ Only in this document () New documents based on this template

T o ) [ o)

4. Untuk pengaturan lebih lanjut, kita bisa klik tombol format, lalu pilih salah satu menu yang
muncul.
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Paragraph...
Tabs.. l}
Border...
Language... : Background
. er:

rame... ent 1, 3ptLi
Numbering... i Jle
Shortcut key... Automatically
Text Effects.. MNew documer)

E Format ~ i

Menambahkan Style Dokumen

Kita bisa membuat komponen style dokumen sendiri, caranya:

1. Tulis suatu teks, lalu lakukan pengaturan format teks (misalnya: ukuran huruf, warna,
ketebalan, jenis huruf, spasi, dsb)

2. Seleksi teks yang telah diformat

3. Padatab Home, group Styles, klik tombol panah ke bawah di kanan bawah

1. aaBbe A ] aaBueeD | aaBbecD  aaBbeeD 1. AaBl A AaBb %

55 HEAD... Heading 51 | List Paragr...| TMormal TMo Spaci.. Headingl Heading2 — gir:.lyalnge
'[} es T
Styles P

N O O L I e e - O LT
= T T T T T T T T T T

4. Pada menu yang muncul, klik Save Selection as a New Quick Style...
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1. aaebc A ]| aaBbceD | AaBbceD AaBbceD 1. AaBl A AaBb
US55 HEAD... Heading 51 | List Paragr...| TMormal T Mo Spaci.. Headingl Heading 2

| A1 AaBl a) AaBb [Al1al1 A Aalj AaBbCc. AaBbCcD AaBbCcD
EHeading3 Heading 4 Heading 5 Title Subtitle Subtle Em... Emphasis

S AaBbCcD AaBbCcl AaBbCcD AaBbCcD AsBsCcDl AaBeCcl AaBsCcL
Intense E... Strong Cuote Intense }... Subtle Ref... Intense R... BookTitle

Save Selection as a New Quick Style... [}

i”} Clear Formatting
144 Apply Styles..

5. Pada kolom Name, tuliskan nama stylenya.

F B
Create Mew Style from Formatting M

MName:
Stylel
Paragraph style preview:

Sylet

| ok || Modfy.. || cancel

6. Klik OK, klik tombol Modify untuk melakukan pengaturan lebih lanjut.
Menghapus Style Dokumen

Kita bisa menghapus format dari suatu teks yang sudah diformat stylenya yaitu dengan cara:

1. Arahkan kursor ke teks yang ingin dihapus format stylenya
2. Padatab Home, group Font, klik tombol Clear Formating

Home Insert Page Layout References Maili

Cut il

Cambria ~11 | A AT | Aa-
Copy

B 7 U ~abe x, ¥° - 37 . A~

Format Painter _—

board P Font ra

Memilih Style Set

Pada Ms Word 2010 tersedia 14 jenis style bawaan yang bisa kita gunakan, caranya:

1. Padatab Home, group Style, klik Change Styles
2. Pada menu dropdown, pilih Style Sets
3. Pada sub menu dropdown, pilih salah satu jenis style yang diinginkan.
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34 Find -

E';x Replace

bce AaBbcer AADB 4aBbCc

Title

Change
Styles ~ | lg Select ~

ing 2 Heading 3 Subtitle

-

Style
11

Style Set 4

Default (Black and White]

Distinctive Colors 3

3
Elegant Fonts

(3] L2

Paragraph Spacing ¥
Fancy

Set as Default
Formal =

Manuscript

Modern
Mewsprint
Perspective

tems Simple

esto Thatch

ucre Traditional

Word 2003

Word 2010

men

[

Dengan menerapkan style pada dokumen, maka perubahan format dokumen akan sangat mudah.
Kita tinggal memilih jenis style yang kita inginkan.

V. MENGAPLIKASIKAN REFERENCES DAN HYPERLINKS
A MENGAPLIKASIKAN HYPERLINK
‘A.l Link ke File = =
AP | . \/ENGAPLIKASIKAN REFERENCES DAN HYPERLINKS
A3 Link ke Lokasi Lain Pada | [ MENGAPLIKASIKAN HYPERLINK ]
B MEMBUATENDNOTE D/ | (m—rmee MENGAPLIKASIKAN REFERENCES DAN HYPERLINKS
B.1 nbahkan Footnote (W4% 10 ke Halaman Web
B2 M hkan Endnote A3 LinkkeLokasiLain Pada MENGAPLIKASIKAN HYPERLINK
C MEMBUAT DAFTARISI |(5 MEMBUAT EDAN A1 LINKKE FILE
€1  Menggunakan Daftar Pust ; f2  LINKKE HALAMAN.WEB
€2  Membuat D; :; 5 e eomere | A3 LINKKE LOKASI LAIN PADA DOKUMEN
i‘-. — »r-—2i-~—~~--—‘—‘z-i§i—A MEMBUAT ENDNOTE DAN FOOTNOTE
MENAMBAHKAN FOOTNOTE
£) MENAMBAHKAN ENDNOTE
MEMBUAT DAFTAR IS1
1 MENGGUNAKAN DAFTAR PUSTAKA BUILT-IN
€2 MEMBUAT DAFTAR PUSTAKA SECARA KUSTOM
b. Theme

Disamping style, Ms Word juga mengenal theme yaitu kumpulan pengaturan warna, huruf, dan efek
dari dokumen, yang cakupannya lebih luas dibandingkan dengan style yang hanya fokus pada
format teks. Secara default, telah tersedia banyak theme yang bisa kita gunakan sesuai dengan
keinginan kita. Jika perlu, kita juga bisa mendownload theme di Internet atau memodifikasi theme
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yang sudah tersedia. Adapun fitur theme ini bisa kita jumpai pada tab Page Layout, group Themes

Home Insert Page Layout Referer

Bee [ & [T

Margins Orientation Size Colum

|§| Effects ~ = = s o
: Custom = |
Aa Aa
EEEEN EEEEN
Themel Theme2
Built-In =
s
Aa | Aa
|| 1 EEEEEE EEEE
Adjacency Angles Apex
=
0 Az Aa Aa
EEEEaE aEEEEe L L] || [ ]}
Apothecary Aspect Austin Elack Tie
=] B
Aa | [|Aa_]||Aa Aa
] [ ] ] ] EEEEEE EEEEN IIIIII_I
Civie Clarity Composite  Concourse
Aa Aa Aa Aa
EEEEEn EEEEEN EEEEEE EEEER
Couture Elemental Equity Essential |w

Beset to Theme from Template

B
E=

Enable Content Updates from Office.com...

Browse for Themes..,

Save Current Theme...

M

enerapkan Theme

Untuk menerapkan suatu theme pada sebuah dokumen, caranya:

1.
2.

M

Pada tab Page Layout, goup Theme, klik Themes
Pada menu theme, silahkan pilih salah satu theme yang diinginkan.

emodifikasi Theme

Karena alasan tertentu, theme yang telah tersedia bisa kita modifikasi dan kemudian kita simpan
sebagai theme baru yang bisa kita gunakan dikemudian hari. Caranya:

1.
2.

Pada tab Page Layout, goup Theme, klik Themes

Pada menu theme, silahkan pilih salah satu theme yang paling mendekati dari apa yang kita
inginkan.

Masih pada tab Page Layout, goup Theme, sebelah kanan Themes terdapat tombol Colors,
Fonts, dan Effect. Lakukan pengaturan untuk ketiga komponen penyusun theme tersebut.
Mengatur Colors atau kombinasi warna, kita bisa memilih kombinasi warna yang telah
tersedia.
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h limu dengaan rmenuliskonnya

3

Built-In |
Office
HOCTNNN  Grayscale
HOENC NN Adjacendy
HONNENEE Angles
EONNNNEN Apex

B NNENCN Apothecary
HONENEEN Aspec
HONNENEE Austin
EONEDNENE slackTie
HEONNNNNN Cvi
BN EEEN cCarty =
HOENENEN composite
HONNEENEN concourse
HONNNTNN couture
HONNENEEEN Eemental
HONNENEN cquity
HONCWMEMNE Essential
HONNNNEN Execcutive
HONENNNN Flow
BEOENOEEE Foundry
HEONNENEN crid -

Create New Theme Colors..,

Atau juga bisa menentukan kombinasi sendiri, yaitu dengan memilih menu Create New
Theme Colors
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[ Create New Theme Colors @
Theme colors Sample
Text/Background - Dark 1 Text
Text/Badkground - Light 1 | |
[ o )
Text/Backaround - Dark 2 0 —
Text/Background - Light 2 m &
Accent 1 Hyperlink
Accent 2 Hyperink
Accent 3
Accent 4
Accent 5
Accent &
Hyperlink
Followed Hyperlink
Mame: Custom 1
Reset [ Save ] [ Cancel ]

5. Demikian juga untuk Fonts atau huruf, kita bisa memilih pengaturan huruf yang telah
tersedia atau melakukan pengaturan sendiri dengan memilih Create New Theme Font

6. Lakukan juga pengaturan efek, efek disini berkaitan dengan format grafik. Ada banyak
pilihan efek yang bisa kita pilih.

7. Setelah pengaturan ketiga komponen tersebut kita lakukan, maka kita bisa menyimpan
hasil kustomisasi tersebut menjadi sebuah theme baru dengan cara mengklik menu Save
Current Theme.
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Home Insert Page Layout Referer
R [ & 0 E
LTI FCIrItS - % =

Themes Margins Orientation Size Colum

- |[O]ffedts~ | . = = =
Custom =]
L
Aa Aa
EEEEEE EEEEEE E‘l
Themel Theme2
Built-In =
Aa Aa Aa Aa
EEEEEN L L] [ ] ] EEEEEE L L] ][]
Office Adjacency Angles Apex
Aa Aa Aa Aa
L L] 1] EEEEEN L L1 []] ENEEEN
Couture Elemental Equity Essential |
Reset to Theme from Template
Enable Content Updates from Office.com...
Browse for Themes..,
G save Current Theme.., @

8. Padajendela Save Current Theme, masukkan nama theme baru Kkita, lalu klik Save.

Save Current Theme E
v| .. % Templates » Document Themes » - | g | | Search Document Themes pel |
Organize = MNew folder 4= - @

4 Downloads “  Name Date modified Type
“El Recent Places .
.. Theme Colers 2/23/201211:36 PM  File folder
B . Theme Effects 2/23/201211:36 PM  File folder
.~ Libraries .
.. Theme Fents 7/23/2012 3:19 PM File folder
@ Documents = i ) )
J’ N Themel thmx 6,/10/2012 12:54 AM  Microsoft Office T...
usic
. Theme2.thmx 7/23/2012 3:20 PM  Microsoft Office T...
[E=| Pictures
i Videos
18 Computer
& T
# PortablefApps.col - [ o .
File name:  Theme2.thmx -
Save as type: [Dﬁice Theme (*.thmz) ']
(= Hide Folders Tools = I Save I ’ Cancel ]

9. Maka theme kita akan muncul pada pilihan theme

Page 120 of 187



limuKomputer.Com

Mme Insert Page Layout Refere|
e OB O @
.ants' ]

Margins Crientation 5Size Colun

[O] Effects - - - - -
Aa
EEEEEE IIIIII
Themel Theme2
Built-In =
Aa
EEEEEE | | [ [ ] ] EEEEEE L 11 ]]
Office Adjacency Angles Apex

c. Template

Template merupakan dokumen yang mendefinisikan informasi tentang style dan skema warna teks
dokumen serta berisi konten tertentu. Pada Word 2010, dokumen template disimpan dalam
ekstensi .dotm atau .dotx. Setiap dokumen yang dibuat pasti berdasarkan template tertentu (default

template Blank Document atau Normal.dotm).

Home Insert Page Layout References Mailings Review My Tab View Develop

Q Save

Available Templates
Save As

+ fat Home
[ Open
ﬁ Close \ - | | \
5 T j

Info i/‘-‘ t- \
Recent Blank Blog post Recent Sample My ternplates | New from

document termnplates templates existing

=

Print — Personal Templates
— || &

Save & Send = =1
' = Pre:
Hel Agendas Blank NormalCld....
=2 Document
2] Options \

— |

Menggunakan Template

Untuk mempercepat dan memudahkan kita dalam membuat sebuah dokumen tertentu adalah
dengan menggunakan template yang telah tersedia atau mengunduhnya jika kita memiliki koneksi

internet.
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Berikut ini langkah-langkahnya:

1. Pada menu ribbon, pilih File > New
2. Pilih sample templates

Y lim |4

cent Sample My temg
plates ternplates I}

3. Maka akan muncul template yang tersedia, pilih salah satu template yang diinginkan.

Available Templates

* fit Home » Sample templates

Adjacency Merge Letter Adjacency Report

Apothecary Merge Letter  Apothecary Mewsletter Apothecary Resurne

4. Maka dokumen baru yang dihasilkan merupakan dokumen yang dibuat berdasarkan
template yang kita pilih sebelumnya.

Membuat Template

Sebagaimana yang dijelaskan dimuka, bahwa template merupakan dokumen yang berisi kumpulan
dari definisi style dan skema warna teks serta konten tertentu. Oleh karena itu pada dasarnya
membuat sebuah template sama saja dengan membuat sebuah dokumen biasa hanya saja dokumen
tersebut kita simpan dengan format .dotx atau dotm.

1. Buat dokumen baru, File > New
2. Pilih My templates, pada jendela New yang muncul, pilih opsi Template, lalu klik OK
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lj Open L mune
[ Close
ST |
Info L/-'] L-
Sy = =
Recent Blank Blog post Recent Sample My templates | New from
docurment templates templates existing

MNew Off b
- New |

Print Personal Templates
Save & Send (Wil %ﬂ =
31
p =) Preview
Hel Blank MormalOld....
P Document
] Options
@ Exit Preview not available,
E il
Create New
() Document @ Template
Ini
[ oK ] [ Cancel ]

| \
3. Lakukan pengaturan yang berkaitan dengan pendefinisian style teks dan heading, skema
warna teks, dan konten tertentu.
4. Setelah itu, simpan templat. File > Save, masukkan nama file template kita lalau tekan
tombol Save.

(W] Save As
f guo| . €« Roaming » Microsoft » Templates » - |$f | | Search Templates ye |
Organize * MNew folder H== = @

PR Desktop m Mame ’ Date modified Type
4. Downloads .
h .. Charts 4/19/2012 2:02 AM File folder
= Recent Places _ .
. Document Themes 7/23/2012 3:20 PM File folder
) o . LiveContent 2/21/2012 1:45 PM File folder
4 Libraries E ) o ]
.. SmartArt Graphics 3/7/2012 8:27 AM File folder
@ Documents
J‘ Music
[ Pictures
E Videos
1M Computer RN m ¢
File narne:  Templateku -
Save as type: [Word Template (*.dot) -
Authors: Hafid Tags: Add atag
[ Save Thumbnail
“ Hide Folders Tools - Save ] [ Cancel

5. Selesai.

Mengaplikasikan Template

Page 123 of 187



Pada Microsoft Word, memungkinkan kita untuk menerapkan template tertentu kepada sebuah
dokumen. Sehingga untuk membuat sebuah dokumen, kita bisa fokus kepada kontennya saja,
adapun template bisa diterapkan setelah konten jadi.

Berikut ini langkah-langkah untuk menerapkan sebuah template pada dokumen yang telah jadi:

1. Buatlah sebuah dokumen baru
2. Tulislah teks dummy

SEPAK BOLA

SEJARAH

MASA PENJAJAHAN
BELANDA
JEPANG

MASA KEMERDEKAAN
MASA SEKARANG

3. Lalu pada tab Developer, group Templates, klik Document Template

s Developer
hema 4 ] —lﬁ
. ;5 &] @ ] Q.
pnsformation
) Block  Restrict | Document Document
pansion Packs | ayuthors = Editing | | Template,,  Panel
L Protect Tem&tes

4. Pada jendela Template and Add Ins, Attach atau masukkan template yang ingin kita
terapkan dengan cara mengklik tombol Attach
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o =

Termnplates and Add-ins

Templates | XML Schema | XML Expansion Packs | Linked CS5 |

Document template
Mormal Attach...
[] Automatically update document styles

Attach to all new e-mail messages
Global templates and add-ins
Checked items are currently loaded,

Full path:

o) o

5. Pada jendela yang muncul, pilih file template kita. Lalu klik Open

@ Attach Template
@Ov| @ v Libraries » Documents » - | +y | | Search Documents Fe |
Organize » MNew folder =~ i @

Bl Desktop .

Documents library

Includes: 2 locations

& Downloads Arrange by:  Felder =

LOE:
=l Recent Places

— s

Name
) Ji Vypress Lhat History
= Libraries Teach
.. Teac
@ Documents Bluetooth
.. Bluetoo
Musi
J’ Hsie @ My Music
[E5] Pictures E )
[ My Pictures
E Videos :
@ My Videos
- My Music
1= C t
: }’ c-:lrr::ucer My Pictures =
— = — My Videos
PortableApps. —
o lalls Ltis |@J Templateku.dotx -
> | 4| [} — 2
- Type: Microsoft Word Template
File name: Templateku.dob: Authors: Hafid Vord Templates (*.dotg*.de VI
Size: 17.0 KB
Date modified: §/31/2012 1:25 f\M Open ] I Gancel ]

6. Centang checbox Automatically update document style, klik OK
7. Maka format teks pada dokumen kita akan berubah mengikuti template.

Page 125 of 187



B limu dznaan

IImuKomputer..C_o‘m

SEPAKBOLA

MASA PENJAIAHAN

BELANDA
JEPANG

JAASA KEMERDEKAAN

MASA SEKARANG

8. Selesai.

9. Fitur Lain

a. Screen Capture Tools

Fungsinya mirip dengan print screen pada keyboard yang diembed dalam Ms Word sehingga lebih
cepat. Caranya : Pada menu ribbon, pilih tab Insert, klik Screen shoot, dan pilih available window
yang akan di print screen

[@Itﬂ#vu’?fﬁh Y Do - Mo o T o S o

Mme My Tab Insert Page Layout References Mailings Review View Developer

= ElE ™y T2 SmartArt 5] Header ~ & QuickParts~ @~ T Eqg
A EEPT 2 A

il Chart : & Footer - — dwordart- [F | Qe
Pages  Table | Picture Clip Shapes — Links Text |, _
- = Art + |zt Screenshot - - [#] Page Number = | goy~ A5 DropCap~ hgd~
Tables lllustratio  available Windows a“ syn
Mavigation v X
Search Document - == e e - A
o =
= | oo | = |
= | oo | = R i -~
, the
This document does jm::u
not contain headings.
the
To create navigation ]
tabs, create headings ke,
in your document by
applying Heading
Styles, ¥ | pr the
|53+ Screen Clipping E:E
éTc- change the overall look of your document, choose new Theme elements on the Page Layout tab.

Kita juga bisa live cropping layar yang kita print screen tersebut dengan cara memilih Screen
Clipping
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b. Live Paste Preview

Fitur ini berfungsi untuk menampilkan preview secara langsung dari konten yang akan dipaste,
yang mana secara umum ada tiga opsi paste yaitu:

e Keep Source Formatting - Konten yang dipaste akan tetap menggunakan format dari
dokumen yang di copy.

o Merge Formatting - Konten yang dipaste akan menggunakan format dari dokumen tujuan.

o Keep Text Only - Konten yang dipaste hanya akan berupa plain teks tanpa gambar dan
format

Caranya: copy konten yang berisi teks berformat dan gambar, kemudian pada menu Ribbon pilih
Home > Paste, lalu pilih salah satu dari opsi paste. Ketika mouse kita arahkan ke salah satu dari
ketiga opsi tersebut, maka pada area dokumen akan ditampilkan preview dari konten yang akan
dipaste.

Home Insert
=]k

| Paste | h

- | Format Painter

Cali

=

Paste Options:

| [S][A

Paste Special...

5et Default Paste...
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c. Clipboard

Clipboard merupakan hasil copy atau cut suatu konten yang disimpan di memori. Word mempunyai
fitur untuk mengelola clipboard tersebut sehingga ketika kita akan mempaste maka kita bias
memilih konten clipboard mana yang akan dipaste.

Tab Home | Clipboard | Klik launcher

V. Koneksi Pada Dokumen

1. Mengaplikasikan Hyperlink

Hyperlink merupakan tautan yang menghubungkan satu titik (teks/gambar/dsb) dalam dokumen
ke titik lain. Titik tujuan bisa berupa: bagian dari dokumen, file dokumen lain, alamat website, dll.
Fungsi hyperlink adalah untuk menghubungkan ke informasi terkait atau untuk melakukan
aktifitas seperti membuka dokumen lain, download file, menampilkan halaman web, atau mengirim
email.

Hyperlink berbentuk sebuah link yang mana untuk mengeksekusinya bisa kita lakukan dengan
menekan tombol CTRL diikuti dengan mengklik link tersebut.

mailto:milisstudic@gmail.com?
subject=test
Ctrl+Click to follow link

¥irim EEaill

Cara menambah hyperlink: pada menu ribbon pilih Insert kemudian pada group Links pilih
Hyperlink.

@ =

Hype&ink EBookmark Cross-reference

Links

Maka akan muncul jendela dialog hyperlink
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Insert Hyperlink — T —— . e W mm— M
Link to: Text to display:
Lookin: | ). [T [=]
Existing File or
Web Page . Ebook Bookmark. ..
%’l:f”t |, Kurikulum
e . Modul Target Frame...
Place in This . Other
Document Browsed | . Teach
Pages ., Teach I
>D . Templata %
Create New Recent . Video
Document Files
Address: IZ|
E-mail Address

a. Link ke File

Misalnya kita akan membuat link ke file video, berikut ini langkah-langkahnya:

Pada jendela Insert Hyperlink

Link to: pilih Existing File or Web Page

Text to display: File Video

Look in: pilih folder tempat penyimpanan file video yang akan dihubungkan
Pilih file video

Klik tombol OK

r Y
Insert Hyperlink M

Link to: Text to display: |File Video
Look in: H My videos IZ|

Existing File ar

\Web Page . Google Docs Bookmark. ..
Current

Folder Ms Office 2010

Place in This . ROBINHOOD

o Uk W

Document Browsed J UPIN IPIN
Pages , Web Programming
2| desktop.ini
Create New Recent m SEMAM OTAK BRAIN GYM.mp4
Document Files
Address: C:\Users\useriVideos\SENAM OTAK BRAIM GYM.mp4 |Z|

E-mail Address

[ [\QK ] [ Cancel

b. Link ke Halaman Web

Misalnya kita akan membuat link ke halaman web wikipedia, berikut ini langkah-langkahnya:

1. Padajendela Insert Hyperlink
2. Link to: pilih Existing File or Web Page
3. Textto display: Makna Lebaran

Page 129 of 187



IImuKomvpu.ter..Com

4. Address masukkan alamat website : http://id.wikipedia.org/wiki/Lebaran

5. Klik tombol Target Frame, pada jendela Set Target Frame: pilih New Window supaya ketika
link di klik maka target akan dibuka pada jendela baru. Klik tombol OK.

6. Klik tombol OK

' Y
Insert Hyperlink &Iﬂ
Link to: Text to display: |Makna Lebaran
Look in: | My Documents |E|
Existing File or
Web Page , AssaultCube_vl.1 - Bookmark...
Current Bahan |_|
Folder ] - BE
. Bahan Ajar PPDP
Place in This | BDK Makassar
Document Browsed . BDK Malang
Pages J Bluetooth
)iﬁ . Bus Driver
Create New Recent | easylib
Document Fileg , IFR_Applications
J Imu Komputer e
Address: http://id.wikipedia.orgfwiki/Lebaran |Z|
E-mail Address
LD 0K ] ’ Cancel

e

-
Set Target Frame m

Current frames page: Select the frame where you want the
document to appear:
Mew window El
— Set as default for all hyperlinks
[ fl§ ] ’ Cancel ]
u 1y

c. Link ke Lokasi Lain Pada Dokumen

Lokasi lain bisa berupa Heading atau Bookmark. Berikut ini langkah-langkahnya:

Pada jendela Insert Hyperlink

Link to: pilih Place in This Document

Text to display: loncat ke Pendahuluan

Select a place in this document: pilih Pendahuluan
Klik tombol OK

v W e
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# B h
Insert Hyperlink — . ' m
Link to: Text to display: locat ke Pendahuluan
Select a place in this document:
Existing File or | | .- Top of the Document -
Web Page - Headings |:
[=E Pendahuluzg
Place in This Menggunakan Mouse
Document : - Dalam Tubuh Dokumen
. - Dalam Tabel
: B--Menggunakﬂn Keyboard
Create Mew - Dalam Dokumen
Document ‘.- Dalam Tabel
- Bergerak Dalam Dokumen =
] — T wm | »
E-mail Address
[ Ok ] ’ Cancel
L

d. Link ke Email

Berikut ini langkah-langkahnya:

Pada jendela Insert Hyperlink

Link to: pilih E-mail Address

Text to display: Kirim Email

E-mail address: masukkan alamat email yang dituju, misal: mailto:milisstudio@gmail.com
Masukkan subject dari pesan email

Klik tombol OK

Insert Hyperlink m
Link to: Text to display: |Kirim Email

E-mail address:

Existing File or | | mailto:milisstudio@gmail.com

o Ul W

Web Page
Subject:
Test
Place in This Recently used e-mail addresses:
Document i n
Create New
Document

E-mail Address

e. Edit Hyperlink

Klik kanan hyperlink, lalu pada menu dropdown pilih Edit Hyperlink
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ot

|, Paste Options:

=
9 Edit Hyperlink...
5

Sele yperlink

Cpen Hyperlink

f. Hapus Hyperlink

Klik kanan hyperlink, lalu pada menu dropdown pilih Remove Hyperlink

Kirim Enm

[, Paste Options:
v A

@, Edit Hyperlink..
Select Hyperlink
Open Hyperlink
Copy Hyperlink

"ﬂ Remove [jgperlink

g. Menambahkan Bookmark

Bookmark merupakan penanda pada suatu konten dokumen yang akan digunakan sebagai
referensi

Caranya:

1. Letakkan kursor mouse pada lokasi yang ingin kita bookmark atau seleksi teks/obyek yang

ingin kita bookmark.
2. Pada tab Insert, group Links, klik tombol Bookmark.

My Tab View Developer

Q@ 2 =

Hyperlink Boohﬂark Craoss-reference

Links

3. Pada jendela Bookmark, masukkan nama dari bookmark lalu klik tombol Add

Nama bookmark tidak boleh berisi spasi. Untuk nama yang lebih dari satu kata, gunakan
garis bawah agar mudah dibaca
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=
Bookmark m

Bookmark name:

formatting [ gﬁd
e X

"
| -

| Sortby: @ MName

L () Location
[ Hidden bookmarks

Close

h. Menjelajah Bookmark

1. Pada tab Insert, group Links, klik tombol Bookmark.
2. Padajendela Bookmark, pilih nama bookmark yang ingin dituju
3. Klik tombol Go To, dan close

>
oot ——— =
S _
Bookmark name:
formatting ‘L‘
-
\ w
| |
N
1" Sortby: @ MName
[ ) Location
| [ Hidden bookmarks
| |
Cancel

Atau bisa juga dengan menggunakan fitur Go To

1. Padatab Home, group Editing, klik arrow Find
2. Pilih Go To
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> @

%%F‘

Find
Change
Styles 1 @4 Advanced Find...

= GoTq.
o s e

3. Pilih nama bookmark yang hendak dituju, lalu klik tombol Go To
[ Find and Replace @Iﬂ—hj

Find Replace GoTo

Go to what: Enter bookmark name:
Page » | |formatting |Z|
Section |;|
Line =
Comment
Footote &

2. Membuat Daftar Isi

Daftar isi merupakan index atau peta dari dokumen panjang, yang akan memudahkan pembaca
dalam menjelajahi dokumen tersebut. Dalam bahasa inggris daftar isi disebut dengan Table of
Content (TOC).

Microsoft Word memiliki fitur untuk membuat daftar isi secara otomatis melalui style heading yang
di dokumen tersebut. Word akan mengindek semua heading (defaultnya dari heading 1 sampai
heading 3) kemudian membuat link-link menuju ke heading-heading tersebut. Heading merupakan
style teks untuk judul, sub judul, dst.

Oleh karena itu dokumen yang baik hendaknya menggunakan style heading untuk mengatur judul
atau subjudul sehingga daftar isi bias dibuat secara otomatis. Ada dua cara membuat daftar isi yaitu
dengan menggunakan template daftar isi build-in atau bawaan dan membuat secara kustom.

a. Menggunakan Daftar Isi Build-In

Langkah-langkahnya:

1. Siapkan sebuah dokumen panjang yang terdapat style heading di dalamnya.
2. Arahkan kursor pada halaman kosong sebagai tempat untuk meletakkan daftar isi.
3. Pada menu ribbon tab References, pilih Tabel of Content
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m_Home Insert Page Layout References Mailing
[ Add Text - AR [y Insert Endnote i
|2 Update Table ﬁg MNext Footnote = ¥
Table of Insert Insert
Contents + Footnote si show Notes Citation = &
Built-In i
Automatic Table 1
Contents
11 Heacing 2 1
141 Heading 3. 1
Automatic Table 2
Table of Contents
11 Heacing 2 1
111 Heading 3. 1
Manual Table

4. Pilih salah satu dari template daftar isi yang tersedia.
5. Selesai

-_'}_‘Q-l-j_-|-2-|-3-|-4-|-5-|-6-|-?-|-s-|-9-|-1.0-|-1_1-|-1_2-|-]3-|-1_4-|-]5-|-1_6-2\-

Table of Contents

o= =T 1
LT T
Paragraf 3

a. Membuat Daftar Isi Secara Kustom

Langkah-langkahnya:

1. Siapkan sebuah dokumen panjang yang terdapat style heading di dalamnya.
2. Arahkan kursor pada halaman kosong sebagai tempat untuk meletakkan daftar isi.
3. Pada menu ribbon tab References, pilih Tabel of Content, lalu pilih Insert Tabel of Content
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ﬁHnme Insert Page Layout References Mailing
[Z Add Text ~ |#yInsert Endnote L
[2¥ update Table Ag Mext Footnote - — L
Table of Insert Insert
Contents = Footnote Q Show Motes Citation = §
|| Built-In I
Automatic Table 1
Contenls
1 HEADING 1 1
i ARG X, i
T P

Insert Table of Contents...

Eemove Table n&n ntents

Save Selection to Table of Contents Gallery...

B X = - - e e L L ¥ L i |

4. Maka akan muncul jendela Table of Content, disini kita bisa mengatur apakah nomor
halaman dicantumkan dalam daftar isi, apa karakter yang digunakan untuk
menghubungkan nomor halaman dan heading, format tampilannya (gunakan Formal), serta
berapa level heading yang akan ditampilkan dalam daftar isi (default: 3).

r — P | —
Table of Contents m
—
Index Table of Contents | Table of Figures | Table of Authorities |
Print Preview Web Preview
-
HEADING 1...coeeiiiieiineeeennenaas 1 |_| HEADING 1 3
HEADING 2..eveececmeeeacaeseemeaeaenes 3 Heaping 2
Heading 3 Heading 3
Show page numbers Use hyperlinks instead of page numbers
Right align page numbers
Tab leader: |, El
General
(]
: Formal |
Formats Formal |Z| i
Show levels: |3 - I
Options...
|
[ OK ] [ Cancel l

5. Untuk pengaturan lebih lanjut, kita bisa klik tombol Options. Disini kita bisa menentukan
sendiri TOC Level untuk style, secara default Heading 1 adalah TOC Level 1, Heading 2
adalah TOC Level 2, dan Heading 3 adalah TOC Level 3, dst.

Sehingga kita bisa membuat style sendiri kemudian memunculkannya ke dalam daftar isi
dengan cara mengatur TOC Level pada style tersebut.
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l',t',‘_L{ ZE2NDGN Y2 ulisr2Aanaua
Table of Contents | ? &= |
Index | Table of Contents | Table of Figures I Table of Authorities |
Print Preview |_web Preview
,
HEADING 1| Table of Contents Options —— m |i|
HEADING Build table of contents from:
Headif =
Available styles: TOC level:
Footer il
A =
Show pags Header ks
Right align]| ¥ Heading 1 1
Tab leader: [ ¥  Heading 2 2
~  Heading 3 3
General Heading 4 il
Formats: Qutline levels
Shaw levels [] Table entry fields
o) o)
[ 0K ] [ Cancel l

6. Klik OK

b. Mengupdate Daftar Isi

Daftar isi yang telah dibuat tidak otomatis update menyesuaikan dengan perubahan konten
dokumen, melainkan harus kita update secara manual:

Langkah-langkahnya:
1. Klik kanan pada daftar isi, kemudian klik Update Field.

PARAGRAF1 ..... BIEJEE'P?'&'J .

Paragrar ... —_—
Parograf 3.~ I .............
By Cog
[, Paste Options:
=

Z¥  update Field
Edit Fiell:&

Taoale Field Codes

2. Pada jendela dialog Update Table of Contents, klik Update page numbers only (update
nomor halaman saja) atau Update entire table (update konten dan nomor halaman),
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Update Table of Contents &lg

Word is updating the table of contents. Select one of
h| the following options:

7 Upda

numbers only

3. Kemudian klik OK.

Atau:
1. Posisi kursor pada daftar isi
2. Pada tab References, dalam group Table of Contents, klik tombol Update Table
3. Lakukan sebagaimana cara sebelumnya.
4, Klik OK

c. Menghapus Daftar Isi

Langkah-langkahnya:

1. Posisi kursor pada daftar isi

2. Pada tab References, dalam group Table of Contents, Pilih Table of Content, kemudian klik
Remove Table of Content

ME Insert Page Layout References Mailing
% (2 Add Text - AR [[;yInsert Endnote 4
2 Update Table A |

J‘\g Mext Footnote -
Table of Insert Insert
Contents =

Footnote = Show Notes Citation = @
|| Built-In

Automatic Table 1

4

] Insert Table of Contents...
Eemn\reTabISf Contents

—jEl Save Selectio

3. Klik OK

3. Membuat Daftar Gambar & Tabel
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Hampir sama dengan proses pembuatan daftar isi, untuk membuat daftar gambar/table maka yang
perlu kita lakukan adalah memberi caption atau judul pada setiap gambar/table. Baru kemudian
daftar gambar/table bisa kita generate.

a. Memberi Judul Gambar/Tabel:

Caranya:
1. Klik kanan gambar atau tabel

2. Pada popup menu yang muncul pilih Insert Caption...

Copy
Paste Options:

¥ |

alah:

Sawe as Picture...

Change Picture...

Insert G

Hyperlink...

Insert Caption...

& = @ & & 5

Wrap Text 3

3. Pada jendel Caption, pilih label yang sesuai (Gambar/Tabel) lalu tuliskan judul gambar tersebut
pada kolo caption. Lalu klik OK. (tombol New Label untuk membuat label baru)

Caption @

Caption:
[FIGURE 1| |
Options

Label: Figure E
Position: | Below selected item IZI

|| Exclude label from caption

’ﬁutoCapﬁon... ] [ oK ] [ Cancel ]

4. Hasilnya
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Untuk memformat teks judul tersebut sebaiknya jangan diformat langsung melainkan melaui style
caption sehingga semua judul dalam dokumen tersebut juga akan berubabh.

b. Menampilkan Daftar Gambar/Tabel

Caranya: pada menu References, pilih Insert Table of Figures

:'dj (5] Insert Table of Figures

=¥ Update Table
Insert
Caption [ Cross-reference

Captions

4, Membuat Endnote dan Footnote

Note merupakan catatan yang berisi informasi, keterangan atau referensi tambahan yang
menjelaskan suatu konten dalam dokumen. Ada dua macam note yaitu: footnote dan endnote.
Footnote merupakan note yang terletak dibagian bawah suatu halaman, sedangkan endnote adalah
note yang terletak di halaman terakhir dokumen.

! Munir Fuady, Hukum Pailit Dalam Teori dan Praktek, PT. Citra Aditya B
2 Zainal Asikin, Hukum Kepailitan Dan Penundaan Pembayaran, PT. Gra
3 Sunarmi, Hukum Kepailitan Edisi 2, PT. Sofmedia, Jakarta, 2010, hal. 1
41bid.

3 Ibid., hal. 11

a. Menambahkan Footnote

Langkah-langkahnya:

1. Letakkan kursor ke lokasi yang akan ditambahkan referensi atau note
mraf 1
Inserttab, the galleriesinclude items tk
cument. You can use these galleries to
ocument building blockﬁm\!henyuu cre
urcurrent document look.

2. Pada menu ribbon tab references, pilih Insert Footnote
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Page Layout References

.__[';'] Insert Endnote

ﬁs Mext Footnote -
Insert

Fogtgte Q Show Motes

Footnotes I

3. Maka kita akan dibawa ke bagian bawah halaman. Tuliskan note tempat tersebut.

1 Tuliskan footnote disini|

4. Akan muncul index dari note yang ditambahkan tersebut, berupa angka kecil yang posisinya
agak ke atas.

Paragraf1
On the Inserttab, the galleries include ite
your document. You can use these galler
other document building blocks!. When'y
with your current document look.

b. Menambahkan Endnote

Langkah-langkahnya:

1. Letakkan kursor ke lokasi yang akan ditambahkan referensi atau note

thatare designed to coordin
ro insert tables, headers, foot
create pictures, chartﬁ:[ or dia

2. Pada menu ribbon tab references, pilih Insert Endnote

Page Layout References

Uiy Insert Endnote

ﬁi Mext Foothote -
Insert

Footnote 3] Show Motes q
Footnotes I

3. Maka kita akan dibawa ke bagian bawah halaman. Tuliskan note tempat tersebut.

i Tulis endnote disini| I
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4. Akan muncul index dari note yang ditambahkan tersebut, berupa huruf romawi kecil yang
posisinya agak ke atas.

thatare designed to coordinate
to insert tables, headers, footers,
create pictures, charts’, or diagra

c. Kustomisasi Endnote dan Footnote

Index note bisa diatur sesuai dengan keinginan kita, caranya:

1. Pada menu ribbon tab references, pada group Footnotes, pilih tanda panah di pojok kanan

bawah
Page Layout References Mailing
.__[';'] Insert Endnote i
ﬁg Mext Footnote - ¥
Insert Insert

Footnote 5{ Show Notes Citation = §
Footnotes | Citation
v X |[L] IJ'u}cutnDte &End

1 1

2. Maka akan muncul jendela dialog Footnotes dan Endnotes, atur propertinya. Disini kita bisa
mengatur lokasi note dan number format

i T
Footnote and Endnote M
Location
(@ Footnotes: Bottom of page |Z|
() Endnotes: End of document
Farmat
I Mumber format; 1,2, 3 .. |Z|
1] 1]
Custom mark: | | [ Symbol. .. ] I
] ]
Start at: 1 =
| | |
I Mumbering: Continuous |Z|
Apply changes
Apply changes to:  |[Ngls=RslstaNy=g]8 |Z| i
[ Insert '\eJ [ Cancel ]
L

3. Klik tombol Insert.
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5. Bekerja dengan Mail Merge

Mail merge merupakan salah satu fitur classic Microsoft Word yang sangat berguna untuk membuat
dokumen secara massal dan dinamis. Fungsi mail merge di Microsoft Word 2010 bisa kita jumpai
pada menu ribbon yaitu tepatnya pada tab Mailings.

Jika kita ingin membuat surat untuk banyak penerima, yang mana secara umum isi surat untuk
masing-masing penerima surat adalah sama kecuali nama, alamat atau informasi lain dari penerima
surat, maka dengan menggunakan fitur Mail Merge ini kita bisa melakukannya dengan lebih cepat.

a. Persiapan Dokumen Mail Merge

Mail merge mengkombinasikan informasi statis yang disimpan dalam sebuah dokumen (dokumen
utama) dengan variabel informasi yang disimpan pada dokumen lain (data sumber). Dokumen
utama berisi teks statis yang akan muncul pada semua dokumen yang digabungkan. Disamping itu
juga berisi placeholder yang disebut merge field yaitu tempat variabel informasi akan ditampilkan.

Persiapan Dokumen Utama

Dalam contoh berikut kita akan membuat dokumen utama berupa surat undangan rapat, yang
mana undangan rapat ini akan ditujukan untuk beberapa penerima surat. Ada tiga variabel
informasi yang digunakan yaitu: nama (jabatan) penerima, alamat penerima, kota penerima.

Tiga variabel informasi itu disebut dengan merge field, artinya field-field yang nilainya akan
diambil dari data sumber secara dinamis.
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Persiapan Data Sumber

Setelah mempersiapkan dokumen utama, maka langkah selanjutnya adalah mempersiapkan data
sumber yang akan digunakan untuk mengisi variabel informasi pada dokumen utama. Data sumber
ini sering disebut dengan data recipients atau penerima surat.

Data sumber berupa tabel (matrik baris dan kolom). Masing-masing baris data sumber berisi
beberapa sel, baris pertama berisi judul field / field name (contoh: No, Nama, Alamat, Kota),
sedangkan baris selanjutnya merupakan data field tersebut.

Berikut ini contoh data sumber untuk dokumen utama diatas:

NO NAMA ALAMAT KOTA
1 | Kepala Biro SDM Setjen | J1. Dr Wahidin No 55 Jakarta Pusat
2 | Sekretaris BPPK JL Purnawarman No. 99 Kebayoran Baru | Jakarta Selatan
3 | Kapusdiklat PSDM Komplek STAN Jurangmangu Tangerang
4 | Kepala BPPT J1 ThamrinNo. 123 Jakarta Pusat

Judul field atau field name pada contoh diatas adalah satu kata, untuk kasus lain yang mana judul
fieldnya lebih dari satu kata maka ada aturan yaitu tidak boleh menggunakan spasi. Hal ini karena
judul field tersebut digunakan sebagai merge field pada dokumen utama. Untuk membuat judul
field mudah dibaca maka kita bisa menggunakan huruf kecil kecuali huruf pertama pada masing-
masing kata, contoh: NamaLengkap, NomorTelepon. Atau bisa juga dengan menggunakan tanda
garis bawah, contoh: nama_lengkap, nomor_telepon.

Page 144 of 187



Data sumber yang valid adalah berupa dokumen terstruktur, seperti tabel Microsoft Word, tabel
Microsoft Excel atau CSV, tabel database Microsoft Access, dan daftar kontak Microsoft Outlook.

b. Menghubungkan Dokumen Mail Merge

Setelah kita mempersiapkan dokumen mail merge yang terdiri dari dua dokumen yaitu dokumen
utama dan dokumen / data sumber. Maka sekarang kita akan menghubungkan (merge) kedua
dokumen tersebut agar merge field (variabel informasi) pada dokumen utama terhubung dengan
data field pada data sumber.

Berikut ini langkah-langkanya:

1. Buka file dokumen utama (surat undangan)

2. Tambahkan data sumber (data penerima surat / recipients). Caranya: pada tab Mailings,
klik tombol Select Recipients, pilih Use Existing List... (karena kita telah membuat data
sumber sebelumnya, jika belum kita bisa membuatnya secara langsung dengan memilih
Type New List...)

Page Layout References Mailings

Select Edit Highlight Addreg
Recipients ~|Recipient List | Merge Fields BEloc
Ig Type Mew List... L

| B Use Existing List... 5.0

| &=  Selewfrom Outlook Contacts.. b
F H i ———— 7Y

3. Pada jendela Select Data Source, browse dan pilih data sumber yang telah kita buat
sebelumnya, klik tombol Open
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RAAA

h limu denaan men

Select Data Source u
G@v ) <« Modul Ms Word 2010 ... » Mail Merge - Search Mail Merge o
=" T e
Organize « Mew folder = - 0O 9
D load i 3
Q!' . Documents library Arange by: Folder -
7= Recent Places Mail Merge )
| (4 Libraries m Meme
¥ Documents 4] ~Skumen-utama.docx
& Music ] dokumen-utama.docx
[&=| Pictures 3 | data-sumber.docx
" b
& videos Type: Microsoft Word Document
Authors: Hafid
I| ™ Computer L4 Size: 13.7 KB
Date modified: 8/11/2012 6:27 AM
I & Thac)
# Portablefpps.col + [ I g 3
’ Mew Source... l
: File name: data-sumber.docx - [AII Data Sources (*.odc;™.mdb;* ']
L Tools = I Open I l Cancel ]

4. Untuk memastikan apakah data sumber telah masuk atau belum maka kita bisa klik tombol

Edit Recipient List pada tab Mailings

out References Mailings

3 E
Edit Highlight Addres
Recipier&ust Merge Fields Block]

trge

Maka akan muncul jendela Mail Merge Recipients
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v viery Reciiers [ (e
Thiz is the list of redpients that will be used in your merge. Use the options below to add to or change your list. Use the
checkboxes to add or remove recipients from the merge. When your list is ready, dick OK.

Data Source |7 NO o | NAMA w | ALAMAT - | KOTA -

rs\user\Do... 1 Kepala Biro SDM Setjen |_I|. Dr Wahidin No 55 |_Iakarta Pusat

ChUsers\user\Do... |7 2 Sekretans BPPK Il. Purnawarman Mo. 9...  Jakarta Selatan

CAUsers\user\De... [¥ 3 Kapusdiklat PSDM Komplek STAM Jurang... Tangerang

ChUsers\user\Do... |7 4 Kepala BFPT I Thamrin Me. 123 Jakarta Pusat
(]

Data Source Refine recipient list
|| |C:\WUsers\user\Documents\Ms { . ‘%l Sort...
! Filter...
E Find duplicates...
_| ¢} Find redpient...
Il Validate addresses...
Edit... | | Refresh |

| |
|

Kita bisa melakukan pengeditan data secara langsung menggunakan tool ini. Caranya: pilih

Data Source,

Data Source Refine recip
| E‘W» £ sort.
! Filter

#4 Find
i Find
Valid
| e | [ oo |
| |

kemudian klik tombol Edit... maka akan muncul jendela Data Form yang berfungsi untuk
melakukan pengeditan data sumber.
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Data Source; = | ALAMAT . |
o —— ]
—
ChlUsers\u
ChUsers\u RIEE |1 |[ Add New ]
Ci\Usersid] | |NAMA: [kepala Biro 5DM Setjen |
ALAMAT: |1. Dr wahidin Mo 55 |
KOTA: |Jakarta Pusat |
Eind...
| ew 5o &|
Data Sour
|
E
et L I =
#e Validate addresses...
[ Edt. || Refresh |

5. Tambahkan Merge Field pada dokumen utama (pada surat diatas, menggunakan merge field
manual maka kita harus menggantinya).

i ampiran -
Hal - Rapat Kurikulum DTU Ms Office 2010

¥th. - [L.NAMA.]
[.ALAMAT.] Hopus merge
[.KOTA.] field manual ini

Merge Field dimasukkan satu persatu, caranya:
a. Arahkan kursor ke posisi merge field pertama

_ampiran -
Hal @ - RapatKurikulum DTU M

vih. o

b. Pada tab Mailings, klik tombol Insert Merge Field, kemudian pilih merge field yang
sesuai (NAMA).

Mailings Review My Tab View

SN 5
= = EEM
hlight  Address Greeting [Insert Merge

e Fields Block Line Field = ﬂ Ug
Write & In NCH

RN U I S T MAMA
RLAMA[%

KEUANGAN REPUBL

DIKAN DAN PELATIHA KOTA
AALDUAM DL A TILLA M L e

c. Maka pada merge field pertama di dokumen utama akan tampak seperti berikut:
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i ampiran L=
Hal @: Rapat Kurikulur

wth, eMNAMAz I

d. Lakukan langkah yang sama untuk merge field lain (ALAMAT, KOTA)

1 ampiran -
Hal - Rapatkurikulu
wth, - «NAMA»

a«ALAMAT =

aKOTAx

6. Selesai.

c. Preview Hasil Mail Merge

Untuk mengetahui apakah dokumen utama dan data sumber benar-benar terhubung maka kita bisa
melakukan preview hasil merge tersebut. Caranya:

1. Pada tab Mailings, klik tombol Preview Results

Mailings Review My Tab View Developer
j 'j _] E'j [=r Rules - < H 411 FoM
= — — oo =
— 2 & Match Fields 1 Find Recipient
nlight Address Greeting Insert Merge Preview
e Fields Block Line Field = £] Update Labels ||Rasylts -3‘/ Auto Check for Errors
Write & Insert Fields Preview Results

2. Lihat pada merge field, jika berhasil maka merge field akan diisi dengan data sebenarnya
dari data sumber.

Momor C5- PRRZ01Z
i ampiran -

Hal {}Rapath{urikulum DTL Ms Office 2010

wth. . Kepala Biro SDM Setjen
JI. Dr'Wahidin No 55

Jakarta Pusat

3. Untuk melihat record selanjutnya, kita bisa menggunakan tombol kontrol (panah) pada
menu ribbon, tab Mailings, group Preview Results.

Mailings Review My Tab View Developer
j -] _] ':'j [p Rules - i H 411 oM
= — = [=1=] =
— & Match Fields 1 Find Recipient
nlight Address Greeting Insert Merge Preview
b Fields Elock Line Field = £] Update Labels ||Rasults -J;/Auto Check for Errors
Write & Insert Fields Preview Results
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d. Mencetak Hasil Mail Merge

Setelah melakukan preview hasil merge dan hasilnya sesuai, maka langkah selanjutnya adalah
finishing atau pencetakan dokumen hasil mail merge. Caranya:

1. Pada tab Mailings, klik tombol Finish & Merge, lalu pilih Print Documents untuk langsung

mencetaknya. Atau pilih Edit Individual Document, untuk melihat (mengedit) hasil dari
mail merge.

Mailings Review My Tab View Developer

ﬂ 3 g ﬁ ZF Rules - 1@2_4 ||44 1 | --e;_'l

',_'j Match Fields 3| Find Recipient

light Address Greeting Insert Merge Preview ) Finish &
Fields Block  Line Field~ (2] Update Labels | pesyjts | ¢ Auto Check for Errors | |perge -
Write & Insert Fields Preview Results '-j Edit Individual Documents
& E
B9 401 il 430 i3 140 o160 A g g | By print Detuments...
2y send E-mail Messages..,
KEUANGAN REPUBLIK INDONESIA -

2. Maka akan muncul jendela Merge yang menanyakan apakah semua record pada data
sumber dicetak atau tidak.

Merge to Mew Document M
Merge records

ol

(7 Current record

() From: To:

Ok ] [ Cancel ]
—]
3. Klik OK

VI. Melakukan Review Dokumen

1. Membuat Komentar Pada Dokumen

Adakalanya kita ingin mengomentari suatu naskah dokumen, misalnya seorang atasan yang
memeriksa proposal yang dibuat oleh bawahannya kemudian ingin memasukkan catatan atau
koreksi, maka bisa dengan menggunakan fitur ini.

Dengan menggunakan fitur ini maka akan memudahkan baik pemberi komentar, maupun yang
diberi komentar dalam rangka menindaklanjuti komentar-komentar terhadap naskah dokumen.

a. Memasukkan Komentar

1. Seleksi teks atau konten lain yang ingin dikomentari
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Most controls offera choice of
change the overall look of vour
available in the Chuclke Style gal

ol i Sy [ W | 11

2. Pada tab Review, group Comment, pilih New Comments
Mailings Review My Tal

o |4 T3 A
Mew Delete Previous Mext

Comment
Comments

3. Masukkan komentar pada balon sebelah kanan

ing a format that vou specify directly. To
| the [Page Layout]:ab. To change the looks __._-{jr,omment [T1]: Lavout halamm ]

et command. Both the Themes gallery
vs restore the look of your decument to

dac mrlnda itame that are Aacienad £a

4. Selesai

b. Menampilkan atau Menyembunyikan Komentar

1. Pada tab Review, group Tracking, klik tombol Show Markup
2. Pilih Comment

Review My Tab View Developer
_J = l 4 l =2 ﬂl_‘] Final: Show Markup -
= [Ii-_j Show Markup *]
te Previous Mext Track
Changes ||+ | Comments I},
mments v | Ink

Menampilkan Komentar Pada Margin

1. Pada tab Review, group Tracking, klik tombol Show Markup
2. Pilih Ballons, klik Show Only Comments and Formatting in Ballons

Review My Tab View Developer
J = l [~ l .'_2;, 2% | Final: Show Markup - \%9 \%9 3 Previous _'ja y ?
= 5] show Markup ~ P3 Next N
te Previous Mext Track Accept Reject Compare Block  Restrict
Changes~||v | Comments v - v Authors ~ Editing
mments | Ink Changes Compare Protect

& 1313 11| Insertions and Deletions S+ 1 B 17 0 B0 90 10 11l 112 1 13 1k

v | Formatting fy directly. To

- nange the locks __—{ iComment [T1]: Layout halaman |
v | Markup Area Highlight bes gallexy J
L—}u Balloons 4 Show Revisions in Balloons

Reviewers 4 Show All Revisions Inline
V' | Highlight Updates v | Show Only Comments and Formatting in Balloons
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Menampilkan Komentar Pada Panel Review

1. Pada tab Review, group Tracking,
2. Klik ikon Reviewing Pane, lalu Reviewing Pane Vertical atau Horizontal.

References Mailings Review My Tab View Developer

%ﬁ \j E E E . F'”' SUWMErkup .

angvuage Cnmment Delvete Previous MNext ‘ Ch‘gr:;ts [E Reviewing Fane| ]
lage Comments Tracking
% | Summary: 1 revisions g oa X
r | Insertions: 0 Deletions: 0 Moves: 0 -
Formatting: 0 Comments: 1 N
iﬂa'm document changes and R
comments -
Comment [T1] -
Layout halaman - | offera choice of using the lo«
: : _| erall look of vour document, ¢
A ~|1e Quick Stvle gallerv, use the
. T : Styles gallery provide reset c
_ ~|>ntained in your current templ
I S S -l th tha nawrarall Tanl af wanr Ao

Menampilkan Komentar Pada ScreenTips

1. Pada tab Review, group Tracking,
2. Klik tombol Show Markup, lalu pilih Ballons, kemudian klik Show All Revisions Inline

Review MyTab  View Developer
I] E E . 5| Final: Show Markup - @ 3 Previous j {1 %
|2 show Markup - 93 Next s
lte Previous Mext Track Accept Reject Compare | Elock  Restrict
Changes ~ Comments - - - Authors ~ Editing
mments Ink Changes Compare Protect
'InsertionsandDelet\ons N . e ea.:

v | Formatting

Markup Area Highlight

Balloons 13 ici
Reviewers L4 Show All Revisions Inline
Highlight Updates | Show Only Comments and Formatting in Balloans

Other Authors

Most controls offer a choice of using the look from the current theme or usings
change the overall look of vour document, choose new Theme elements on th
looks available in the Quick Stvle gallerv, use the Change Current Quick StvlkSe s

lerv and the Quick Styles gallery provide reset commands so that vou can always restore the look of yvour document
tothe original contained in your current template. On the Insert tab, the galleries include items that are designed to
coordinate with the overall look of your document.

¥ <=

&

Menampilkan Komentar Reviewer Tertentu

Page 152 of 187



IImuKom“puAter..Com

1. Pada tab Review, group Tracking,
2. Klik tombol Show Markup, lalu pilih Ballons, kemudian klik Show All Revisions Inline

Review My Tab Wiew Developer
ZI \j 29 ,_I_] Final: Show Markup ~ @ . ‘Q}F‘reu
l,_.j Show Markup - l 23 Mext
2 Previous MNext Track Accept Reject
Changes - Comments - =
nments H,-r Ink Changes
iltered) B oa X |I| v | Insertions and Deletions e .
0 Moves: [} ~||¥| Eormatting
ats: 0 v | Markup &rea Highlight
™~
-] - |_Tz| Balloons L
Reviewers Bl Al Reviewers
- |[v| Highlight Updates |:| Elafid

c¢. Berpindah Antar Komentar

1. Pada tab Review, group Comment,
2. Klik Previous (sebelumnya) dan Next (selanjutnya) untuk berpindah antar komentar

i Mailings Review My Tab

Mew Deletell Previous MNext
Comment =

Comments

d. Mengedit Komentar

1. Tampilkan komentar pada panel Review atau Ballons
2. Lakukan editing teks dengan cara biasa

Hafid, 8/31/2012
a format that vou specify directlv. To commented:

[Page La}r{:rut'kab. To change the looks! __..——{i:umment [T1]= Lavout w
ymmand. Both the Themes gallery b’

e. Merespon Komentar

1. Tampilkan komentar pada panel Review atau Ballons
2. Klik pada area komentar, bisa di panel Review atau Ballons
3. Pada tab Review, group Comment, pilih New Comments
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Mailings Review My Tal

o |4 T3 A
Mew Delete Previous Mext

Comment
Comments

4. Masukkan komentar seperti cara sebelumnya

a format that you specify directly. To |

: Page Layout fab. To change the looks: - { Comment [T1]: Tavout halaman

____________________________

%J

ommand. Both the Themes gallery e { Comment [T2R1]: Menjelaskanlavout Page

)

estore the look of vour document to

f. Menghapus Komentar

1. Pada tab Review, group Comment,
2. Klik Delete

ings Review My Tab View Dev

faty B 30
= 2 sho

Delete |Previous Mext Track -
(4 Changes ~ .E Revi
_| &2 Delete n
isi K o
le Delete All Comments in Document N

2. Mencatat Perubahan Dokumen

Fitur ini memungkinkan kita mencatat semua perubahan pada dokumen.

= 'ﬂj Final: Show Markup v
= 2 show Markup ~
Track

Changes = g Reviewing Pane -

Tracking

a. Mengaktifkan Track Change

Agar semua perubahan tercatat, maka kita harus mengaktifkan fitur tracking.

Caranya:

1. Klik Icon Track Changes
2. Pilih Track Changes
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fj Final: Show Markup -
2 show Markup ~

Track
Changes ~ 2 Reviewing Pane ~

-

L 5¥ Track Changes

_ Change Tracking Options... '_
Change User Name... l

Contoh dokumen yang sedang ditracking

Summary: 5 revisions ﬂﬁx@_g:l;:%:

Insertions: 1 Deletions:1 Moves: 0 Formatting: 1

Comments: 2

[ Comment [T1] Th3Prof3550r |
Tahun matahari

| »

[ Comment [T2] Th3Prof3550r |
Bulan pertama B B Sk, Jsthsni il it sl diialiohonilet = gl = SRR

| Deleted Th3Prof3550r | i pada tanggal 1 Lllanuari 2012 akan
tahun

[ Formatted Th3Prof3550r |
Indent: Left: 0"

Inserted Th3Prof3550r |
akan

(none)

b. Menolak Atau Menerima Perubahan

@ @ @3 Previous
P} Next
Accept Reject

Changes

Fitur ini berfungsi untuk menerima atau menolak perubahan yang terjadi pada suatu naskah. Fitur
ini juga memungkinkan kita untuk bisa menerima sebagian perubahan dan menolak sebagian
perubahan yang lain atau sebaliknya.

3. Membandingkan Konten Dari Dua Dokumen

Fitur ini berfungsi untuk membandingkan atau menggabungkan konten dari dua versi naskah
tulisan. Ms Word akan otomatis menganalisa kedua naskah tersebut dan menampilkan asumsi
perubahan pada panel track changes
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wWd A 2 Cornpare Result S - Microsoft Word T | )|
Home  Insert  Pagelayout  References  Mailings = Review  View  Developer o @
’_i = ABC o * - = , B 92| Finak Show Markup - j” 4} Previous % 2
A = = g 5 ~ _,29, T w é»y # i E
ly LJ = J 123 ?) 2 —-ﬁ! —A —4| = [ show Markup - - == %) Next
Spelling & Research Thesaurus Word | Translate Language = New  Delete Previo ext Trackk =——— Accept Reject Compare  Block Restrict
Grammar - - Comment Changes - | [B] Reviewing Pane|~ - - - Luthors - Editing
Proofing Language Comments Tracking Changes Compare Pratect
Summary: 3 revisions & 2 x || Compared Document X | Original Document (Docl doc - Th3Prf3550r) x
Insertions: 2 Deletions: 1 Moves: 0 Formatting: 0 =] )
Comments: 0 . £ . =
. ||| Contoh Tulisan Kedua Contoh Tulisan %
Inserted Th3Prof3550r
On the Insert tab, the galleries include items that are designed to coordinate with the overall On the Insert tab, the galleries include items that are
Kedua look of your document. ¥ou can use these galleries to insert tables, headers, footers, lists designed to coordinate with the overall look of your
[Deleted Th3Prof3550r | cover pages, and other document building blocks. When you create pictures, charts, or document. You can use these galleries to insert tables,
You can easily change the formatting of selected diagrams, they also coordinate with your current document look. headers, footers, lists, cover pages, and other document
textin the document text by choosing a look for building blocks. When you create pictures, charts, or
| I change the £ £ selected taxtin the o + text by ch look
the selected text from the Quick Styles galleryon =1 e e o e s diagrams, they also coordinate with your current document 2
the Home tab. You can also format text directly e eeeRTremT HeTE o the H e N = look. o
by using the other controls on the Home tab. directly by usingthe-eth srelsoatheH tab-hosteontrelsoff b Fusing th i
Most controls offer a choice of using the look toakt th eth EaT Fthatyou spedify-directhy: Revised Document (Doc2.doc - TH3PH0£35501) x
from the current theme or using a format that " . . " -
Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. ]
you specify directly. . s " i N -
Fusce posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet
commodo magna eros quis urna. Contoh Tulisan Kedua
Inserted Th3Prof3ssor |-
Lorem ipsum dolor sit amet, consectetuer Munc viverra imperdiet enim. Fusce est. Vivamus a tellus.
adipiscing elit. Maecenas porttitor congue massa. On the Insert tab, the galleries include items thatare
Fusce posuere, magna sed pulvinar ultricies, Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis )| designed to coordinate with the overall look of your
purus lectus malesuada libero, sit amet commodo egestas. Proin pharetra nonummy pede. Mauris et orcl. document. You can use these galleries to insert tables,

magna eros quis urna. headers, footers, lists, cover pages, and other document

To change the overall look of your document, choose new Theme elements on the Page
building blocks. When you create pictures, charts, or

Nunc viverra imperdiet enim. Fusce est. Vivamus Layout tab. To change the looks available in the Quick Style gallery, use the Change Current . ) | 4
atellus. Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset ; diagrams, they also caordinate with your current document ;
commands so that you can always restore the look of your document to the original contained || look. 5

Bollamtacoin habiant mnrhibeictinn cannetor ot X
Words: 180 | <& Indonesian | Insert [ | | D @Rl = 100% (<) y! (+)
=

VII. BeKkerja dengan Formulir

1. Pendahuluan

Kata “Formulir” berasal dari bahasa Belanda yaitu formulier yang artinya adalah sebuah
kertas yang berisi beberapa pertanyaan formal yang harus diisi. Formulir sebenarnya merupakan
cara klasik yang biasa digunakan orang untuk mendapatkan informasi. Model formulir ini sering
kita jumpai ketika kita melakukan suatu pendaftaran atau registrasi, misalnya registrasi akun
rekening bank, registrasi diklat, dll. Seiring berkembangnya Teknologi Informasi dan Komputer,
bentuk formulir pun berevolusi dari bentuk manual (paper base) ke bentuk digital (computer
base). Sekarang kita bisa jumpai di Internet, ketika kita mendaftar website, email, atau jejaring
sosial lain maka formulir registrasinya menggunakan formulir digital.

Di era ini, penggunaan formulir digital tentunya akan lebih efisien dan efektif karena selain
lebih cepat dalam distribusi informasinya, juga lebih mudah dalam mengelolaanya. Microsoft Office
2010 (Word & Excel) yang merupakan aplikasi perkantoran populer, memiliki fitur yang bisa
digunakan untuk pembuatan dan pengelolaan formulir digital.

2. Mengenal Komponen Form/Formulir Dalam Ms Word 2010

Komponen form dalam Ms Word 2010 dapat kita jumpai pada menu ribbon tab developer.
Namun secara default, tab developer ini tidak ditampilkan. Untuk menampilkan tab ini, ikuti
langkah berikut:

1. Pada menu ribbon, pilih: File > Options > Customize Ribbon
2. Padajendela yang muncul
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3. Pilih Customize the Ribbon,
4. Centang checkbox Developer.

[ 9 - it : —
W A OA ol Opsons - . = SN S e s ‘&.n.
Mome ins = "
| By &5l Cusromae the Ribbon and keyboard shorauts
e Save Daptey P
I Lhease commands from: Cuitomize the Rgbsn:
H AT Prosfing Popoter Conmmends T}_ Main Tabs EJ
Sove
7 Open 3 Accept and Move to Next Main Tats -
| Language B Asgnten =¥ Meme ’
(o Close Advanced ¥ Seeats 4 Chpbaaed
= = gubets 5 # fort
J== iE = |
3 “E Change List Level ¥ shbes
Quack Accrts Toolar 23 Copy  tamng € [\
] aut # W Insen
Recent | d0ans * Oefine New Number Fosmat. % [V Page Layost ;’
Trust Center &) Oclete W [ References -
New j Deawr Tadle # Fi Malings M|
U8 Oraw Vertal Yest 820 # ¥ Review
g2 Caat # [ My Tab [Curtom)
Print ﬁ Fnd “BLE
Font I- AL OB - - |
A Fear 4 4 ¥ Ada s .
Save & Send A Font Color ’ tewTon | | tewGrows | | Rename..
Fomt Sie Ir = AR —— O
Customizations: | Rgset © |
Help KeyDoad shectonts: | Customize.. [y ——
[ 2} options . | 3 = al'
_a o ok Concet |
Komponen form terdapat pada group control
‘Bnces Mailings Review My Tab View Developer

Aa Aa [=] | & Design Mode
FElE: | P Properties
E [ @* EGrDup

Controls

E % Schema F

_] Transformation
Structure . i E
4| Expansion Packs | »,;

XML

Pada Ms Word 2010, ada 3 jenis komponen form (control) yang bisa digunakan untuk
membuat formulir,

out References
Aa Aa _é goeslgn Mode
8 A | F ropene
—% e @ o
F
_“.:,?,?_EE&E__ 2. Legacy Forms

ActiveX Controls

;T ﬁ ; i-;— 3. ActiveX Controls

Mailings

1. Content Control

=

Content Control : Komponen form dasar

Legacy Forms: Komponen form yang menggunakan validasi

3. ActiveX Control: Komponen form yang lebih advance menggunakan teknologi Microsoft
ActiveX

N
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Pada kesempatan ini, penulis hanya akan membahas tentang jenis komponen form pertama
yaitu content control yang merupakan jenis komponen form dasar. Namun tentu saja, hal ini
merupakan modal dasar bagi kita untuk kemudian mencoba jenis lain.

Berikut ini penjelasan tentang masing-masing komponen form yang termasuk dalam content
control:

RichText cocok untuk nama, NIP

Plain Text cocok untuk teks yang panjang (deskripsi, alamat)

Date Picker cocok untuk tanggal (tanggal lahir),

Check Box cocok untuk pilihan yang boleh lebih dari satu (hobby)

Dropdown list cocok untuk pilihan yang hanya boleh memilih satu (jenis kelamin)
Combobox hampir sama dengan Drowpdown List, hanya saja jika pilihan tidak ada dalam
list, maka user boleh menginputkannya sendiri (agama)

Lal ik ol o ol

out References Mailings

RichText dan PlainText ————— A3 Woaignmose __Combobox dan Dropdown list
Date Picker ——————————3 @ M@ S0 Check Box

Legacy Forms

abl 2 Bkl i 2

ActiveX Controls

FRAcWdS

HA=ing =%

3. Pembuatan Formulir

Setelah memahami fungsi dari masing-masing komponen form, sekarang penulis akan
membahas langkah-langkah dalam mendesain formulir.

1. Buatlah struktur form, untuk mempermudah bisa dengan menggunakan tabel tanpa border.

Formulir Registrasi Diklat
DTU Microsoft Office 2010 Tingkat Lanjutan

Nama

NIP

Jenis Kelamin

Tempat, Tanggal Lahir

2. Masukkan komponen form yang sesuai,
Pada field nama, pilih komponen RichText, kemudian klik Properties
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3 CAED | & properties ¢

7 [ @E- | & Group

Controls

Pada jendela Content Control Properties, atur properti dari RichText sebagai berikut:
Isi kolom “Title” dengan nama dan kolom “Tag” dengan nama, kemudian centang checkbox
“Content Control cannot be deleted”

Formulir Registrasi Diklat
DTU Microsoft Office 2010 Tingkat Lanjutan

| : nama |

Nama : nama| Click here to enter text. /Nama l
NIP J'Content Control Properties m
Jenis K General
Title: |nama
Tempat
Tag: |nama

Agama [7] Use a style to format contents
Style: |Default Paragraph Font

A New Style...
Locking
Content control cannot be deleted
[7] contents cannot be edited
Rich Text Properties

Remove content control when contents are edited

[ OK J l Cancel

w

Lakukan hal yang sama pada field NIP
4. Pada field jenis kelamin, masukkan komponen Dropdown List, kemudian klik properties,

atur propertinya sebagaimana contoh diatas.
Pada jendela content control properties masukkan opsi untuk jenis kelamin dengan cara
mengklik tombol “Add”, maka muncul jendela Add Choice, masukkan Pria, kemudian klik

tombol “Add lagi”, masukkan Wanita.
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General

Title:  Jenis Kelamin

Formulir Registrasi Diklat Tag:  Jeris Kelamin
DTU Microsoft Office 2010 Tingkat]| - %2 ® ereten=re

Style: | Default Paragraph.Eontlacd
-

4 tien 5oy, | Add Choice 2
Nama E namaiClick here to enter t4 | Locking Display Name: |wanita
. Content control can | Value: Wanita
NIP : NIP(Click here to enter tex [F] Contents cannot b
|
Jenis Kelamin B Choose an item. l Drop-Down List Fropertie ————
. Di: M, Val
Tempat, Tanggal Lahir ispiay Name e
Choose an item.
Pria Pria
Agama

5. Pada field tempat dan tanggal lahir, kita buat tanda koma (,) terlebih dahulu untuk
memisahkan antara field tempat dan field tanggal lahir

e

Tempat, Tanggal Lahir S

6. Letakkan kursor sebelum tanda koma, lalu masukkan komponen Richtext untuk field
tempat, kemudian atur propertinya seperti cara sebelumnya.

7. Letakkan kursor setelah tanda koma, lalu masukkan komponen Date Picker untuk field
tanggal lahir, kemudian atur propertinya sebagai berikut:

rContent Cantrol Properties 2

General
Title: |tanggal lahir
Tag: |tanggal lahir
[ use a style to format contents
Style: |Default Paragraph Fonit

Locking
Content control cannot be deleted
[] contents cannot be edited

I Date Picker Properties
LCisplay the date like this:
d-MMM-yy

/262012

Thursday, July 26, 2012
July 26, 2012

7f25[12

2012-07-26 [
26-Jul-12

7.20.2012

ul. 26, 12

Locale:

English (U.5.) [~]
=]

Lm | »

1

Calendar type:

Western

8. Pada field agama, masukkan komponen Combobox, kemudian Kklik properties, atur
propertinya sebagaimana contoh diatas.
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Pada jendela content control properties masukkan opsi untuk agama dengan cara mengklik
tombol “Add”, maka muncul jendela Add Choice, masukkan nama-nama agama, pada contoh
ini dimasukkan 5 agama yaitu Islam, Kristen, Katolik, Hindu, dan Budha. Karena jenis
komponennya Combobox maka user bisa mengetikkan sendiri agamanya jika tidak didapati
dalam opsi tersebut.

Content Control Properties 7

General

Tite: agama

la .|
-
5]

Tag: |agama
[7] use a style to format contents

Style: |Default Paragraph Font

iy Add Choice [

Locking Display Mame: g dha

Content control cannot be del Value: Budha
[7] contents cannot be edited

Drop-Down List Properties

Display Mame Value
Choose an item,

Izlam Islam
Kristen Kristen
Katolik Katolik
Hindu Hindu

[ OK ll Cancel l

9. Pada field hobi, untuk jenis hobi pertama yaitu “jalan-jalan” masukkan komponen
Combobox, kemudian klik properties, atur propertinya sebagaimana contoh diatas.
kemudian disebelah kanan checkbox tuliskan “Jalan-jalan”. Untuk jenis hobi kedua juga
demikian, dst.

jalan-jalan | [ jalan-jalan) jalan-jalan

Hobi

olahraga | [ jolahraga) Olahraga

Setelah langkah-langkah diatas kita lakukan maka jadilah sebuah formulir registrasi
sederhana. Mudah bukan? Tapi ini belum selesai.

Sebagaimana layaknya form digital, kita akan menambahkan sebuah tombol simpan yang
fungsinya melakukan penyimpanan formulir dokumen tersebut. Jadi setelah user mengisi formulir
maka user akan menjumpai tombol penyimpanan yang mana kita sekenariokan agar formulir
tersebut tersimpan dengan nama file sebagaimana data yang diinputkan oleh user yaitu NIP, misal:
198604302009011002.docx, tujuannya agar nama file formulir hasil inputan user unik, sehingga
memudahkan dalam pengelolaan data selanjutnya.

Untuk melakukannya kita memerlukan kode-kode macro / Visual Basic Application (VBA)
yang akan kita asosiasikan pada sebuah tombol / button simpan. Berikut ini langkah-langkahnya:
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1. Tambahkan tombol Simpan dengan cara klik tab Developer, pilih komponen button pada
ActiveX Control sebagaimana yang ditunjukkan pada gambar dibawah ini.
eq| Wor ‘
rences Mailings Review My Tab View Developer
Aa Aa 5] E &5 Schema £
_ﬁ |_‘E |:| | Ig'Propler‘cies %] Transfarmation o
;0 18] Group Suture 4 Expansion Packs :_uEilr';

Legacy Forms | XML |
S abl P A Qs e [E[EC 67
" ActiveX Controls
FEAGES

St si Diklat

Command Button (ActiveX Control) lCE 2 0 1 0

Insert a command button control.

jalan-jalan | [ jalan-jalan Jalan-jalan
olahraga | [] jolahmga) Qlahraga

2. Atur property dari button tersebut, dengan cara mengklik Properties. Ubah captionya
menjadi “Simpan”

Properties E
|CnmmandB||ttun1 CommandButton |
Alphabetic I Categorized
(Mame) CommandButton1
Accelerator
AutoSize False
BackColor [] aH3000000F&
1 - fmBackStyleCpague
Simpan
Enabled True
Font Calibri
Frrarnlar W =HRANNNN1 75
Hobhi H _ FEmAaS

olahraga | [] | olahraga Qlahraga

Page 162 of 187



IImuKomputer Com

3. Double klik tombol Simpan tersebut, maka kita akan dibawa ke jendela code explorer Ms

Visual Basic for Application
E Microsoft Visual Basic for Applications - Formulir Registrasi Diklat [dESIgI‘i]

e | [ e

Eile Edit View Inset Format Debug PRun  Teols Add-Ins Window Help
@"H FOREE RN SN Bl J% A @ .
Project - Project x|
E = Ca _ 4 Forrnulir Registrasi Diklat - ThisDocument (Code) EI@
B ‘ﬁ Normal |Command5utton1 ﬂ |Click j
| H-[11 Microsoft Word Objects —
E‘ ‘ﬁ Project (Formulir Regist Priwvate Sub CommandButtonl Click()
= @ Microsoft Word Objects —
@ThlsDocument
- End Sub
=- @ References ™
: ﬁ Reference to Mormal
E @ Project (Hafid-formulir_
B @ Microsoft Word Objects
@ ThisDocument
I -[77] References
== a1 B
I b

4. Masukkan kode VBA yang fungsinya adalah melakukan penyimpanan “Save As” formulir
tersebut dengan nama file sama dengan teks pada field NIP.

Algoritma sederhananya adalah :

a.
b.

Mulai

Makro Ms Word akan melakukan pencarian Content Control (komponen form) yang
memiliki title NIP.

Jika Content Control dengan title NIP ditemukan maka akan dilakukan pengecekan
apakah teks isian field NIP kosong atau tidak,

Jika teks isian field NIP kosong atau ada teks “Click here to enter text.” berarti user
belum mengisi field NIP. Maka akan ditampilkan pesan yang menginformasikan kepada
user bahwa field NIP harus diisi.

Jika teks isian field NIP tidak kosong alias telah diisi oleh user maka akan dilakukan
penyimpanan formulir (Save As) dengan nama file sama dengan teks isian field NIP
Kemudian ditampilkan pesan yang menginformasikan pada user bahwa formulir telah
disimpan.

Formulir ditutup.

Selesai
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ﬁn cc As ContentControl
Dim filename As String

Private Sub CommandButton1_Click()
For Each cc In ActiveDocument.ContentControls
If cc.Title = "NIP" Then
filename = cc.Range.Text
If filename = Empty Or filename = "Click here to enter text." Then
MsgBox ("NIP harus diisi!")
Else
ActiveDocument.SaveAs2 filename:=filename & ".docx", _
FileFormat:=wdFormatXMLDocument, CompatibilityMode:=14
MsgBox ("File telah disimpan dengan nama " & filename & ".docx!")
ActiveDocument.Close
End If
End If

Next /

Berikut ini kode lengkap VBAnya

4. Pengaturan Hak Akses Formulir

Sebelum menyebarkan formulir ke user, ada satu hal lagi yang harus kita lakukan yaitu
mengatur hak akses formulir tersebut dengan kata lain membatasi akses agar user hanya bisa
melakukan pengisian data formulir saja, tidak lebih.

Hal ini bisa kita lakukan dengan memanfaatkan salah satu fitur Ms Word yaitu Restrict
Editing. Berikut ini langkah-langkahnya:

1. Pada tab Developer, pilih Restrict Editing

View Developer

jg Sc-hen.m - r ﬁ E g?:‘#

] Transformatio
Restrict) | Document Document

m

b .

&| Expansion Packs | authors - Editing | Template  Panel

XML Protect Templates
"6 71 & 14 Restrict Editing i

Restrict how people edit or format
specific parts of the document.

trasi Diklat You can prevent formatting

changes, force all changes to be
Office 2010 Ti| wnmening "

0 Press F1 for more help.

2. Maka akan muncul panel Restrict Editing disebelah kanan.
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Restrict Formatting and Editing v
1. Formatting restrictions

| Limit formatting to a selection ¢
styles

Settings...
2. Editing restrictions

|| Allow only this type of editing i
the document:

No changes (Read only)

3. Pada bagian pertama “Formatting restrictions”. Centang checkbox agar user tidak bisa

melakukan styling.
4. Pada bagian ke dua “Editing restrictions”, centang checkbox “Allow only this type of editing
in the document:”, lalu pada combobox, pilih opsi Filling in Forms

Restrict Formatting and Editing
1. Formatting restrictions

Limit formatting to a selection ¢
styles

Settings...

2. Editing restrictions
Allow only this type of editing i
the document:

Filling in forms IZ|

3. Start enforcement

Are you ready to apply these
settings? (You can turn them off
later)

[ Yes, Start Enforcing Protection

5. Klik tombol “Yes, Start Enforcing Protection”. Masukkan password.

-
Start Enforcing Protection &8 = M

Protection method

(@ Password
(The document is not encrypted. Malidous users can edit the
file and remove the password.)

Enter new password (optional): |«
Reenter password to confirm: |e

User authentication

(Authenticated owners can remove document protection. The
document is encrypted and Restricted Access is enabled.)

[ (04 J [ Cancel

e ———

6. Kilik OK, selesai.
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Langkah terakhir, simpan formulir dokumen ke dalam format Word Macro-Enabled
Document.

F ™
(W] Save As t ﬂ
s
OU?| .« My Docurments ¢ Ilmu Komputer - |<F, | | Search limu Komputer pel |
Organize = MNew folder = - @
Bl Desktop i Mame Date modified Type
4 Downloads - i . . _ . .
. - | -.Serulir Registrasi Diklat.decm 7/25/2012 8:25 AM Microsoft
| Recent Places . . L _ _ )
] Formulir Registrasi Diklat.docm 7/25/2012 9:37 AM Microsoft
o Libraries
@ Documents
J’ Music
[ Pictures
B videns | < [ il C
SN, BT SRR ormulir Registrasi Diklat.docm| -
Save as type: [Word Macro-Enabled Document (*.docm) -
Authors: Hafid Tags: Add atag
[ Save Thumbnail
=« Hide Folders Tools - [ Save ] ’ Cancel
| %

Formulir siap di distribusikan, bisa melalui email, website, file sharing, ftp dan sebagainya.

@Ov| ., ¥ Libraries » Documents » Ilrmu Komputer » Formulir

Organize - Share with = Burn Mew folder
%t Favorites Documents library
B Desktop Formulir

& Downloads Mame

12| Recent Places
@) Formulir Registrasi Diklat.docm

- Libraries
@ Documents
i WY

5. Pengisian Data Formulir

Untuk melakukan pengisian data pada formulir tersebut, user cukup dengan membuka file
tersebut menggunakan Ms Word 2010 pada komputer masing masing.
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-
MW EH9-0 A+ Formulir-Registrasi-Diklat.docm - Microsoft Word ‘ Table T... | l = | & g
Home | Insert  Page Layout  References Mailings Review MyTab View Developer Design Layout &3 e

B T CJEETEE AM (e
- Bg B 7 U -abe x, ¥ | & = | 4= e T
Paste . g Quick Change ting
- B - A-Aa-| A A | B AN Styles - Stylesv |~
Clipboard | Font | Paragraph | Styles | |
y Security Warning  Some active content has been disabled. Click for more details, | Enable Content | X
— = =
__-_J| -|$|-|-1_-|-2-|-3-|-4-|$||$)u§|-6-:-?-l-ls-l-gl-l-l.o-ll-l.l.-|I-]_2-|-I13-|-1_4I-|-/@-|- m
Y
: Formulir Registrasi Diklat
. DTU Microsoft Office 2010 Tingkat Lanjutan
= E
N Nama 3 [ nama| Click here to enter text. /nama l
z NIP : NIP(Click here to enter text. /NIP
H Jenis Kelamin H Jenis Kelamin| Choose an itemn. | Jenis Kelamin
) i tempat | Click here to enter text. /tempat) | | tanggal lahir | C|jck
- Tempat, Tanggal Lahir
-] here to enter a date./tanagal lahir
- Agama : agama| Choose an item. 3dama
[ jalan-jalan ([ jalan-iElan) Jalan-jalan
: Hobi !
N olahraga | [ olahraga) Olahraga
— i
T +
- . o
E Simpan | T
Ll [ Il | 3
Page:lofl Lined | Words:5/56 | o6 English (US) | Inset 3 | |I£ B = = 110% (— +)

Karena berisi macro/VBA, maka Ms Word secara otomatis ketika pertama kali dibuka akan
menampilkan formulir secara protected view, user tinggal mengklik tombol Enable Content warna
kuning. Berikut ini contoh formulir yang telah diisi

Formulir Registrasi Diklat
DTU Microsoft Office 2010 Tingkat Lar

Nama : - | Made Agus Darmaputra
NIP 1 : 198507282004121004
Jenis Kelamin 1 Pria

Tempat, Tanggal Lahir : : Bali, 28-Jul-85

Agama : Eindu [~

B Jalan-jalan
O oOlahraga

Hobi

Simpan |
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Langkah selanjutnya klik tombol simpan, maka akan muncul pesan

' ~
Microsoft Word [

File telah disimpan dengan nama 198507282004121004. docx!

Maka formulir akan otomatis tersimpan dengan nama teks isian NIP, lalu klik OK. Maka file
formulir hasil isian user tersebut siap untuk di kirim balik ke panitia diklat.

@©v| . v Libraries » Documents » Ilmu Komputer » Formulir

Organize * Share with = Burn Mew folder
't Favorites Documents library
B Deskiop Formulir

4 Downloads Mame

5 Recent Places
) Formulir-Registrasi-Diklat.docm

=3 Libraries [#] 1985072820041 21004.docx

File tersebut terletak dalam satu folder dengan file formulir aslinya.

6. Pengelolaan Data Formulir

Setelah formulir diisi oleh user dan dikirimkan balik kepada kita atau panitia diklat maka
langkah selanjutnya adalah mengelola data pada masing-masing formulir tersebut. Dalam hal ini
kita akan masukkan data pada masing-masing formulir kedalam sebuah tabel (Ms Excel 2010)
sehingga mudah dalam pengelolaanya.

Berikut ini contoh file formulir yang telah diisi oleh user.

ilv| . v Libraries » Docurments » Ilmu Komputer » Data Peserta
e - Share with = Burn Mew folder

vorites Documents library

Jesktop Data Peserta

Jownloads Mame

lecent Places

] 199002222010122001.decx
(] 198604302009011002.decx
(&l 1985072820041 21004.decx

raries

Inruments
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Secara manual yang bisa kita lakukan adalah membuka setiap file formulir, kemudian
menulis ulang datanya kedalam sebuah tabel. Jika hal ini yang dilakukan tentu akan membutuhkan
waktu yang lama terutama jika jumlah user banyak disamping itu juga dimungkinkan terjadi
kesalahan input.

Oleh karena itu, kita perlu memanfaatkan komputer dalam hal ini Ms Excel untuk membaca
data dari masing-masing file formulir tersebut kedalam sebuah tabel supaya pengelolaannya lebih
cepat dan efisien. Ya.. sekali lagi kita akan menggunakan macro / VBA.

Berikut ini langkah-langkahnya:

1. Buat dokumen Ms Excel, lalu save ke dalam format Macro-Enabled Workbook (*.xIsm)

r ~a > 3
[X] Save As ﬁ
L — . -
@Uv| % llmu Komputer » Data Peserta - | g | | Search Data Peserta L2 |
Organize = MNew folder 4= - .@.
- -
o
(3] Microsoft Excel Documents library Amange by: Folder ~
Data Peserta
- Favorites e
Bl Desktop
& Downloads No itemns match your search.
1= Recent Places
- Libraries
=y e—— i li C
File name: Data Formulir'Jser.xIsm -
Save as type: [Excel Macro-Enabled Workbook (*axdsm) -
Authors:|Hafid | Tags: Add atag
[ Save Thumbnail
4 Hide Folders Tools Save l ’ Cancel
h

2. Buatlah header tabel sesuai kelomBok data yang ada dalam formulir
IE| H9-c h Data Formulir User.xlsm - Microsoft

L.

Home Insert Page Layout Formulas Data Review View Developer
j # Cut Calibri Tl AN == =) Wrap Text General -
pant 53 Copy ™ By A 0 .00
aste - - - - == = = - 8 <0 .
-  Format Painter B /7 U H =Y = = =24 Merge & Center $ Yo * | %0 508
Clipboard ] Font Fl Alignment ] Number P
5 - 5
A B C D E F G H
Jenis . . . .
Mama NIP Kelami Tempat Lahir | Tanggal Lahir| Agama Hobil Hobi2
elamin

W |
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3. Masukkan sebuah tombol / button yang akan digunakan sebagai trigger dieksekusinya
script macro. Caranya pada tab developer, pilih button di pojok kiri atas, lalu arahkan
kursor ke area kerja

mulas Data Review View Developer

M % Properties E &y
== ] View Code <
Insert |Design Source

dd-Ins Mode '8 Run Dialog ‘o
ns Form Controls

af¥ gEe
i [ A« & abl 26 CHF E

- ActiveX Controls
i P = B |Lahir Agama
HoAdRR%

erxism - MICrosoft Excel —

| Drawing Tools |

Data Review View Developer Format
|'\‘E'1 M [ Properties E 3.[ Map Properties :'ﬂlmport aﬁ
N | T & View Code 2 Expansion Packs :-JExp-:ult &
Insert |Design i Source . Document
- Mode # Run Dialog “§ Refresh Data Panel
Controls MML Modify

ms.CommandButton.1","")

D E F G H | ]

‘empat Lahir | Tanggal Lahir

Agama Hobil Hobi2
CommandButton:

——

4. Klik kanan button yang baru dibuat, pilih properties, kemudian atur properti captionnya:

J CommandButtnn®
Cut

Lopy
FPaste
Properties

View Code

AR B &=

CommandButton Object *
Grouping 3
Order ]

&

Format Contral...
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m Ll
Properties @ Document
| Panel
| CommandButton1 CommandButton - Modify
: Alphabetic | Categorized
A |Name) CommandButton
A | [Accelerator U L
AutoLoad Falze Ti } )
AutoSize False Baca Data Formulir
| [packcolor [] aHa000000F& I
BackStyle 1 - fmBackStyleCpaque i - 8
Enabled True
Font Calibri
ForeColor B =H300000128
Height 30

5. Double klik tombol tersebut, maka kita akan dibawa ke jendela code explorer Ms Visual

Basic for Application
a Microsoft Visual Basic for Applications - Data Formulir Userxism [design] T

File Edit View Inset Format Debug Run  JTools Add-Ins  Window Help

EME-3 4 2 44 9 P o & S A S e @ | Ln2 Coll

Project - VBAProject ﬂ y
=NENF = £ Data Formulir Userxlsm - Sheetl (Code) E\@
E-&% VBAProject (Data Formu |Commandﬂuﬂon1 ﬂ |Click j

-5 Microsoft Excel Objects
i..fH] Sheet1 (Sheet1)

| Sheet2 (Sheet2)

: | Sheet3 (Sheet3)

.38 Thisworkbook

Priwvate Sub CommandButtonl Click()

s

End Sub

N By

5. Masukkan kode VBA yang fungsinya adalah membaca file formulir yang telah diisi oleh user
kemudian memasukkan data tersebut dalam sebuah tabel.

Algoritma sederhananya adalah :

a.
b.

Mulai

Posisi kursor/ Current Cell (Cell saat ini) diletakkan pada kolom pertama baris kedua
Worksheet Ms Excel.

Macro Ms Excel akan membuka setiap file Ms Word dalam folder formulir

Pada setiap file Ms Word yang dibuka tersebut, Macro akan membaca setiap field
Content Control

Jika Content Controlnya bertipe checkbox maka akan ada pengecekan apakah checkbox
tersebut pada kondisi dicentang/dipilih atau tidak. Jika pada kondisi dicentang maka
current cell akan diisi dengan title dari checkbox, jika tidak maka current cell akan diisi
“-“. Kemudian posisi kolom ditambah 1 (agar pengisian selanjutnya, pindah ke cell
sebelah kanannya)

Jika Content Control tidak bertipe checkbox, maka current cell diisi dengan text isian
dari user. Kemudian posisi kolom ditambah 1

Setelah selesai membaca satu file Ms Word, sebelum beralih ke file selanjutnya, maka
posisi kolom dikembalikan ke 1 dan baris ditambahkan 1.

Selesai
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Berikut ini kode lengkap VBAnya

/ Dim fso As Scripting.FileSystemObject
Dim Folder As Scripting.Folder

Dim File As Scripting.File

Dim WordApp As Word.Application
Dim WordDoc As Word.Document
Dim CC As ContentControl

Dim Row As Integer
Dim Column As Integer
Dim Text As String

Private Sub CommandButton1_Click()
Column =1
Row = 2 'ActiveSheet.UsedRange.Rows.Count + 1
Set fso = New Scripting.FileSystemObject
Set Folder = fso.GetFolder(ActiveWorkbook.Path & "/formulir")
Set WordApp = New Word.Application
WordApp.Visible = True

For Each File In Folder.Files
WordApp.Documents.Open (File)
Set WordDoc = WordApp.ActiveDocument

For Each CC In WordApp.Documents(WordDoc).ContentControls
ThisWorkbook.Activate
Cells(Row, Column).Select
' CC Type 8 is Checkbox
If CC.Type = 8 Then
If CC.Checked = True Then
Text = CC.Title
Else
Text="-"
End If
ActiveCell.Value = Text
Column = Column + 1
Else
If IsNumeric(CC.Range.Text) Then
ActiveCell.Value ="" & CC.Range.Text
Else
ActiveCell.Value = CC.Range.Text
End If
Column = Column + 1
End If

Next

Column =1

Row = Row + 1

WordApp.ActiveDocument.Close
Next

WAvd A nn Nt /

6. Kembali ke Worksheet Excel, klik tombol “Baca Data Formulir”
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E F G H I J K

Tanggal Lahir Agama ‘ Hobil ‘ Hobi2

Baca Data Formulir

Maka akan muncul error, yang dikarenakan kode macro yang digunakan merujuk ke library
tertentu dan library tersebut tidak ditemukan.
Microsoft Visual Basic for Applications ﬁ-‘

I Compile erron:

User-defined type not defined

oK | Help |

Untuk mengatasi hal itu, caranya: Pada Tab Developer, pilih View Code untuk masuk ke
Code Explorer Ms Visual Basic for Application:

T Data Formulirad

a Review View Developer

N I Properties
% Q’—‘View Code

Design
Mode 1B Run Dialog

Controls

-

=

View Code

(w)

Edit the Visual Basic code fora
control.

Tempat

9 Press F1 for more help.

Pada Code Explorer Ms VBA, pilih menu Tools | References..

ormulir.xlsm __—

Bun | Tocls | Add-Ins  Window Help
iTRF | E'  References... ol 42

Additional Controls...

Macros...

Dptions...
—— VBAProject Properties...
& Da Digital Signature...

IEME ral] =

Checklist library / referensi berikut: Microsoft Forms 2.0 Object Library, Microsoft Scripting
Runtime, Microsoft Word 14.0 Object Library, Microsoft Office 14.0 Object Library, OLE
Automation, Microsoft Excel 14.0 Object Library, Visual Basic For Application
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Available References:

Visual Basic For Applications - Cancel |
Microsoft Excel 14.0 Object Library K|
OLE Automation —
Microsoft Office 14.0 Object Library Browse... |
Microsoft Forms 2.0 Object Library
Microsoft Scripting Runtime ﬂ
i Microsoft Word 14.0 Obiect Library
[] AccessibilityCpladmin 1.0 Type Library Priority
[ ] Acrobat Access 3.0 Type Library Help |
[] AcroBrokerLib ﬂ
[] AcroIEHelper 1.0 Type Library

["] AcroIEHelperShim 1.0 Type Library

[] Active DS Type Library

[ ArtiveMowie contral tune library

< | n | F

—Microsoft Word 14.0 Object Library

Location:  C:'Program Files\Microsoft Office\Office 1\MSWORD. OLB
Language: Standard

Klik OK, dan close Code Explorer.

7. Kembali ke Worksheet Excel, klik tombol “Baca Data Formulir”

L2 - I
A B C D E F G H 1 1 |
lenis . . . -
Nama ‘ NIP lami Tempat Lahir| Tanggal Lahir | Agama| Hobil Hobhi2
| SEITL Baca Data Formulir
Hasilnya:
A B C 1] E F G H I ]
lenis . . . -
Nama ‘ NIP lami Tempat Lahir| Tanggal Lahir [Agama| Hobil Hohi2
- LT Baca Data Formulir
| Made Agus Darmaputra 19850728200412100 Pria Bali 28-Jul-85 Hindu - olahraga
Hafid Mukhlasin "19860430200901100 Pria Jember 30-Apr-86 Islam jalan-jalan -
Fatmawati Aditya Febrita "195900222201012200 Wanita Palembang 22-Feb-90 Islam jalan-jalan -
8. Selesai.

Setelah data formulir isian user terekap pada sebuah tabel, maka pengelolaan selanjutnya
akan lebih mudah lagi.

VIII. Proteksi Dokumen

Pada bagian ini akan dibahas tentang proteksi dokumen yang meliputi:
1. Mekanisme Proteksi Ms Office 2010

Office memiliki mekanisme proteksi dokumen terhadap program-program jahat yaitu Protected
View

2. Pembatasan Hak Akses Dokumen

Page 174 of 187



Kita juga bisa membatasi hak akses seperti untuk membuka atau mengedit dokumen, baik dengan
menggunakan password maupun tidak (tergantung kebutuhan).

1. Protected View

File-file dokumen dari Internet dan dari sumber lain yang berpotensi tidak aman dapat berisi virus,
worms, dan malware lain yang mana bisa membahayan komputer. Untuk melindungi komputer, Ms
Office akan membuka file-file dokumen tesebut dalam mode aman / terproteksi (Protected View).
Pada mode ini, kita hanya akan bisa membaca dan melihat konten tanpa khawatir terkena risiko.

' _‘__ ' | it ) Editing

4 W A-Aa | AW | O-EH- (8T -
Clipboard Font Paragraph Styles
o Protected View  This file originated from am Internet location and might be unsafe. Click for more details. Enable Editing
i'-| :1.......1...|...5.......1...|...2...|...3...|...4...c'b...
=

a. File Protected View

File dokumen dengan ketentuan berikut ini akan terbuka secara protected view oleh Ms Word:

» Files dokumen dari Internet atau dari lokasi yang berpotensi tidak aman lainnya dapat
berisi virus, worm atau malware yang bisa membahayakan komputer.
» File berisi Macro, Data Conection, File terdapat Error, juga akan dibuka di Protected View

b. Mengedit File Protected View

Jika kita yakin bahwa file dokumen tersebut aman, untuk mengaktifkan fungsi editing adalah
dengan cara:

1. Pada Message Bar, klik Enable Editing. Atau
2. Pada menu Ribbon, klik Tab File > Info > Edit Anyway.

— "_-—
W] = < Y= Benson.docx (Prote
Home My Tab Insert Page Layout References Mailings Review View Deve

H Save
Save As

ﬁ Open
Lj Close )
Protected View
}’ This file originated from an Internet location and might be unsafe.
. T You should only enable editing if you trust the contents of the file.
nable
Recent Editing

Information about Benson
ChUsershuser\AppDatat\Local\Temp\Templ_Unit_1_Data_Files.zip\Unit_1_Data_Files\Lesso

Protected View Settings

Learn more about Protected View
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2. Menandai Dokumen Sebagai Final

Sebelum mendistribusikan dokumen ke orang lain, kita bisa menandai dokumen kita tersebut
sebagai final dokumen. Tujuannya adalah untuk mencegah orang lain merubah dokumen tersebut.
Dokumen yang telah ditandai sebagai dokumen final memiliki ciri-ciri sebagai berikut:

>

>
>
>

Dokumen readonly (hanya bisa dibaca dan tidak bisa diedit) serta beberapa tombol di menu
ribbon akan dinonaktifkan,

Muncul banner bertuliskan “Marked As Final” pada bagian atas dokumen,

Pada bagian Backstage view terdapat informasi bahwa dokumen ditandai sebagai final.
Pada status bar muncul icon Marked As Final.

Tanpa mengahpus tanda final tersebut maka seseorang tidak akan bisa melakukan perubahan pada
dokumen.

a. Cara menandai dokumen sebagai final

1.

Pada Backstage view (tab File), klik tombol Protect Document dan klik Mark as Final.

B Permissions
E3] ?J Anyone can epen, copy, and change any part of this document.

e

Protect
Document +

Mark as Final
Let readers know the document is final
and make it read-only.

Encrypt with Password that it contains:

Eig
a)
._131; Require a password to open this ir's name and related dates

document.

Restrict Editing den text

Control what types of changes people
can make to this document.
sabilities are unable to read
Restrict Permission by People
Grant people access while removing 4
their ability to edit, copy, or print.

Ensure the integrity of the document ave)
by adding an invisible digital signature.

- —

5
LS
§ Add a Digital Signature

vE)

Pada kotak dialog Microsoft Word, klik OK maka file akan di tandai sebagai final dan
disimpan.

Microsoft Word [

I ki This document will be marked as final and then saved.

l OK[\YI [Cancel] [ Help ]

1§

Kemudian akan muncul konfirmasi yang menginformasikan bahwa dokumen telah ditandai
sebagai final, klik OK.
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T
Microsoft Word E

. This document has been marked as final to indicate that editing is complete and that this is the final version of the document.

W' When a documentis marked as final, the status property is set to "Final” and typing, editing commands, and proofing marks are turned off.
Yfou can recognize that a document is marked as final when the Mark As Final icon displays in the status bar.

[7] Don't show this message again

b. Cara menghapus tanda final pada dokumen

1. Padabanner Marked as Final yang terletak di atas dokumen, klik tombol Edit Anyway.

Home Insert Page Layout References Mailings Review My Tab View Developer & e
¥ -1 - iz = = it _ 24
E| B 7 U -abe x, x° | & E N iEd_t_
Paste P Quick Change Ing
e W A-pa (A D ‘l Styles - Styles -
Clipboard = Font Paragraph Styles
o Marked as Final An author has marked this document as final to discourage editing. Edit Anyway | x
— = [ =
E||-|-|-L)§|- '|'3'|'4'|'5'|'6'|'?'|'8'|'9'l'].0'l'].].'I'LZ'I"I‘J'I'H\'I'IS'I'].G'IPQ

Y
- h] Cara menghapus tanda final pada dokumen ]
o 1. Pada banner Marked as Final yang terletak di atas dokumen, klik Edlt
- Anyway. E

2. Atau pada Backstage view, klik tombol Protect Document dan klik Mark as Final.

Permissions
@ This document has been marked as final to discourage editing.

Sy
Protect
Document -

e Mark as Final
Let readers know the document is final

and make it read-only.%

r that it contains:
t ir's name and related dates

3. Tanda Tangan Digital

Word memungkinkan kita membubuhkan tanda tangan digital ke dalam dokumen kita. Sebuah
dokumen yang telah ditanda tangani berarti dokumen tersebut sudah tidak bisa lagi diubah, jika
dipaksa maka tanda tangan tersebut akan hilang dari dokumen.

Word memang tidak menggaransi bahwa dokumen yang telah ditanda tangani akan benar-benar
aman dari perubahan. Hal ini sebenarnya sama saja dengan tanda tangan tinta (manual), apakah
aman dari pemalsuan??

a. Membuat Tempat Tanda Tangan

Caranya: pada tab Insert, pilih Signature Line.
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Microsoft Office digital signatures combine the familiarity of a paper signing experience with the convenience of a digital format. While this feature provides users with the

ability to verify a document’s integrity, evidentiary laws may vary by jurisdiction. Microsoft thus cannot warrant a digital signature's legal enforceability, The third-party
digital signature service providers available from the Office marketplace may offer other levels of digital signature assurance.

[ Don't show this message again

[ Signature Services from the Office Marketplace... ] ’ Ok ]

Word menawarkan jasa tanda tangan digital yang lebih aman melalui Office Marketplace. Namun
pada tutorial ini kita tidak akan membahas sampai kesana. Melainkan menggunakan tanda tangan
digital dengan menggunakan file gambar dikomputer. Pada jendela konfirmasi klik OK.

Maka akan muncul jendela Signature Setup.

Signature Setup @

Suggested signer (for example, John Doe):
Budi Sudarsonal

P

Suggested signer's title (for example, Manager):
Manajer Personalia

Suggested signer's e-mail address;

XXX @YYY.com

Instructions to the signer:

Before signing this document, verify that the content you
are signing is correct.

[] allow the signer to add comments in the Sign dialog
Show sign date in signature line

[ K ] [ Cancel

Masukkan nama dan informasi penanda tangan lalu klik OK, hasilnya sbb:

X

Budi Sudarsono
Manajer Personalia

b. Menandatangani Dokumen

Untuk menandatangani dokumen, silahkan klik tanda X pada tempat tanda tangan. Klik OK pada
jendela konfirmasi.
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o See additional information about what you are signing. ..

Sign @

Before signing this document, verify that the content you are signing is correct.

Type your name below, or dick Select Image to select a picture to use as your
signature:

‘ Select Image. ..

X

Budi Sudarsono
Manajer Personalia

Signing as:  Th3PrOf3550r

s}

Cancel

Klik Select Image untuk memilih gambar tanda tangan kita.

Sign @

o See additional information about what you are signing. ..

Before signing this document, verify that the content you are signing is correct.

Type your name below, or dick Select Image to select a picture to use as your
signature:

X A

Budi Sudarsono
Manajer Personalia
Signed by: Th3PrOf3550r

Signing &s:  Th3Prof3550r

Sign ][ Cancel ]

Klik tombol Sign

I

Signature Confirmation

[ Don't show this message again

(=]

Your signature has been successfully saved with this document.
If the document is changed, your signature will become invalid.

-

Selesai
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| = A Ty | T — S -

Home Insert Page Layout References Pailings Review My Tab View
o Marked as Final An author has marked this document as final to discourage editing. Edit Anyway
|1|J (TS SRR SRS SRR NS NN TR TN NN SRS TR EE- TN RS T
| | 1 1 1 [ 1 - ! 1 1 - 1

i 11/18/2012

Budi Sudarsono

_ Manajer Personalia
@ Signed by: Th3PrOf3550r

Dokumen akan terproteksi sebagai final dokumen.

Pertanyaan yang umum ditanyakan: “Bagaimana menghilangkan tanda X??” ©

4, Membatasi Pemformatan Dokumen

Adakalanya kita ingin mencegah seseorang (atau bahkan diri kita sendiri) dari pengeditan format
dokumen, salah satu tujuannya adalah agar format dokumen tersebut tidak berubah namun teks
atau konten lain tetap bisa diedit. Disini kita bisa membatasi style format apa saja yang masih bisa
digunakan dan tidak bisa digunakan.

Caranya:

a. Langkah-langkah membatasi pemformatan dokumen

1. Pada tab Review, group Protect, klik tombol Restrict Editing.
atau

2. Pada Backstage view, klik tombol Protect Document dan klik Restrict Editing.

3. Pada panel Restrict Formatting and Editing, bagian Formatting restrictions, Pilih (centang)
check box Limit formatting to a selection of styles, dan kemudian klik Settings.

] Restrict Formatting and Editing
1. Formatting restrictions

Limit formatting to a selection
styles

Settings...
2. Editin;_: restrictions

Allow only this type of editing
the document:

4. Padajendela Formatting Restrictions, lakukan salah satu berikut ini kemudian klik OK:

Page 180 of 187



' ™
Formatting Restrictions m

Styles
[]:Limit formatting to a selection of styles:

By restricting formatting to the styles you select, you prevent the ability to
medify styles and the ability to apply direct formatting to the document.
Select the styles you want to allow to be used in this document.

Checked styles are currently allowed:
-
1fafi I_l
apple-converted-space i
Artidle f Section

Balloon Text (recommended)

Bibliography {recommended)

Block Text (recommended)

Body Text {recommended)

Body Text 2 (recommended) -
’ All ] ’ Recommended Minimum ] ’ Maone
Formatting

[] Allow AutoFormat to override formatting restrictions
[ Block Theme or Scheme switching
[ Block Quidk Style Set switching

[ OK ][ Cancel l

h

Hilangkan centang dari styles yang diperbolehkan untuk diaplikasi pada dokumen.
Klik tombol None, dan kemudian centang style yang ingin kamu blok dari dokumen.

5. Pada bagian Start enforcement, klik tombol Yes, Start Enforcing Protection.

3. Start enforcement

Are you ready to apply these
settings? (You can turn them off
later)

[ Yes, SmrtrgnFordng Protection
|

6. Pada kotak dialog Start Enforcing Protection, kita bisa memasukkan password
(opsional) untuk mencegah orang lain menghilangkang proteksi ini. Lalu klik OK

-
Start Enforcing Protection M

Protection method
@ Password

(The document is not encrypted. Malicious users can edit the
file and remaove the password.)

Enter new password (optional):
Reenter password to confirm:

User authentication

(Authenticated owners can remove document protection. The
document is encrypted and Restricted Access is enabled.)

Ok ] [ Cancel

b. Langkah-langkah menghilangkan pembatasan pemformatan dokumen

1. Pada tab Review, group Protect, klik tombol Restrict Editing.
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Restrict Formatting and Editing * X
Your permissions

This document is protected from
unintentional editing.

You may editin this region, but all
changes will be tracked.

You may format text only with certain

styles.,
Available styles. ..

Stop Protection

atau
2. Tab File, Klik Protect Document, Pilih Restrict Editing

Protect
Document -

Mark as Final
Let readers know the document is final

and make it read-only.

Permissions
| Certain types of changes are restricted in this document.

r1=1 Encrypt with Password that it contains:
Require a password to open this r's name and related dates
document,

Restrict Editing den text
Control whatttpes of changes people

can make to th| document. .
sabilities are unable to read

Restrict Permission by People
Grant people access while removing L4

Ikuti langkah sebelumnya.

5. Membatasi Pengeditan Dokumen

a. Cara melakukan pembatasan editing

1. Pada panel Restrict Formatting and Editing, bagian Editing restrictions centang checkbox
Allow only this type of editing
2. Pada daftar Allow only... lakukan salah satu dibawah ini:
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Restrict Formatting and Editing + X
1. Formatting restrictions

Limit formatting to a selection of
styles

Settings...
2. Editing restrictions
Allow only this type of editing in

the document:
Tracked changes u

Tracked changes

Comments h
Filling in forms

Mo changes (Read onl

Ale youTe T "

ady 1o app aese
settings? (You can turn them off
later)

[ ‘Yes, Start Enforcing Protection ]

3

e Untuk menge-track perubahan dokumen, klik Tracked changes.
e Untuk membatasi pengeditan dokumen namun mengijinkan komentar, klik Comments.
e Untuk membatasi perubahan diluar area form, klik Filling in forms.

3. Pada bagian Start enforcement, klik Yes, Start Enforcing Protection.

b. Menghapus pembatasan editing

1. Pada panel Restrict Formatting and Editing, klik Stop Protection.
2. Jikajendela Unprotect Document muncul, maka masukkan password, kemudian klik OK.

6. Membatasi Akses Dokumen Dengan Enkripsi Password

Kita juga bisa membatasi hak akses seperti untuk membuka atau mengedit dokumen, dengan
menggunakan sebuah password tertentu. Sehingga untuk membuka atau mengedit dokumen
terproteksi maka Ms Word akan meminta password yang tepat. Hanya yang tau password yang bisa
membuka atau mengeditnya, selain itu tidak bisa.

a. Proteksi Akses Membuka dan Mengedit Dokumen

1. Pada Backstage view, klik tombol Protect Document, kemudian klik Encrypt with Password.
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A Permissions
Protect
Document ~

Mark as Final

and make it read-only.

_‘j Encrypt with Password
E%‘l) Require a password to open this

document,

Restrict Editing

can make to this document,

Anyone can open, copy, and chang

Let readers know the document is final

Control what types of changes people

th

ir's

de

|1

2. Padajendela Encrypt Document, masukkan password kemudian klik OK.

-
Encrypt Document

A=)

Encrypt the contents of this file

Password:

Caution: If you lose or forget the password, it cannot be
recovered. Itis advisable to keep a list of passwords and
their corresponding decument names in a safe place.
(Remember that passwords are case-sensitive, )

[ o

]’ Cancel l

atau

1. Pada Backstage view, klik Save As.
2. Dibawah jendela Save As, klik Tools, kemudian klik General Options.

o

Manager: 5

Tools -

Save Options...
General Options...

Web Opticns...

Map Metwork Drive...

[

Compress Pictures...

3. Padajendela General Options, masukkan password lalu click OK.
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' R
General Options M
General Options

File encryption options for this document

Password to open: .

File sharing options for this document
Password to modify: | 4

[ read-only recommended

Protect Document...

Macro security
Adjust the security level for opening files that might
contain macro viruses and spedfy the names of =

trusted macro developers,

[ oK ][ Cancel ]

4. Pada jendela Confirm Password masukkan kembali password kemudian klik OK.
5. Pada jendela Save As, klik Save. Lalu klik Yes.

b. Membuka Proteksi Akses Dokumen

Untuk membuka kembali proteksi akses dokumen, caranya:

1. Pada Backstage view, klik Save As.
2. Padajendela General Options, hapus password lalu click OK.

Page 185 of 187



IImuKom“put_er..Covm

-
General Opticns

General Options

File encryption options for this document

Password to open: .

File sharing options for this document

Password to modify: | 4

[ read-only recommended

Protect Document...

Macro security

Adjust the security level for opening files that might
contain macro viruses and spedfy the names of
trusted macro developers,

[

OK

] [ Cancel

3. Padajendela Save As, klik Save. Lalu klik Yes..
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